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What’s new

December 8, 2021

What’s new in 2110

This release addresses issues to improve the user experience.

Note:

Starting with 2110, before installing the Session Recording Administration components on Win‑
dows Server 2016 where TLS 1.0 is disabled, complete the following steps:

1. Install Microsoft OLE DB Driver for SQL Server.

2. Under the HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\.NETFramework\v4
.0.30319 registry key, add the SchUseStrongCrypto DWORD (32‑bit) value and set
the value data to 1.

3. Reboot.

Fixed issues

January 8, 2022

Compared with: Session Recording 2109

Session Recording 2110 adds the following fixes:

• The streaming servicemight fail to play a live recordingwhen the Session Recording Server and
Session Recording Agent are not synchronized. [SRT‑6461]

• Upgrading SessionRecording fromversion 2102 to 2107might fail when youuse Azure SQLMan‑
aged Instance. [SRT‑6485]

• The Session Recording web player might not play a video when the Advanced Video Coding
(AVC) decoder disposal fails. The player displays a black screen with an exception. [SRT‑6556]

Known issues

September 7, 2025
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• Upgrading the Session Recording server fails when “Require SSL”is enabled in IIS for the Ses‑
sionRecordingBroker application and only TLS 1.2 is enabled for the server‑side protocol on
the SR server.

To work around this issue, complete the following steps:

1. Temporarily Disable SSL: On the Session Recording server, open IIS Manager. For the
SessionRecordingBroker application, go to SSL Settings and uncheck “Require SSL”.

2. Run Upgrade: Execute the upgrade installer for the Session Recording server.
3. Re‑enable SSL: After the upgrade completes, go back to the SSL Settings in IIS and re‑

check “Require SSL” for the SessionRecordingBroker application.

• If you are using Citrix Web App Firewall (WAF) signatures tomitigate in part the CVE‑2021‑44228
vulnerability, Session Recording might not work as expected. To resolve the issue, exclude the
IP addresses of your Session Recording servers from themitigate_cve_2021_44228 policy on
the NetScaler side. [CVADHELP‑24365]

• A domain user with local administrator privileges on themachine where the Session Recording
Policy Console is installed can add both local users and domain users to which the action of a
policy rule applies. However, a local user with local administrator privileges can add only local
users but not domain users. [SRT‑5769]

• The web player might not work properly if you upgrade it from Version 2009 or earlier. To work
around the issue, clear your browser cache. [SRT‑5624]

• Rules of Session Recording custom policies might be lost after you update Session Recording
from the version included in the XenApp and XenDesktop 7.6 LTSR to the latest version. As a
workaround, before updating Session Recording to the latest version, update the software to
the version included in the latest CU of the XenApp and XenDesktop 7.15 LTSR and then update
it to the latest release. [SRT‑4546]

• When Machine Creation Services™ (MCS) or Provisioning Services (PVS) creates multiple VDAs
with the configuredmaster imageandMicrosoftMessageQueuing (MSMQ) installed, those VDAs
can have the same QMId under certain conditions. This case might cause various issues, for
example:

• Sessions might not be recorded even if the recording agreement is accepted.
• The Session Recording Servermight not be able to receive session logoff signals and there‑
fore, sessions might always be in a live state.

For information about a workaround, see Install, upgrade, and uninstall. [#528678]
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Third party notices

December 8, 2021

Session Recording Version 2110 (PDF Download)

This release of Session Recording can include third party software licensed under the terms defined
in this document.

System requirements

December 26, 2025

Session Recording includes the Session Recording Administration components, the Session Record‑
ing Agent, and the Session Recording Player. You can install the Session Recording Administration
components (Session Recording Database, Session Recording Server, and Session Recording Policy
Console) on a single server or on different servers. The following section details the requirements for
each of the Session Recording components.

For more information about using this Current Release (CR) in a Long Term Service Release (LTSR)
environment and other FAQs, see Knowledge Center article.

Session Recording Database

Supported operating systems:

• Windows Server 2022
• Windows Server 2019
• Windows Server 2016

Supported Microsoft SQL Server versions:

• Microsoft SQL Server 2019 Enterprise, Express, and Standard editions
• Microsoft SQL Server 2017 Enterprise, Express, and Standard editions
• Microsoft SQL Server 2016 SP2 Enterprise, Express, and Standard editions
• Microsoft SQL Server 2016 SP1 Enterprise, Express, and Standard editions
• Microsoft SQL Server 2014 SP2 Enterprise, Express, and Standard editions
• Microsoft SQL Server 2012 SP3 Enterprise, Express, and Standard editions
• Microsoft SQL Server 2008 R2 SP3 Enterprise, Express, and Standard editions

Supported Azure SQL database services:
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• Azure SQL Managed Instance
• SQL Server on Azure Virtual Machines (VMs)
(Use supported versions of Microsoft SQL Server that are listed earlier.)

Supported AWS RDS database services:

• SQL Server

Requirement: .NET Framework 4.7.2

Note:

Ledger databases are not supported. Password cannot contain quotemarks (“) andminimumof
8 characters.

Session Recording Server

Supported operating systems:

• Windows Server 2022
• Windows Server 2019
• Windows Server 2016

Other requirements:

• Internet Information Services (IIS) 10, 8.5, 8.0, or 7.5
• .NET Framework Version 4.7.2
• If the Session Recording Server uses HTTPS as its communications protocol, add a valid certifi‑
cate. Session Recording uses HTTPS by default, which Citrix® recommends.

• MicrosoftMessageQueuing (MSMQ),withActiveDirectory integrationdisabledandMSMQHTTP
support enabled.

• For Administrator Logging: Latest version of Chrome, Firefox, or Internet Explorer 11

Session Recording Policy Console

Supported operating systems:

• Windows Server 2022
• Windows Server 2019
• Windows Server 2016

Requirement: .NET Framework 4.7.2
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Session Recording Agent

Install the Session Recording Agent on everyWindows Virtual Delivery Agent (VDA) onwhich youwant
to record sessions.

Supported operating systems:

• Windows Server 2022
• Windows Server 2019
• Windows Server 2016
• Windows 11
• Windows 10, minimum version 1607
• Windows 10 Enterprise for Virtual Desktops

Requirements:

• Citrix Virtual Apps and Desktops™ 7 2109 with Premium license
• Citrix Virtual Apps™ and Desktops 7 1912 LTSR CU3 with Platinum license
• XenApp and XenDesktop 7.15 LTSR CU8 with Platinum license
• .NET Framework 4.7.2
• MicrosoftMessageQueuing (MSMQ),withActiveDirectory integrationdisabledandMSMQHTTP
support enabled

Session Recording Player

Supported operating systems:

• Windows Server 2022
• Windows Server 2019
• Windows Server 2016
• Windows 11
• 64‑bit Windows 10, minimum version 1607

Requirement: .NET Framework 4.7.2

Note:

On 32‑bit Windows 10, you can install the Player only by using the SessionRecordingPlayer.msi
file. The msi file is located on the Citrix Virtual Apps and Desktops ISO under \layout\image‑
full\x86\Session Recording.

For optimal results, install the Session Recording Player on a workstation with:

• Screen resolution of 1024 x 768
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• Color depth of at least 32‑bit
• 2GBRAMminimum;moreRAMandCPU/GPUresources can improveperformancewhenplaying
graphics‑intensive recordings, especially when recordings contain many animations

The seek response time depends on the size of the recording and yourmachine’s hardware specifica‑
tions.

Get started

September 7, 2025

Session Recording consists of five components:

• Session Recording Agent. A component installed on each VDA for multi‑session OS or single‑
session OS to enable recording. It is responsible for recording session data.

• Session Recording Server. A server that hosts:

• The Broker. An IIS 6.0+ hosted Web application that handles the search queries and file
download requests from the Session Recording Player, handles policy administration re‑
quests from the Session Recording Policy Console, and evaluates recording policies for
each Citrix Virtual Apps and Desktops session.

• The StorageManager. AWindows service thatmanages the recorded session files received
from each Session Recording‑enabled computer running Citrix Virtual Apps and Desktops.

• Administrator Logging. An optional subcomponent installed with the Session Recording
Server to log the administration activities. All the logging data is stored in a separate SQL
Server database named CitrixSessionRecordingLogging by default. You can customize
the database name.

• Session Recording Player. A user interface that users access from a workstation to play
recorded session files.

• Session Recording Database. A component that manages the SQL Server database for stor‑
ing recorded session data. When this component is installed, it creates a database named Cit‑
rixSessionRecording by default. You can customize the database name.

• Session Recording Policy Console. A console used to create policies to specify which sessions
are recorded.

This illustration shows the Session Recording components and their relationship with each other:

In the deployment example illustrated here, the Session Recording Agent, Session Recording Server,
Session Recording Database, Session Recording Policy Console, and Session Recording Player all re‑
side behind a security firewall. The Session Recording Agent is installed on a VDA for multi‑session
OS or single‑session OS. A second server hosts the Session Recording Policy Console, a third server
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acts as the Session Recording Server, and a fourth server hosts the Session Recording Database. The
Session Recording Player is installed on a workstation. A client device outside the firewall communi‑
cates with the VDA for multi‑session OS on which the Session Recording Agent is installed. Inside the
firewall, the Session Recording Agent, Session Recording Policy Console, Session Recording Player,
and Session Recording Database all communicate with the Session Recording Server.

Plan your deployment

September 7, 2025

Limitations and caveats

Session Recording does not support Desktop Composition Redirection (DCR) display mode. By de‑
fault, Session Recording disables DCR in a session if the session is to be recorded by recording policy.
You can configure this behavior in Session Recording Agent properties.
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If some URLs are configured in the browser content redirection policy that was introduced in Version
7.16 of the Windows VDA, graphics activities of browsing these URLs in the Internet Explorer browser
cannot be recorded.

Session Recording does not support the Framehawk display mode. Sessions in Framehawk display
mode cannot be recorded and played back correctly. Sessions recorded in Framehawk display mode
might not contain the sessions’activities.

Session Recording cannot record the Lync webcam video when using the HDX™ RealTime Optimiza‑
tion Pack.

Depending upon your environment, you can deploy the Session Recording components in different
scenarios.

A Session Recording deployment is not limited to a single site. Except the Session Recording Agent,
all components are independent of the server site. For example, you can configure multiple sites to
use a single Session Recording Server.

Alternatively, if you have a large site with many agents and plan to record many graphically intense
applications (for example, AutoCAD applications), or you have many sessions to record, a Session
Recording Server can experience a high performance demand. To alleviate performance issues, you
can install multiple Session Recording Servers and enable the load balancing feature to make the
Session Recording Servers work as a load balancing pool and to share the work load from different
VDAs.

Suggested server site deployment

Use this typeof deployment for recording sessions for oneormoreSites. TheSessionRecordingAgent
is installed on each VDA in a Site. The Site resides in a data center behind a security firewall. The Ses‑
sion Recording Administration components (Session Recording Database, Session Recording Server,
andSessionRecordingPolicyConsole) are installedonother servers and theSessionRecordingPlayer
is installed on aworkstation, all behind the firewall. It is recommended to deploy the Session Record‑
ing Server in a secure, intranet data center.
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Important deployment notes

• To enable Session Recording components to communicate with each other, install them in the
same domain or across trusted domains that have a transitive trust relationship. The system
cannot be installed on a workgroup or across domains that have an external trust relationship.

• Considering its intensegraphical natureandmemoryusagewhenplayingback large recordings,
Citrix® does not recommend installing the Session Recording Player as a published application.

• The Session Recording installation is configured for TLS/HTTPS communication. Ensure that
you install a certificate on the Session Recording Server and that the root certificate authority
(CA) is trusted on the Session Recording components.

• If you install the Session Recording Database on a standalone server running the Express Edi‑
tion of SQL Server 2019, SQL Server 2017, SQL Server 2016, SQL Server 2014, SQL Server 2012,
or SQL Server 2008 R2, the server must have the TCP/IP protocol enabled and the SQL Server
Browser service running. These settings are disabled by default, but they must be enabled for
the Session Recording Server to communicate with the database. For information about en‑
abling these settings, see the Microsoft articles Enable TCP/IP Network Protocol for SQL Server
and SQL Server Browser Service.

• Consider the effects of session sharingwhenplanning your SessionRecordingdeployment. Ses‑
sion sharing for published applications can conflict with Session Recording policy rules for pub‑
lished applications. Session Recording matches the active policy with the first published appli‑
cation that a user opens. After the user opens the first application, any subsequent applications
openedduring the same session continue to follow the policy that is in force for the first applica‑
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tion. For example, if a policy states to record only Microsoft Outlook, the recording commences
when the user opens Outlook. If the user opens a published Microsoft Word second while Out‑
look is running,Word also is recorded. Conversely, if the active policy does not specify to record
Word, and the user launches Word before Outlook, Outlook is not recorded.

• Though you can install the Session Recording Server on a Delivery Controller™, Citrix does not
recommend that you do so because of performance issues.

• You can install the Session Recording Policy Console on a Delivery Controller.
• You can install both the Session Recording Server and the Session Recording Policy Console on
the same system.

• Ensure that the NetBIOS name of the Session Recording Server does not exceed the limit of 15
characters. Microsoft has a 15‑character limit on the host name length.

• PowerShell 5.1 or later is required for custom event logging. Upgrade PowerShell if you install
the Session Recording Agent onWindows Server 2012 R2 that has PowerShell 4.0 installed. Fail‑
ure to comply can cause failed API calls.

Security recommendations

September 7, 2025

Session Recording is deployed within a secure network and accessed by administrators, and as such,
is secure. Out‑of‑the‑box deployment is simple and security features such as digital signing and en‑
cryption can be configured optionally.

Communication between Session Recording components is achieved through Internet Information
Services (IIS) and Microsoft Message Queuing (MSMQ). IIS provides the web services communication
linkbetweenSessionRecordingcomponents. MSMQprovidesa reliabledata transportmechanism for
sending recorded session data from the Session Recording Agent to the Session Recording Server.

Warning:

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix® cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

Consider these security recommendations when planning your deployment:

• Ensure that you properly isolate the different administrator roles in the corporate network, in
the Session Recording system, or on individual machines. By not doing so, security threats that
can impact the system functionality or abuse the systemmight occur. We recommend that you
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assign different administrator roles to different persons or accounts. Do not allow general ses‑
sion users to have administrator privileges to the VDA system.

• Citrix Virtual Apps andDesktops™ administrators do not grant VDA local administrator role
to any users of published apps or desktops. If the local administrator role is a requirement,
protect the Session Recording Agent components by usingWindowsmechanisms or third‑
party solutions.

• Separately assign the Session Recording database administrator and Session Recording
policy administrator.

• We recommend that you do not assign VDA administrator privileges to general session
users, especially when using Remote PC Access.

• Session Recording Server local administration account must be strictly protected.
• Control access tomachineswhere the Session Recording Player is installed. If a user is not
authorized for the Player role, do not grant that user local administrator role for any player
machine. Disable anonymous access.

• We recommend using a physical machine as a storage server for Session Recording.

• Session Recording records session graphics activities without regard to the sensitivity of the
data. Under certain circumstances, sensitive data (including but not limited to user credentials,
privacy information, and third‑party screens) might be recorded unintentionally. Take the fol‑
lowing measures to prevent risks:

• Disable core memory dump for VDAs unless for specific troubleshooting cases.
To disable core memory dump:
1. Right‑clickMy Computer, and then select Properties.
2. Click the Advanced tab, and then under Startup and Recovery, click Settings.
3. UnderWrite Debugging Information, select (none).
See the Microsoft article at https://support.microsoft.com/en‑us/kb/307973.

• Session owners notify attendees that online meetings and remote assistance software
might be recorded if a desktop session is being recorded.

• Ensure that logon credentials or security information does not appear in all local andWeb
applications published or used inside the corporation. Otherwise, they are recorded by
Session Recording.

• Close any application that might expose sensitive information before switching to a re‑
mote ICA® session.

• We recommend only automatic authentication methods (for example, single sign‑on,
smartcard) for accessing published desktops or Software as a Service (SaaS) applications.

• Session Recording relies on certain hardware and hardware infrastructure (for example, corpo‑
rate network devices, operation system) to function properly and to meet security needs. Take
measures at the infrastructure levels to prevent damage or abuse to those infrastructures and
make the Session Recording function secure and reliable.
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• Properly protect and keep network infrastructure supporting Session Recording available.
• We recommend using a third‑party security solution or Windows mechanism to protect
Session Recording components. Session Recording components include:

• On the Session Recording Server

• Processes: SsRecStoragemanager.exe and SsRecAnalyticsService.exe
• Services: CitrixSsRecStorageManager and CitrixSsRecAnalyticsService
• All files in Session Recording Server installation folder
• Registry valueswithinHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server

• On the Session Recording Agent

• Process: SsRecAgent.exe
• Service: CitrixSmAudAgent
• All files in Session Recording Agent installation folder
• Registry valueswithinHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Agent

• As a security best practice, Citrix recommends using HTTPS on IIS.

• Set the access control list (ACL) for Message Queuing (MSMQ) on the Session Recording Server
to restrict VDA or VDI machines that can send MSMQ data to the Session Recording Server and
prevent unauthorized machines from sending data to the Session Recording Server.

1. Install server featureDirectoryService IntegrationoneachSessionRecordingServer and
VDA or VDImachinewhere Session Recording is enabled. Then restart theMessageQueu‑
ing service.

2. From the Windows Start menu on each Session Recording Server, open Administrative
Tools > Computer Management.

3. Open Services and Applications >Message Queuing > Private Queues.

4. Click the private queue citrixsmauddata to open the Properties page and select the Se‑
curity tab.
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5. Add the computers or security groups of the VDAs that send MSMQ data to this server and
grant them the SendMessage permission.
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• Properly protect the event log for the Session Record Server and Session Recording Agents. We
recommend using aWindows or third‑party remote logging solution to protect the event log or
redirect the event log to the remote server.

• Ensure that servers running the Session Recording components are physically secure. If possi‑
ble, lock these computers in a secure room to which only authorized personnel can gain direct
access.

• Isolate servers running the Session Recording components on a separate subnet or domain.

• Protect the recorded session data from users accessing other servers by installing a firewall be‑
tween the Session Recording Server and other servers.

• Keep the Session Recording Administration Server and SQL database up‑to‑date with the latest
security updates fromMicrosoft.

• Restrict non‑administrators from logging on to the administration machine.

• Strictly limit who is authorized to make recording policy changes and view recorded sessions.

• Install digital certificates, use the Session Recording file signing feature, and set up TLS commu‑
nications in IIS.

• SetupMSMQtouseHTTPSas its transport. Theway is to set theMSMQprotocol listed inSession
Recording Agent Properties to HTTPS. For more information, see Troubleshoot MSMQ.

• Use TLS 1.1 or TLS 1.2 (recommended) and disable SSLv2, SSLv3, TLS 1.0 on the Session Record‑
ing Server and Session Recording Database.

• Disable RC4 cipher suites for TLS on the Session Recording Server and Session Recording Data‑
base:

1. Using theMicrosoft Group Policy Editor, navigate to Computer Configuration > Adminis‑
trative Templates >Network > SSL Configuration Settings.

2. Set the SSL Cipher Suite Order policy to Enabled. By default, this policy is set to Not
Configured.

3. Remove any RC4 cipher suites.

• Use playback protection. Playback protection is a Session Recording feature that encrypts
recorded files before they are downloaded to the Session Recording Player. By default, this
option is enabled and is in Session Recording Server Properties.

• Follow NSIT guidance for cryptographic key lengths and cryptographic algorithms.

• Configure TLS 1.2 support for Session Recording.

We recommend using TLS 1.2 as the communication protocol to ensure the end‑to‑end security
of the Session Recording components.

To configure TLS 1.2 support of Session Recording:
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1. Log on to themachine hosting the Session Recording Server. Install the proper SQL Server
client component and driver, and set strong cryptography for .NET Framework (version 4
or later).

a) Install the Microsoft ODBC Driver 11 (or a later version) for SQL Server.
b) Apply the latest hotfix rollup of .NET Framework.
c) Install ADO.NET - SqlClient based on your version of .NET Framework. For

more information, see https://support.microsoft.com/en‑us/kb/3135244.
d) AddaDWORDvalueSchUseStrongCrypto=1underHKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\.NetFramework\v4.0.30319

andHKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\.NetFramework\v4.0.30319.
e) Restart the machine.

2. Log on to themachine hosting the Session Recording Policy Console. Apply the latest hot‑
fix rollup of .NET Framework, and set strong cryptography for .NET Framework (version 4
or later). The method for setting strong cryptography is the same as substeps 1–4 and 1–
5. You can omit these steps if you choose to install the Session Recording Policy Console
on the same computer as the Session Recording Server.

To configure the TLS 1.2 support for SQL Server with versions earlier than 2016, see https://support.
microsoft.com/en‑us/kb/3135244. To use TLS 1.2, configure HTTPS as the communication protocol
for the Session Recording components.

Scalability considerations

December 26, 2025

SessionRecording is a highly scalable system that handles thousandsor tens of thousandsof sessions.
Installing and running Session Recording requires few extra resources beyond what is necessary to
run Citrix Virtual Apps and Desktops. However, if you plan to use Session Recording to record many
sessions or if the sessions you plan to record can result in large session files (for example, graphically
intense applications), consider the performance of your system when planning your Session Record‑
ing deployment.

This article explains how Session Recording achieves high scalability and how you can get the most
out of your recording system at a lowest cost.

Why Session Recording scales well

There are two major reasons that Session Recording scales well compared with competitive prod‑
ucts:
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• Small file size

A recorded session file made with Session Recording is highly compact. It is many orders of
magnitude smaller than an equivalent video recordingmadewith solutions that screen‑scrape.
The network bandwidth, disk space, and disk IOPS required to transport and store each Session
Recording file is typically at least 10 times less than an equivalent video file.

The small size of recorded session files means faster and smoother rendering of video frames.
Recordings are also lossless and have no pixelation that is common in most compact video for‑
mats. Text in recordings is easy to read during playback as it is in the original sessions. To
maintain small file sizes, Session Recording does not record key frames within the files. Ses‑
sion Recording can dropH.264 packageswhile recording sessions that have videos running and
thus reduce the recording file sizes. To use this functionality, set HKEY_LOCAL_MACHINE
\SOFTWARE\Citrix\SmartAuditor\Agent\DropH264Enabled to 1 on the Session
Recording Agent and set the value of Use video codec for compression to For actively chang‑
ing regions.

• Low processing required to generate files

A recorded session file contains the ICA® protocol data for a session that is extracted virtually
in its native format. The file captures the ICA protocol data stream that is used to communi‑
cate with Citrix Workspace™ app. There is no need to run expensive transcoding or encoding
software components to change the format of data in real time. The low amount of processing
is also important for VDA scalability and ensures the end‑user experience is maintained when
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many sessions are recorded from the same VDA.

Moreover, only those ICA virtual channels that can be played back are recorded, which results
in a further optimization. For example, the printer and client drive mapping channels are not
recorded because they can generate high volumes of data without any benefit in video play‑
back.

Estimate data input and processing rates

The Session Recording Server is the central collection point for recorded session files. Each machine
that is running a multi‑session OS VDA with Session Recording enabled sends recorded session data
to the Session Recording Server. Session Recording can handle high volumes of data and can tolerate
bursts and faults, but there are physical limits on howmuch data any one server can handle.

Consider howmuch data you send to each Session Recording Server and how quickly the servers can
process and store this data. The rate at which your system can store incoming data must be higher
than the data input rate.

To estimate your data input rate,multiply the number of sessions recordedby the average size of each
recorded session anddivide by the time forwhich you are recording sessions. For example, youmight
record 5,000 Microsoft Outlook sessions of 20 MB each over an 8‑hour work day. In this case, the data
input rate is approximately 3.5Mbps. (5,000 sessions times 20MBdivided by 8 hours, divided by 3,600
seconds per hour.) A typical Session Recording Server connected to a 100 Mbps LAN with sufficient
disk space to store the recordeddata canprocess data at around 5.0Mbps basedon thephysical limits
imposed by disk and network IOPS. This rate is the processing rate. In the example, the processing
rate (5.0 Mbps) is higher than the input rate (3.5 Mbps), so recording the 5,000 Outlook sessions is
feasible.

The amount of data per session varies greatly depending on what is being recorded, while other fac‑
tors such as the screen resolution, color depth, and graphics mode also have impacts. A session run‑
ning a CAD package where graphics activity is constantly high likely generates a much larger record‑
ing than a session in which the end user sends and receives emails in Microsoft Outlook. Therefore,
recording the samenumberof CAD sessions cangenerate ahigh input rate and require theuseofmore
Session Recording Servers.

Bursts and faults

The previous example assumes a simple uniform throughput of data but does not explain how the
system deals with short periods of higher activity, known as bursts. A burst might occur when all
users log on at the same time in the morning, known as the 9 o’clock rush, or when they receive the
same email in their Outlook inbox at once. The 5.0 Mbps processing rate of the Session Recording
Server is highly inadequate at dealing with this sudden demand.
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The Session Recording Agent running on each VDA uses Microsoft Message Queuing (MSMQ) to send
recorded data to the Storage Manager running on the central Session Recording Server. The data is
sent in a store‑and‑forward manner similar to how an email is delivered between the sender, mail
server, and receiver. If the Session Recording Server or the network cannot handle the high rate of
data in a burst, the recorded session data is temporarily stored until the backlog of data messages
is cleared. The data message might be temporarily stored in the outgoing queue on the VDA if the
network is congested, or stored on the Session Recording Server’s receiving queue if the data has
traversed the network but the Storage Manager is still busy processing other messages.

MSMQ also serves as a fault tolerance mechanism. If the Session Recording Server goes down or the
link is broken, recorded data is held in the outgoing queue on each VDA. When the fault is rectified,
all queued data is sent together. The use of MSMQ also allows you to take a Session Recording Server
offline for upgrade or maintenance without interrupting the recording of existing sessions and losing
data.

The main limitation of MSMQ is that disk space for the temporary storage of data messages is finite.
This limitation limits how long a burst, fault, or maintenance event can last before data is eventually
lost. The overall system can continue after data loss, but in this situation, individual recordings have
chunks of data missing. A file with missing data is still playable but only up to the point where data
was first lost. Note the following:

• Adding more disk space to each server, especially the Session Recording Server, and making it
available to MSMQ can increase the tolerance to bursts and faults.

• It is important to configure the Message Life setting for each Session Recording Agent to an ap‑
propriate level (on the Connections tab in Session Recording Agent Properties). The default
value of 7,200 seconds (two hours) means that each recorded data message has two hours to
reach the Storage Manager before it is discarded and recording files are damaged. With more
disk space available (or fewer sessions to record), you can choose to increase this value. The
maximum value is 365 days.

The other limitation with MSMQ is that when data backlogs, there is extra disk IOPS in the queue to
read andwrite datamessages. Under normal conditions, the StorageManager receives andprocesses
data from the network directly without the data message ever being written to disk. Storing the data
involves a single write operation to disk that appends the recorded session file. When data is back‑
logged, the disk IOPS is tripled: each message must be written to disk, read from disk, and written
to file. As the Storage Manager is heavily IOPS bound, the processing rate of the Session Recording
Server drops until the backlog ofmessages is cleared. Tomitigate the effects of this extra IOPS, adopt
the following recommendations:

• Ensure that the disk onwhichMSMQ storesmessages is different from the recording file storage
folders. Even though IOPS bus traffic is tripled, the drop in the true processing rate is never as
severe.

© 1997–2025 Citrix Systems, Inc. All rights reserved. 21



Session Recording 2110

• Have planned outages at off‑peak times only. Depending on budget constraints, follow recog‑
nized approaches to building high availability servers. The approaches include the use of UPS,
dual NICs, redundant switches, and hot swappable memory and disks.

Design for spare capacity

The data rate of recorded session data is unlikely to be uniform, bursts and faults might occur, and
the clearing ofmessage backlogs is expensive in IOPS. For this reason, design each Session Recording
Server with plenty of spare capacity. Adding more servers or improving the specification of existing
servers, as described in later sections, always gains you extra capacity. The general rule of thumb is to
run each Session Recording server at amaximumof 50%of its total capacity. In the earlier example, if
the server can process 5.0 Mbps, target the system to run only at 2.5 Mbps. Instead of recording 5,000
Outlook sessions that generate 3.5 Mbps on one Session Recording Server, reduce to 3,500 sessions
that generate only about 2.5 Mbps.

Backlogs and live playback

Liveplayback iswhena revieweropensa session recording forplaybackwhile the session is still active.
During live playback, the Session Recording Agent responsible for the session switches to a streaming
mode for that session, and recordingdata is sent immediately to theStorageManagerwithout internal
buffering. Because the recording file is constantly updated, the Player can continue to be fed with
the latest data from the live session. However, data sent from the Agent to the Storage Manager is
through MSMQ, so the queuing rules described earlier apply. A problem can occur in this scenario.
When MSMQ is backlogged, the new recorded data available for live playback is queued like all other
datamessages. The reviewer can still play the file, but viewing the latest live recorded data is delayed.
If live playback is an important feature for reviewers, ensure a lowprobability of backlog by designing
spare capacity and fault tolerance into your deployment.

Citrix Virtual Apps™ and Desktops scalability

Session Recording never reduces session performance and never stops sessions in response to
recorded data backlogs. Maintaining the end‑user experience and single‑server scalability is para‑
mount in the design of the Session Recording system. If the recording system becomes irreversibly
overloaded, recorded session data is discarded. Extensive scalability testing by Citrix reveals that
the impact of recording ICA sessions on the performance and scalability of Citrix Virtual Apps and
Desktops servers is low. The size of the impact depends on the platform, the memory available, and
the graphical nature of the sessions being recorded. With the following configuration, you can expect
a single‑server scalability impact of between 1% and 5%. In other words, if a server can host 100
users without Session Recording installed, it can host 95–99 users after installation:
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• 64‑bit server with 8 GB RAM running a multi‑session OS VDA
• All sessions running Office productivity applications, such as Outlook and Excel
• The use of applications is active and sustained
• All sessions are recorded as configured by the Session Recording policies

If fewer sessions are recordedor sessionactivity is less sustainedandmore sporadic, the impact is less.
In many cases, the scalability impact is negligible and user density per server remains the same. As
mentioned earlier, the low impact is due to the simple processing requirements of the SessionRecord‑
ing components installed on each VDA. Recorded data is extracted from the ICA session stack and sent
as‑is to the Session Recording Server through MSMQ. There is no expensive encoding of data.

There is a minor overhead of using Session Recording even when no sessions are recorded. Although
the impact is low, if you are sure that no sessions are recorded from a particular server, you can dis‑
able recording on that server. Removing Session Recording is one way. A less invasive approach is to
clear the Enable session recording for this VDA machine check box on the Session Recording tab
in Session Recording Agent Properties. If session recording is required in future, reselect this check
box.

Measuring throughput

There are various ways to measure the throughput of recorded session data from the sending VDA
to the receiving Session Recording Server. One of the simplest and most effective approaches is to
observe the size of files that are recorded, and the rate at which disk space on the Session Recording
Server is being consumed. The volume of data written to disk closely reflects the volume of network
trafficbeinggenerated. TheWindowsPerformanceMonitor tool (perfmon.exe)hasa rangeof standard
system counters that can be observed in addition to some counters provided by Session Recording.
Counters can be used to measure throughput, and identify bottlenecks and system problems. The
following table outlines some of the most useful performance counters.

Performance Object Counter Name Description

Citrix Session Recording Agent Active Recording Count Indicates the number of
sessions that are currently
being recorded on a particular
VDA.
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Performance Object Counter Name Description

Citrix Session Recording Agent Bytes read from the Session
Recording Driver

The number of bytes read from
the kernel components
responsible for acquiring
session data. Useful for
determining howmuch data a
single VDA generates for all
sessions recorded on that
server.

Citrix Session Recording
Storage Manager

Active Recording Count Similar to the Citrix Session
Recording Agent counter
except for the Session
Recording Server. Indicates the
total number of sessions
currently being recorded for all
servers.

Citrix Session Recording
Storage Manager

Message bytes/sec The throughput of all recorded
sessions. Can be used to
determine the rate at which the
Storage Manager is processing
data. If MSMQ is backlogged
with messages, the Storage
Manager runs at full speed.
This value can be used to
indicate the maximum
processing rate of the Storage
Manager.

LogicalDisk Disk Write Bytes/sec Can be used to measure disk
write‑through performance.
This is important in achieving
high scalability for the Session
Recording Server. Performance
of individual drives can also be
observed.

© 1997–2025 Citrix Systems, Inc. All rights reserved. 24



Session Recording 2110

Performance Object Counter Name Description

MSMQ Queue Bytes in Queue This counter can be used to
determine the amount of data
backlogged in the
CitrixSmAudData message
queue. If this value increases
over time, the rate of recorded
data received from the network
is greater than the rate at which
the Storage Manager can
process data. This counter is
useful for observing the effect
of data bursts and faults.

MSMQ Queue Message in Queue Similar to the Bytes in Queue
counter but measures the
number of messages.

Network Interface Bytes Total/sec Can bemeasured on both sides
of the link to observe how
much data is generated when
sessions are recorded. When
measured on the Session
Recording Server, this counter
indicates the rate at which
incoming data is received.
Contrasts with the Citrix
Session Recording Storage
Manager/Message bytes/sec
counter that measures the
processing rate of data. If
network rate is greater than
this value, messages build in
the message queue.

Processor % Processor Time Worth monitoring even though
CPU is unlikely to be a
bottleneck.
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Session Recording Server hardware

You can increase the capacity of your deployment by carefully selecting the hardware used for the Ses‑
sion Recording Server. You have two choices: scaling up (by increasing the capacity of each server) or
scalingout (byaddingmore servers). Inmakingeitherof the choices, youraim is to increase scalability
at a lowest cost.

Scaling up

Whenexamining a single SessionRecording Server, consider the followingbest practices to ensure op‑
timal performance for available budgets. The system depends on IOPS. This ensures a high through‑
put of recorded data from the network onto the disk. So it is important to invest in appropriate net‑
work and disk hardware. For a high‑performance Session Recording Server, a dual CPU or dual core
CPU is recommended but little is gained from any higher specification. 64‑bit processor architecture
is recommended but an x86 processor type is also suitable. 4 GB of RAM is recommended but again
there is little benefit from adding more.

Scaling out

Even with the best scaling up practices, there are limits to performance and scalability that can be
reachedwith a single Session Recording Server when recordingmany sessions. It might be necessary
to add extra servers to meet the load. You can install more Session Recording Servers on different
machines to have the Session Recording Servers work as a load balancing pool. In this type of deploy‑
ment, the Session Recording Servers share the storage and the database. To distribute the load, point
the Session Recording Agents to the load balancer that is responsible for theworkload distribution.

Network capacity

A 100 Mbps network link is suitable for connecting a Session Recording Server. A Gb Ethernet con‑
nection might improve performance, but does not result in 10 times greater performance than a 100
Mbps link. In practice, the gain in throughput is significantly less.

Ensure that network switches used by Session Recording are not sharedwith third‑party applications
that might compete for available network bandwidth. Ideally, network switches are dedicated for
use with the Session Recording Server. If network congestion proves to be the bottleneck, a network
upgrade is a relatively inexpensive way to increase the scalability of the system.
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Storage

Investment in disk and storage hardware is the single most important factor in server scalability. The
faster that data can be written to disk, the higher the performance of the overall system. When select‑
ing a storage solution, take more note of the write performance than the read performance.

Store data on a set of local disks controlled either as RAID by a local disk controller or as a SAN.

Note:

Storing data on a NAS, based on file‑based protocols such as SMB and NFS, might have perfor‑
mance and security implications. Use the latest version of the protocol in place to avoid security
implications and perform scale testing to ensure proper performance.

For a local drive setup, aim for a disk controller with built‑in cache memory. Caching allows the con‑
troller to use elevator sorting during write‑back, which minimizes disk head movement and ensures
write operations are completed without waiting for the physical disk operation to complete. This can
improvewrite performance significantly at aminimal extra cost. Cachingdoeshowever raise theprob‑
lem of data loss after a power failure. To ensure the integrity of data and the file system, consider a
battery backup facility for the caching disk controller, which ensures that, if power is lost, the cache
is maintained and data is written to disk when power is eventually restored.

Consider using a suitable RAID storage solution. There are many RAID levels available depending on
performance and redundancy requirements. The following table specifies each of the RAID levels and
how applicable each standard is to Session Recording.

RAID Level Type
MinimumNumber of
Disks Description

RAID 0 Striped set without
parity

2 Provides high
performance but no
redundancy. Loss of
any disk destroys the
array. This is a low cost
solution for storing
recorded session files
where the impact of
data loss is low. Easy
to scale up
performance by
adding more disks.
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RAID Level Type
MinimumNumber of
Disks Description

RAID 1 Mirrored set without
parity

2 No performance gain
over one disk, making
it a relatively
expensive solution.
Use this solution only
if a high level of
redundancy is
required.

RAID 3 Striped set with
dedicated parity

3 Provides high write
performance with
redundancy
characteristics similar
to RAID 5. RAID 3 is
recommended for
video production and
live streaming
applications. As
Session Recording is
this type of
application, RAID 3 is
most highly
recommended but it is
not common.
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RAID Level Type
MinimumNumber of
Disks Description

RAID 5 Striped set with
distributed parity

3 Provides high read
performance with
redundancy but at the
cost of slower write
performance. RAID 5 is
the most common for
general purpose
usages. But due to the
slow write
performance, RAID 5 is
not recommended for
Session Recording.
RAID 3 can be
deployed at a similar
cost but with
significantly better
write performance.

RAID 10 Mirrored set and
striped set

4 Provides performance
characteristics of RAID
0 with redundancy
benefits of RAID 1. An
expensive solution
that is not
recommended for
Session Recording.

RAID 0 and RAID 3 are the most recommended RAID levels. RAID 1 and RAID 5 are popular standards
but are not recommended for Session Recording. RAID 10 does provide some performance benefits
but is too expensive for the additional gain.

Decide on the type and specification of disk drives. IDE/ATA drives and external USB or Firewire drives
are not suitable for use in Session Recording. Themain choice is between SATA and SCSI. SATA drives
provide reasonably high transfer rates at a reduced cost per MB compared with SCSI drives. However,
SCSI drives providebetter performance andaremore common in server deployments. Server RAID so‑
lutionsmostly support SCSI drives but some SATA RAID products are now available. When evaluating
the specifications of disk drive products, consider the rotational speed of disk and other performance
characteristics.
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Because the recording of thousands of sessions per day can consume significant amounts of disk
space, youmust choose betweenoverall capacity andperformance. From the earlier example, record‑
ing 5,000Outlook sessions over an 8‑hourwork day consumes about 100GBof storage space. To store
10days’worthof recordings (that is, 50,000 recorded session files), youneed1,000GB (1TB). This pres‑
sure on disk space can be eased by shortening the retention period before archiving or deleting old
recordings. If 1 TB of disk space is available, a seven‑day retention period is reasonable, ensuring
disk space usage remains around 700 GB, with 300 GB remaining as a buffer for busy days. In Session
Recording, the archiving and deleting of files is supported with the ICLDB utility and has a minimum
retention period of two days. You can schedule a background task to run once a day at some off‑peak
time. For more information about the ICLDB commands and archiving, see Manage your database
records.

The alternative to using local drive and controllers is to use a SAN storage solution based on block‑
level disk access. To the Session Recording Server, the disk array appears as a local drive. SANs are
more expensive to set up, but as the disk array is shared, SANs do have the advantage of simplified
and centralized management. There are two main types of SAN: Fibre Channel and iSCSI. iSCSI is
essentially SCSI over TCP/IP and is gaining popularity over Fibre Channel since the introduction of Gb
Ethernet.

Database scalability

The Session Recording Database requires Microsoft SQL Server 2019, Microsoft SQL Server 2017, Mi‑
crosoft SQL Server 2016, Microsoft SQL Server 2014, Microsoft SQL Server 2012, or Microsoft SQL
Server 2008 R2. The volume of data sent to the database is small because the database stores only
metadata about the recorded sessions. The files of the recorded sessions themselves are written to
a separate disk. Typically, each recorded session requires only about 1 KB of space in the database,
unless the Session Recording Event API is used to insert searchable events to the session.

The Express Editions of Microsoft SQL Server 2019, Microsoft SQL Server 2017, Microsoft SQL Server
2016,MicrosoftSQLServer 2014,MicrosoftSQLServer 2012, andMicrosoftSQLServer 2008R2 impose
a database size limitation of 10 GB. At 1 KB per recording session, the database can catalog about
4,000,000 sessions. Other editions of Microsoft SQL Server have no database size restrictions and are
limited only by available disk space. As the number of sessions in the database increases, perfor‑
mance of the database and speed of searches diminishes only negligibly.

If you are notmaking customizations through the Session Recording Event API, each recorded session
generates four database transactions: two when recording starts, one when the user logs on to the
session being recorded, and one when recording ends. If you use the Session Recording Event API
to customize sessions, each searchable event recorded generates one transaction. Because even the
most basic database deployment can handle hundreds of transactions per second, the processing
load on the database is unlikely to be stressed. The impact is light enough that the Session Recording
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Database can run on the same SQL Server as other databases, including the Citrix Virtual Apps and
Desktops data store database.

If your Session Recording deployment requiresmanymillions of recorded sessions to be cataloged in
the database, follow Microsoft guidelines for SQL Server scalability.

Install, upgrade, and uninstall

September 7, 2025

This article contains the following sections:

• Installation checklist

• Use Citrix scripts to install the Windows roles and features prerequisites

• Install the Session Recording Administration components

• Install the Session Recording Database

• Install the Session Recording Server

• Install the Session Recording Agent

• Install the Session Recording Player and the web player

• Automate installation

• Upgrade Session Recording

• Uninstall Session Recording

Installation checklist

You install the Session Recording components by using the following files:

• Broker_PowerShellSnapIn_x64.msi

• SessionRecordingAdministrationx64.msi

• SessionRecordingAgentx64.msi

• SessionRecordingPlayer.msi

• SessionRecordingWebPlayer.msi

Before you start the installation, complete this list:
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� Step

Install the prerequisites before starting the
installation. See System requirements and Use
Citrix scripts to install the Windows roles and
features prerequisites.
Select the machines on which you want to install
each Session Recording component. Ensure that
each computer meets the hardware and
software requirements for the component or
components to be installed on it.
Use your Citrix account credentials to access the
Citrix Virtual Apps and Desktops™ download
page and download the product file. Unzip the
file.
To use the TLS protocol for communication
between the Session Recording components,
install the correct certificates in your
environment.
Install any hotfixes required for the Session
Recording components. The hotfixes are
available from the Citrix Support.
Configure Director to create and activate the
Session Recording policies. For more
information, see Configure Director to use the
Session Recording Server.

Note:

• We recommend that you divide the published applications into separate Delivery Groups
based on your recording policies. Session sharing for published applications can conflict
with the active policy if the applications are in the sameDelivery Group. Session Recording
matches the active policy with the first published application that a user opens. Starting
with the 7.18 release, you can use the dynamic session recording feature to start or stop
recording sessions at any time during the sessions. This feature can help to mitigate the
conflict issue with the active policy. For more information, see Dynamic session recording.

• If you are planning to use Machine Creation Services™ (MCS) or Provisioning Services, pre‑
pare a unique QMId. Failure to comply can cause recording data losses.

• SQL Server requires that TCP/IP is enabled, the SQL Server Browser service is running, and
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Windows Authentication is used.
• To use HTTPS, configure server certificates for TLS/HTTPS.
• Ensure that users under Local Users and Groups > Groups > Users have
write permission to the C:\windows\Temp folder.

Use Citrix scripts to install the Windows roles and features prerequisites

For Session Recording to work properly, use the following Citrix scripts to install the necessary Win‑
dows roles and features prerequisites before
installing Session Recording:

• InstallPrereqsforSessionRecordingAdministration.ps1

1 <#
2 .Synopsis
3 Installs Prereqs for Session Recording Administration
4 .Description
5 Supports Windows Server 2022, Windows Server 2019 and Windows

Server 2016.
6 Install below windows feature on this machine:
7 -Application Development
8 -Security - Windows Authentication
9 -Management Tools - IIS 6 Management Compatibility

10 IIS 6 Metabase Compatibility
11 IIS 6 WMI Compatibility
12 IIS 6 Scripting Tools
13 IIS 6 Management Console
14 -Microsoft Message Queuing (MSMQ), with Active Directory

integration disabled, and MSMQ HTTP support enabled.
15 #>
16 function AddFeatures($featurename)
17 {
18
19 try
20 {
21
22 $feature=Get-WindowsFeature | ? {
23 $_.DisplayName -eq $featurename -or $_.Name -eq $featurename }
24
25 Add-WindowsFeature $feature
26 }
27
28 catch
29 {
30
31 Write-Host "Addition of Windows feature $featurename

failed"
32 Exit 1
33 }
34
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35 Write-Host "Addition of Windows feature $featurename
succeeded"

36 }
37
38
39 $system= gwmi win32_operatingSystem | select name
40
41 if (-not (($system -Like '*Microsoft Windows Server 2022*') -or (

$system -Like '*Microsoft Windows Server 2019*') -or ($system
-Like '*Microsoft Windows Server 2016*')))

42 {
43
44 Write-Host("This is not a supported server platform.

Installation aborted.")
45 Exit
46 }
47
48
49 # Start to install Windows feature
50 Import-Module ServerManager
51
52 AddFeatures('Web-Asp-Net45') #ASP.NET 4.5
53 AddFeatures('Web-Mgmt-Console') #IIS Management Console
54 AddFeatures('Web-Windows-Auth') # Windows Authentication
55 AddFeatures('Web-Metabase') #IIS 6 Metabase Compatibility
56 AddFeatures('Web-WMI') #IIS 6 WMI Compatibility
57 AddFeatures('Web-Lgcy-Scripting')#IIS 6 Scripting Tools
58 AddFeatures('Web-Lgcy-Mgmt-Console') #IIS 6 Management Console
59 AddFeatures('MSMQ-HTTP-Support') #MSMQ HTTP Support
60 AddFeatures('web-websockets') #IIS Web Sockets
61 AddFeatures('NET-WCF-HTTP-Activation45') #http activate

• InstallPrereqsforSessionRecordingAgent.ps1

1 <#
2 .Synopsis
3 Installs Prereqs for Session Recording Agent
4 .Description
5 Supports Windows Server 2022, Windows Server 2019, Windows

Server 2016, windows 11, and Windows 10.
6 Install below windows feature on this machine:
7 -Microsoft Message Queuing (MSMQ), with Active Directory

integration disabled, and MSMQ HTTP support enabled.
8 #>
9 function AddFeatures($featurename)

10 {
11
12 try
13 {
14
15 $feature=Get-WindowsFeature | ? {
16 $_.DisplayName -eq $featurename -or $_.Name -eq $featurename }
17
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18 Add-WindowsFeature $feature
19 }
20
21 catch
22 {
23
24 Write-Host "Addition of Windows feature $featurename

failed"
25 Exit 1
26 }
27
28 Write-Host "Addition of Windows feature $featurename

succeeded"
29 }
30
31
32 # Start to install Windows feature
33 $system= gwmi win32_operatingSystem | select name
34
35 if (-not (($system -Like '*Microsoft Windows Server 2022*') -or (

$system -Like '*Microsoft Windows Server 2019*') -or ($system
-Like '*Microsoft Windows Server 2016*') -or ($system -Like '*
Microsoft Windows 11*') -or ($system -Like '*Microsoft Windows
10*')))

36 {
37
38 Write-Host("This is not a supported platform. Installation

aborted.")
39 Exit
40 }
41
42
43 if ($system -Like '*Microsoft Windows Server*')
44 {
45
46 Import-Module ServerManager
47 AddFeatures('MSMQ') #Message Queuing
48 AddFeatures('MSMQ-HTTP-Support')#MSMQ HTTP Support
49 }
50
51 else
52 {
53
54 try
55 {
56
57 dism /online /enable-feature /featurename:MSMQ-HTTP /all
58 }
59
60 catch
61 {
62
63 Write-Host "Addition of Windows feature MSMQ HTTP Support
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failed"
64 Exit 1
65 }
66
67 write-Host "Addition of Windows feature MSMQ HTTP Support

succeeded"
68 }

To install the Windows roles and features prerequisites, complete the following steps:

1. On the machine where you plan to install the Session Recording Administration components:

a) Ensure that the execution policy is set to RemoteSigned or Unrestricted in PowerShell.

1 Set-ExecutionPolicy RemoteSigned

b) Start a command prompt as an administrator and run the powershell.exe -file
InstallPrereqsforSessionRecordingAdministration.ps1 command.

The script displays the features that are successfully added and then stops.

c) After the script runs, ensure that the execution policy is set to a proper value basedon your
company policy.

2. On the machine where you plan to install the Session Recording Agent component:

a) Ensure that the execution policy is set to RemoteSigned or Unrestricted in PowerShell.

1 Set-ExecutionPolicy RemoteSigned

b) Start a command prompt as an administrator and run the powershell.exe -file
InstallPrereqsforSessionRecordingAgent.ps1 command.

The script displays the features that are successfully added and then stops.

c) After the script runs, ensure that the execution policy is set to a proper value based on
company policy.

Install the Session Recording Administration components

We recommend that you install the Session Recording Administration, Session Recording Agent, and
Session Recording Player components on separate servers.

The Session Recording Administration components include the Session Recording Database, Session
Recording Server, and Session Recording Policy Console. You can choose the component to install on
a server.
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Note:

Starting with 2110, before installing the Session Recording Administration components on Win‑
dows Server 2016 where TLS 1.0 is disabled, complete the following steps:

1. Install Microsoft OLE DB Driver for SQL Server.

2. Under the HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\.NETFramework\v4
.0.30319 registry key, add the SchUseStrongCrypto DWORD (32‑bit) value and set
the value data to 1.

3. Reboot.

1. Install Broker_PowerShellSnapIn_x64.msi.

Important:

To use the Session Recording Policy Console, install the Broker PowerShell Snap‑in
(Broker_PowerShellSnapIn_x64.msi) manually. Locate the snap‑in on the Citrix
Virtual Apps and Desktops ISO (\layout\image-full\x64\Citrix Desktop
Delivery Controller) and follow the instructions for installation. Failure to comply
can cause an error.

2. Start the Windows command prompt as an administrator, and then run the msiexec /i
SessionRecordingAdministrationx64.msi command or double‑click the .msi file.

3. On the installation UI, clickNext and accept the license agreement.

4. On the Session Recording Administration Setup screen, select the Session Recording Admin‑
istration components you want to install.
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Note:

Installingall theSessionRecordingAdministrationcomponentsona single server is fine for
a proof of concept. However, for a large production environment, we recommend that you
install the Session Recording Policy Console on a separate server and the Session Record‑
ing Server, Session Recording Administrator Logging, and Session Recording Database on
another separate server. The Session Recording Administrator Logging is an optional sub‑
feature of the Session Recording Server. Select the Session Recording Server before you
can select the Session Recording Administrator Logging.

Install the Session Recording Database

Note:

• The Session Recording Database is not an actual database. It is a component responsible
for creating and configuring the required databases in the Microsoft SQL Server instance
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during installation. Session Recording supports three solutions for database high availabil‑
ity based on Microsoft SQL Server. For more information, see Database high availability.

• You can deploy the Session Recording Database on Azure SQL Managed Instance, on SQL
Server on Azure VirtualMachines (VMs), and on AWSRDS. Formore information, see Deploy
theSessionRecordingDatabaseonAzureSQLManaged Instanceor onAWSRDSandDeploy
the Session Recording Database on SQL Server on Azure VMs.

There are typically three types of deployments for the Session Recording Database andMicrosoft SQL
Server:

• Deployment 1: Install the Session Recording Server and Session Recording Database on the
samemachine and the Microsoft SQL Server on a remote machine. (Recommended)

• Deployment 2: Install the Session Recording Server, Session RecordingDatabase, andMicrosoft
SQL Server on the samemachine.

• Deployment 3: Install the Session Recording Server on a machine and install both the Session
Recording Database and Microsoft SQL Server on another machine. (Not recommended)

1. On the Database and Server Configuration page, specify the instance name and database
name of the Session Recording Database and the computer account of the Session Recording
Server. Click Next.

• Instance name: If the database instance is not a named instance as you configured when
you set up the instance, you can use only the computer name of the SQL Server. If you
have named the instance, use computer‑name\instance‑name as the database instance
name. To determine the server instance name that you are using, run select @@server‑
nameon theSQLServer. The return value is the exact database instancename. If your SQL
server is configured to be listening on a customport (other than the default port 1433), set
the custom listener port by appending a comma to the instance name. For example, type
DXSBC‑SRD‑1,2433 in the Instance name text box, where 2433, following the comma, de‑
notes the custom listener port.

• Database name: Type a customdatabase name in theDatabase name text box or use the
default database name preset in the text box. Click Test connection to test the connectiv‑
ity to the SQL Server instance and the validity of the database name.

Important:

A custom database name must contain only A‑Z, a‑z, 0–9, and underscores, and can‑
not exceed 123 characters.

• Youmust have the securityadmin and dbcreator server role permissions of the data‑
base. If you do not have the permissions, you can:
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• Ask the database administrator to assign the permissions for the installation. Af‑
ter the installation completes, the securityadmin and dbcreator server role per‑
missions are no longer necessary and can be safely removed.

• Or, during the msi installation, a dialog box prompts for the credentials of a data‑
base administrator with the securityadmin and dbcreator server role permis‑
sions. Type the correct credentials and then clickOK to continue the installation.

The installation creates the Session Recording Database and adds the machine ac‑
count of the Session Recording Server as db_owner.

• Session Recording Server computer account:

• Deployments 1 and 2: Type localhost in the Session Recording Server computer
account text box.

• Deployment 3: Type the name of the machine hosting the Session Recording Server
in the format of domain\computer‑name. The Session Recording Server computer
account is the user account for accessing the Session Recording Database.

Note:

Attempts to install the Session Recording Administration components can fail with
error code 1603 when a domain name is set in the Session Recording Server
computer account text box. As a workaround, type localhost or NetBIOS domain
name\machine name in the Session Recording Server computer account text
box. To get the NetBIOS domain name, run $env:userdomain in PowerShell or
echo %UserDomain% in a command prompt on the machine where the Session
Recording Server is installed.

2. Follow the instructions to complete the installation.

Install the Session Recording Server

1. Select Session Recording Server and Session Recording Administrator Logging.

Note:

• The Session Recording Administrator Logging is an optional subfeature of the Session
Recording Server. Select the Session Recording Server before you can select the Ses‑
sion Recording Administrator Logging.

• We recommend that you install the SessionRecording Administrator Logging together
with the Session Recording Server at the same time. If you don’t want the Administra‑
tor Logging feature to be enabled, you can disable it on a later page.

2. On the Database and Server Configuration page, specify the settings.
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• Instance name: Type the name of your SQL Server in the Instance name text box. If
you are using a named instance, type computer‑name\instance‑name; otherwise, type
computer‑name only. If your SQL server is configured to be listening on a custom port
(other than the default port 1433), set the custom listener port by appending a comma to
the instance name. For example, type DXSBC‑SRD‑1,2433 in the Instance name text box,
where 2433, following the comma, denotes the custom listener port.

• Database name: Type a customdatabase name in theDatabase name text box or use the
default database name CitrixSessionRecording that is preset in the text box.
Youmust have the securityadmin and dbcreator server role permissions of the database.
If you do not have the permissions, you can:

• Ask thedatabaseadministrator to assign thepermissions for the installation. After the
installation completes, the securityadminanddbcreator server rolepermissions are
no longer necessary and can be safely removed.

• Or, during themsi installation, a dialog box prompts for the credentials of a database
administrator with the securityadmin and dbcreator server role permissions. Type
the correct credentials and then clickOK to continue the installation.

• After typing the correct instance name and database name, click Test connection to test
the connectivity to the Session Recording Database.

• Type the Session Recording Server computer account, and then clickNext.

3. On theAdministration Logging Configuration page, specify configurations for the Administra‑
tion Logging feature.

• Logging database is installed on the SQL Server instance: This text box is not editable.
The SQL Server instance name of the Administration Logging database is automatically
grabbed from the instance name that you typed on the Database and Server Configura‑
tion page.

• Logging database name: To install the Session Recording Administrator Logging feature,
type a custom database name for the Administrator Logging database in this text box or
use the default database name CitrixSessionRecordingLogging that is preset in the text
box.

Note:

TheAdministrator Loggingdatabasenamemustbedifferent fromtheSessionRecord‑
ing Database name that is set in the Database name text box on the previous Data‑
base and Server Configuration page.

• Use default database name: Selecting this option uses the default logging database
name.
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• Enable Logging service: By default, the Administration Logging feature is enabled. You
can disable it by clearing the check box.

• Enable mandatory blocking: By default, mandatory blocking is enabled. The normal
featuresmight be blocked if logging fails. You can disablemandatory blocking by clearing
the check box.

4. ClickNext and proceed to complete the installation.

Note:

The Session Recording Server default installation uses HTTPS/TLS to secure communications. If
TLS is not configured in the default Internet Information Services (IIS) site of the Session Record‑
ing Server, use HTTP. To do so, cancel the selection of SSL in the IIS Management Console by
navigating to the Session Recording Broker site, opening the SSL settings, and clearing the Re‑
quire SSL check box.

Install the Session Recording Agent

Install the Session Recording Agent on the VDA or VDI machine on which you want to record ses‑
sions.

1. On the SessionRecording Agent Configuration page: If you have installed the Session Record‑
ing Server in advance, type the computer name of the machine where you installed the Ses‑
sion Recording Server and the protocol and port information for the connection to the Session
Recording Server. If you have not installed Session Recording yet, you can change such infor‑
mation later in Session Recording Agent Properties.

2. Follow the instructions to complete the installation.

Note:

WhenMachine Creation Services (MCS) or Provisioning Services (PVS) createsmultiple VDAswith
the configured master image and Microsoft Message Queuing (MSMQ) installed, those VDAs can
have the sameQMId under certain conditions. This casemight cause various issues, for example:

• Sessions might not be recorded even if the recording agreement is accepted.
• The Session Recording Server might not be able to receive session logoff signals and there‑
fore, sessions might always be in Live status.

As aworkaround, create a uniqueQMId for each VDA and it differs depending on the deployment
methods.

No extra actions are required if single‑session OS VDAs with the Session Recording Agent in‑
stalled are created with PVS 7.7 or later and MCS 7.9 or later in the static desktop mode that
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is, for example, configured to make all changes persistent with a separate Personal vDisk or the
local disk of your VDA.

For multi‑session OS VDAs created with MCS or PVS and single‑session OS VDAs that are config‑
ured to discard all changes when a user logs off, use the GenRandomQMID.ps1 script to change
the QMId on system startup. Change the power management strategy to ensure that enough
VDAs are running before user logon attempts.

To use the GenRandomQMID.ps1 script, do the following:

1. Ensure that the execution policy is set to RemoteSigned or Unrestricted in PowerShell.

1 Set-ExecutionPolicy RemoteSigned

2. Create a scheduled task, set the trigger as on systemstartup, and runwith the SYSTEMaccount
on the PVS or MCSmaster imagemachine.

3. Add the command as a startup task.

1 powershell .exe -file C:\\GenRandomQMID.ps1

Summary of the GenRandomQMID.ps1 script:

1. Remove the current QMId from the registry.
2. Add SysPrep = 1 to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\MSMQ\

Parameters.
3. Stop related services, including CitrixSmAudAgent and MSMQ.
4. To generate a randomQMId, start the services that stopped previously.

Example GENRANDOMQMID.PS1:

1 # Remove old QMId from registry and set SysPrep flag for MSMQ
2
3 Remove-Itemproperty -Path >HKLM:Software\Microsoft\MSMQ\Parameters\

MachineCache -Name QMId -Force
4
5 Set-ItemProperty -Path HKLM:Software\Microsoft\MSMQ\Parameters -

Name >"SysPrep" -Type DWord -Value 1
6
7 # Get dependent services
8
9 $depServices = Get-Service -name MSMQ -dependentservices | Select -

Property Name
10
11 # Restart MSMQ to get a new QMId
12
13 Restart-Service -force MSMQ
14
15 # Start dependent services
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16
17 if ($depServices -ne $null) {
18
19
20     foreach ($depService in $depServices) {
21
22
23         $startMode = Get-WmiObject win32_service -filter "NAME = '$

($depService.Name)'" | Select -Property StartMode
24
25         if ($startMode.StartMode -eq "Auto") {
26
27
28             Start-Service $depService.Name
29         }
30
31 }
32
33
34 }

Install the Session Recording Player and the web player

Install theSessionRecordingPlayeron theSessionRecordingServeroronworkstations in thedomain.
Install the web player on the Session Recording Server only.

Double‑click SessionRecordingPlayer.msi and SessionRecordingWebPlayer.msi
and follow the instructions to complete the installation.

Automate installation

Session Recording supports silent installation with options. Write a script that uses silent installation
and run the relevant commands.

Automate installation of the Session Recording Administration components

Install the complete set of the Session Recording Administration components by using a single
command For example, either of the following commands installs the complete set of the Session
Recording Administration components and creates a log file to capture the installation information.

1 msiexec /i "c:\SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"
DATABASEINSTANCE="WNBIO-SRD-1" DATABASENAME="CitrixSessionRecording"
LOGGINGDATABASENAME="CitrixSessionRecordingLogging" DATABASEUSER="
localhost" /q /l*vx "yourinstallationlog"
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1 msiexec /i "SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"
DATABASEINSTANCE="CloudSQL" DATABASENAME="CitrixSessionRecording"
LOGGINGDATABASENAME="CitrixSessionRecordingLogging"
AZURESQLSERVICESUPPORT="1" AZUREUSERNAME="CloudSQLAdminName"
AZUREPASSWORD="CloudSQLAdminPassword" /q /l*vx "c:\WithLogging.log"

Note:

The SessionRecordingAdministrationx64.msi file is located on the Citrix Virtual
Apps and Desktops ISO under \layout\image-full\x64\Session Recording.

Where:

• ADDLOCAL provides the features for you to select. You can selectmore than one option. SsRec‑
Server is the Session Recording Server. PolicyConsole is the Session Recording Policy Console.
SsRecLogging is the Administrator Logging feature. StorageDatabase is the Session Recording
Database. Session Recording Administrator Logging is an optional subfeature of the Session
Recording Server. Select the Session Recording Server before you can select Session Recording
Administrator Logging.

• DATABASEINSTANCE is the instance name of the Session Recording database. For example,.\
SQLEXPRESS,computer-name\SQLEXPRESS,computer-name or tcp:srt-sql-
support.public.ca7b16b60789.database.windows.net,3342 if you are using
Azure SQL Managed Instance.

• DATABASENAME is the database name of the Session Recording Database.
• LOGGINGDATABASENAME is the name of the Administrator Logging database.
• AZURESQLSERVICESUPPORT determines whether cloud SQL is supported. To use cloud SQL,
set it to 1.

• DATABASEUSER is the computer account of the Session Recording Server.
• AZUREUSERNAME is the cloud SQL admin name.
• AZUREPASSWORD is the cloud SQL admin password.
• /q specifies quiet mode.
• /l*v specifies verbose logging.
• yourinstallationlog is the location of your installation log file.

Create a master image for deploying the Session Recording Server You might already have the
Session Recording Database and the Administration Logging database in place from an existing de‑
ployment. For such scenarios, you can now forego database checks when you are installing the Ses‑
sion Recording Administration components using SessionRecordingAdministrationx64.msi. You can
create a master image for deploying the Session Recording Server easily on many other machines.
After deploying the Server on target machines using the master image, run a command on each ma‑
chine to connect to the existing Session Recording Database and Administration Logging database.
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This master image support facilitates deployment and minimizes the potential impact of human er‑
ror. It applies only to fresh installations and consists of the following steps:

1. Start a command prompt and run a command similar to the following:

1 msiexec /i "SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"
DATABASEINSTANCE="sqlnotexists" DATABASENAME="
CitrixSessionRecording2" LOGGINGDATABASENAME="
CitrixSessionRecordingLogging2" DATABASEUSER="localhost" /q /l*
vx "c:\WithLogging.log" IGNOREDBCHECK="True"

This command installs the Session Recording Administration components without configuring
and testing connectivity to the Session Recording Database and the Administration Logging
database.

Set the IGNOREDBCHECK parameter to True and use random values for DATABASEINSTANCE,
DATABASENAME, and LOGGINGDATABASENAME.

2. Create a master image on the machine you are operating.

3. Deploy the master image to other machines for deploying the Session Recording Server.

4. On each of the machines, run commands similar to the following:

1 .\SsRecUtils.exe -modifydbconnectionpara DATABASEINSTANCE
DATABASENAME LOGGINGDATABASENAME

2
3 iisreset /noforce

The commands connect the Session Recording Server installed earlier to an existing Session
Recording Database and Administration Logging database.

The SsRecUtils.exe file resides in \Citrix\SessionRecording\Server\bin\.
Set the DATABASEINSTANCE, DATABASENAME, and LOGGINGDATABASENAME parameters as
needed.

Retain databases when uninstalling the Session Recording Administration components With
KEEPDB set to True, the following command retains the Session Recording Database and the Admin‑
istration Logging database when uninstalling the Session Recording Administration components:

1 msiexec /x "SessionRecordingAdministrationx64.msi" KEEPDB="True"

Automate installation of the Session Recording Player andweb player

For example, the following commands install the Session Recording Player and web player, respec‑
tively.
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1 msiexec /i "c:\SessionRecordingPlayer.msi" /q /l*\vx "
yourinstallationlog"

1 msiexec /i "c:\SessionRecordingWebPlayer.msi" /q /l*vx "
yourinstallationlog"

Note:

The SessionRecordingPlayer.msi file is located on the Citrix Virtual Apps and Desktops
ISO under \layout\image-full\x86\Session Recording.

The SessionRecordingWebPlayer.msi file is located on the Citrix Virtual Apps and Desk‑
tops ISO under \layout\image-full\x64\Session Recording.

Where:

• /q specifies quiet mode.
• /l*v specifies verbose logging.
• yourinstallationlog is the location of your installation log file.

Automate installation of the Session Recording Agent For example, the following command in‑
stalls the Session Recording Agent and creates a log file to capture the installation information.

1 msiexec /i SessionRecordingAgentx64.msi /q /l*vx yourinstallationlog
SESSIONRECORDINGSERVERNAME=yourservername

2 SESSIONRECORDINGBROKERPROTOCOL=yourbrokerprotocol
SESSIONRECORDINGBROKERPORT=yourbrokerport

Note:

The SessionRecordingAgentx64.msi file is located on the Citrix Virtual Apps and Desk‑
tops ISO under \layout\image-full\x64\Session Recording.

Where:

• yourservername is the NetBIOS name or FQDN of the machine hosting the Session Recording
Server. If not specified, this value defaults to localhost.

• yourbrokerprotocol is HTTP or HTTPS that the Session Recording Agent uses to communicate
with the Session Recording Broker. If not specified, this value defaults to HTTPS.

• yourbrokerport is the port number that the Session Recording Agent uses to communicate
with the Session Recording Broker. If not specified, this value defaults to zero, which directs the
Session Recording Agent to use the default port number for your selected protocol: 80 for HTTP
or 443 for HTTPS.

• /q specifies quiet mode.
• /l*v specifies verbose logging.
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• yourinstallationlog is the location of your installation log file.

Upgrade Session Recording

You can upgrade certain deployments to later versions without having to first set up newmachines or
sites. You can upgrade from the latest CU of Session Recording 7.15 LTSR, and from any later version,
to the latest release of Session Recording.

Note:

When you upgrade Session Recording Administration from 7.6 to 7.13 or later and chooseMod‑
ify in SessionRecording Administration to add the Administrator Logging service, the SQLServer
instance name does not appear on the Administrator Logging Configuration page. The follow‑
ing errormessage appearswhen you clickNext: Database connection test failed. Pleaseenter
correctDatabase instancename. As aworkaround, add the readpermission for localhost users
to the following SmartAuditor Server registry folder: HKEY_LOCAL_MACHINE\SOFTWARE\
Citrix\SmartAuditor\Server.

You cannot upgrade from a Technical Preview version.

Requirements, preparation, and limitations

• Use the Session Recording installer’s graphical or command line interface to upgrade the Ses‑
sion Recording components on the machine where you installed the components.

• Before any upgrade activity, back up the database named CitrixSessionRecording in the SQL
Server instance. In this way, you can restore it if any issues are discovered after the database
upgrade.

• In addition to being a domain user, you must be a local administrator on the machines where
you are upgrading the Session Recording components.

• If the Session Recording Server and Session Recording Database are not installed on the same
server, youmust have thedatabase role permission toupgrade the SessionRecordingDatabase.
Otherwise, you can:

• Ask the database administrator to assign the securityadmin and dbcreator server role
permissions for the upgrade. After the upgrade completes, the securityadmin anddbcre‑
ator server role permissions are no longer necessary and can be safely removed.

• Or, use the SessionRecordingAdministrationx64.msi file to upgrade. During
themsi upgrade, a dialog box prompts for the credentials of a database administratorwho
has the securityadmin and dbcreator server role permissions. Type the correct creden‑
tials and then clickOK to continue the upgrade.
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• If youdonot plan to upgrade all the SessionRecording Agents at the same time, SessionRecord‑
ing Agent 7.6.0 (and later) is compatible with the latest (current) release of Session Recording
Server. However, some new features and bug fixes might not take effect.

• Any sessions started during the upgrade of Session Recording Server are not recorded.
• The Graphics Adjustment option in Session Recording Agent Properties is enabled by default
after a fresh installation or upgrade to keep compatible with the Desktop Composition Redirec‑
tion mode. You can disable this option manually after a fresh installation or upgrade.

• The Administrator Logging feature is not installed after you upgrade Session Recording from a
previous release where the feature is unavailable. To add the feature, modify the installation
after the upgrade.

• If there are live recording sessions when the upgrade process starts, there is little chance that
the recording can be complete.

• Review the following upgrade sequence, so that you can plan andmitigate potential outages.

Upgrade sequence

1. When the Session Recording Database and Session Recording Server are installed on different
servers, stop theSessionRecordingStorageManager servicemanuallyon theSessionRecording
Server. Then upgrade the Session Recording Database first.

2. Through the Internet Information Services (IIS)Manager, ensure that the SessionRecordingBro‑
ker is running. Upgrade the Session Recording Server. If the Session Recording Database and
Session Recording Server are installed on the same server, the Session Recording Database is
also upgraded.

3. The Session Recording service is back online automatically when the upgrade of the Session
Recording Server is completed.

4. Upgrade the Session Recording Agent (on the master image).
5. Upgrade the Session Recording Policy Console with or after the Session Recording Server.
6. Upgrade the Session Recording Player.

Deploy the Session Recording Database on cloud SQL database services

This sectiondescribeshow todeploy theSessionRecordingDatabaseonAzureSQLManaged Instance,
on AWS RDS, and on SQL Server on Azure VMs.

Deploy the Session Recording Database on Azure SQL Managed Instance or on AWS RDS

Tip:

You can also run a single command similar to the following todeploy the SessionRecordingData‑
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base on Azure SQL Managed Instance or on AWS RDS. For more information, see the preceding
Automate installation section in this article.

1 msiexec /i "SessionRecordingAdministrationx64.msi" ADDLOCAL="
SsRecServer,PolicyConsole,SsRecLogging,StorageDatabase"
DATABASEINSTANCE="CloudSQL" DATABASENAME="CitrixSessionRecording"
LOGGINGDATABASENAME="CitrixSessionRecordingLogging"
AZURESQLSERVICESUPPORT="1" AZUREUSERNAME="CloudSQLAdminName"
AZUREPASSWORD="CloudSQLAdminPassword" /q /l*vx "c:\WithLogging.log"

1. Create anAzure SQLManaged instanceor create a SQLServer instance through theAmazonRDS
console.

2. (For Azure SQL only) Keep a record of the Server strings that appear in the properties panel.
The strings are the instance name of the Session Recording Database. For an example, see the
following screen capture.

3. (For AWS RDS only) Keep a record of the Endpoint and Port information. We use it as the in‑
stance name of your database, in the format of <Endpoint, Port>.
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4. Run SessionRecordingAdministrationx64.msi to install the Session Recording Database.

Select the Enable cloud SQL check box and fill in the cloud SQL admin name and password.
Make other required configurations.
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Note:

If you change the cloud SQL admin password, you must update the password in Session
Recording Server Properties. When you open Session Recording Server Properties,
an error message appears. Click OK to proceed, select the Cloud DB tab, and type the
new cloud SQL admin password. Restart the Citrix Session Recording Analytics service,
the Citrix Session Recording Storage Manager service, and the IIS service.

Azure AD authentication is not supported.
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Migrate an on‑premises database to cloud SQLManaged Instance

1. Migrate your on‑premises database according to https://docs.microsoft.com/en‑us/data‑
migration/ or https://docs.aws.amazon.com/prescriptive‑guidance/latest/patterns/migrate‑
an‑on‑premises‑microsoft‑sql‑server‑database‑to‑amazon‑rds‑for‑sql‑server.html.

2. To make Session Recording work properly after the migration, run SsRecUtils.exe on the
Session Recording Server.

C:\Program Files\Citrix\SessionRecording\Server\bin\SsRecUtils.
exe -modifyazuredbconnectionpara { Database Instance } { Session
Recording Database Name } { Session Recording Logging Database
Name } { AzureAdminName } { AzureAdminPassword } iisreset /

noforce

3. On theSessionRecordingServer, restart theCitrix SessionRecordingAnalytics service, theCitrix
Session Recording Storage Manager service, and the IIS service.
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Migrate a production database from Azure SQL Managed Instance to an on‑premises database

1. Migrate the database according to https://docs.microsoft.com/en‑us/data‑migration/.

2. To make Session Recording work properly after the migration, run SsRecUtils.exe on the
Session Recording Server.

C:\Program Files\Citrix\SessionRecording\Server\bin\SsRecUtils
.exe -modifydbconnectionpara { Database Instance } { Session
Recording Database Name } { Session Recording Logging Database
Name } iisreset /noforce

3. On theSessionRecordingServer, restart theCitrix SessionRecordingAnalytics service, theCitrix
Session Recording Storage Manager service, and the IIS service.

Deploy the Session Recording Database on SQL Server on Azure VMs

On SQL Server on Azure VMs, you can deploy the Session Recording Database.

1. Check out an Azure SQL VM.
2. Configure the VMandadd it to thedomainwhere you install the SessionRecording components.
3. Use the VM’s FQDN as the instance name during the installation of the Session Recording Data‑

base.
Note: When you are using SessionRecordingAdministrationx64.msi for the installation, clear
the Enable cloud SQL check box.

4. Follow instructions to complete the installation.

Uninstall Session Recording

To remove the Session Recording components from a server or workstation, use the uninstall
or remove programs option available from the Windows Control Panel. To remove the Session
Recording Database, youmust have the same securityadmin and dbcreator SQL Server role permis‑
sions as when you installed it.

For security reasons, the Administrator Logging Database is not removed after the components are
uninstalled.

Dynamic session recording

December 26, 2025
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Previously, session recording started strictly at the very beginning of sessions that met the recording
policies and stopped strictly when those sessions ended.

Starting with the 7.18 release, Citrix introduces the dynamic session recording feature. With this fea‑
ture, you can start or stop recording a specific session or sessions that a specific user launches, at any
time during the sessions.

Note:

Tomake the feature work as expected, upgrade Session Recording, VDA, and Delivery Controller
to Version 7.18 or later.

Enable or disable dynamic session recording

On the Session Recording Agent, a registry value is added for enabling or disabling the feature. The
registry value is set to 1 by default, which means that the feature is enabled by default.

To enable or disable the feature, complete the following steps:

1. After the Session Recording installation is complete, log on as an administrator to the machine
where you installed the Session Recording Agent.

2. Open the Registry Editor.
3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor.
4. Set the value of DynamicControlAllowed to 0 or use the default value, 1.

1: enable dynamic recording
0: disable dynamic recording

5. Restart the Session Recording Agent to make your setting take effect.
If you are using MCS or PVS for deployment, change the setting on your master image and per‑
form an update to make your change take effect.

Warning:

Incorrectly editing the registry can cause serious problems that might require you to reinstall
your operating system. Citrix® cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

Dynamically start or stop recording by using PowerShell commands in the Citrix SDKs

Youcanuse thedynamic session recording feature inbothon‑premises andCitrix Cloudenvironments
by using the Citrix Virtual Apps and Desktops™ PowerShell SDK and the Citrix Virtual Apps and Desk‑
tops Remote PowerShell SDK, respectively.
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To determine which SDK to install and use, be aware of the Delivery Controller you specified when
creating your recording policy. If you select the Citrix Cloud Controller check box to record sessions
in a Citrix Cloud environment, youmust validate your Citrix Cloud credentials. For more information,
see Create a custom recording policy.

Note:

Do not install the Remote PowerShell SDK on a Citrix Cloud Connector™machine. You can install
the Remote PowerShell SDK on any domain‑joined machine within the same resource location.
We recommend that you do not run this SDK’s cmdlets on Cloud Connectors. The SDK’s opera‑
tion does not involve the Cloud Connectors.

The following table lists three PowerShell commands that both Citrix SDKs provide for dynamic ses‑
sion recording.
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Command Description

Start‑BrokerSessionRecording Lets you start recording a specific active session,
a list of active sessions, or sessions launched by
a specific user. For more information, run Get-
Help Start-BrokerSessionRecording
to see the command online help.

Stop‑BrokerSessionRecording Lets you stop recording a specific active session,
a list of active sessions, or sessions launched by
a specific user. For more information, run Get-
Help Stop-BrokerSessionRecording
to see the command online help.

Get‑BrokerSessionRecordingStatus Lets you get the recording status of a specific
active session. For more information, run
Get-Help Get-
BrokerSessionRecordingStatus to see
the command online help.

For example, when a user reports an issue and needs timely support, you can use the feature to dy‑
namically start recording the user’s active sessions and play back the live recording to proceed with
the follow‑up troubleshooting. You can do the following:

1. (For Citrix Virtual Apps™ and Desktops PowerShell SDK only) Launch PowerShell from the Citrix
Studio console.

2. Use the Get-BrokerSession command to get all the active sessions of the target user.
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3. Use the Get-BrokerSessionRecordingStatus command to get the recording status of
the specified session.

Note:

The ‑Session parameter can accept only one session Uid at a time.

4. Use the Start-BrokerSessionRecording command to start recording. By default, a no‑
tification message appears to inform users of the recording activity.

The following table shows commonways of using the Start-BrokerSessionRecording
command.

Command Description

Start‑BrokerSessionRecording ‑User DomainA \
UserA

Starts recording all sessions of user UserA in the
domain named DomainA and notifies UserA.

Start‑BrokerSessionRecording ‑User DomainA \
UserA ‑NotifyUser $false

Starts recording all sessions of user UserA in the
domain named DomainA and does not notify
UserA.

Start‑BrokerSessionRecording ‑Sessions
$SessionObject

Starts recording all sessions in the object named
$SessionObject and notifies the user. To get the
object $SessionObject, run
$SessionObject=Get-BrokerSession
–username UserA. The name of an object is
prefixed with a dollar sign $. For more
information, see Step 2 and the command online
help.

Start‑BrokerSessionRecording ‑Sessions
uid1,uid2,…,uidn

Starts recording the sessions uid1, uid2,…, and
uidn, and notifies the users.

5. Use the Get-BrokerSessionRecordingStatus command to get the recording status of
each target session. The status is supposed to be SessionBeingRecorded.
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6. Play back the Live or Complete recordings in the Session Recording Player and proceed with
the follow‑up troubleshooting.

Note�

The last section of the timeline on the Player progress bar might show gray when you
play back a “Complete”recording ended by the Stop-BrokerSessionRecording
command and the last section of the recorded session is idle. It is not obvious when the
recorded session has constant activities.

7. Use the Stop-BrokerSessionRecording command to stop recording when the reported
issue has been triaged or resolved.

The following table shows common ways of using this command:

Command Description

Stop‑BrokerSessionRecording ‑User DomainA \
UserA

Stops recording all sessions of user UserA in the
domain named DomainA.

Stop‑BrokerSessionRecording ‑Sessions
$SessionObject

Stops recording all sessions in the
$SessionObject.

Stop‑BrokerSessionRecording ‑Sessions
uid1,uid2,…,uidn

Stops recording the sessions uid1, uid2,…, and
uidn.

On theCitrixStudioLogging screen, youcanviewthe resulting logsof theStart-BrokerSessionRecording
and Stop-BrokerSessionRecording commands.
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Configure

September 7, 2025

After installing the Session Recording components, you can perform the following steps to config‑
ure Session Recording to record Citrix Virtual Apps and Desktops™ sessions and allow users to view
them:

• Configure the connection to the Session Recording Server
• Authorize users
• Create and activate recording policies
• Specify where recordings are stored
• Specify file size for recordings
• Customize notification messages
• Enable or disable recording
• Enable or disable digital signing
• Administrator Logging
• Database high availability
• Load balancing
• Change your communication protocol
• Configure CEIP

Configure the connection to the Session Recording Server

September 7, 2025

Configure the connection of the Session Recording Player to the Session Recording
Server

Before a Session Recording Player can play sessions, configure it to connect to the Session Recording
Server that stores the recorded sessions. Each Player can be configured with the ability to connect to
multiple Session Recording Servers, but can connect to only one Session Recording Server at a time.
If the Player is configured with the ability to connect to multiple Session Recording Servers, users
can change which Session Recording Server the Player connects to by selecting a check box on the
Connections tab at Tools >Options.

1. Log on to the workstation where the Session Recording Player is installed.
2. Start the Session Recording Player.
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3. From the Session Recording Player menu bar, choose Tools >Options.
4. On the Connections tab, click Add.
5. In theHostname field, type the name or IP address of themachine hosting the Session Record‑

ing Server and select the protocol. By default, Session Recording is configured to use HTTP‑
S/SSL to secure communications. If SSL is not configured, select HTTP.

6. Toconfigure theSessionRecordingPlayerwith theability to connect tomultipleSessionRecord‑
ing Servers, repeat Steps 4 and 5 for each Session Recording Server.

7. Ensure that you select the check box for the Session Recording Server you want to connect to.

Configure the connection of the Session Recording Agent to the Session Recording
Server

The connection between the Session Recording Agent and the Session Recording Server is typically
configured when the Session Recording Agent is installed. To configure this connection after the Ses‑
sion Recording Agent is installed, use Session Recording Agent Properties.

1. Log on to the server where the Session Recording Agent is installed.

2. From the Startmenu, choose Session Recording Agent Properties.

3. Click the Connections tab.

4. In the Session Recording Server field, type the FQDN of the Session Recording Server.

Note:

To useMessageQueuing over HTTPS (TCP is used by default), type an FQDN in the Session
Recording Server field. Otherwise, session recording fails.

5. In the Session Recording Storage Manager message queue section, select the protocol that
is used by the Session Recording StorageManager to communicate and change the default port
number if necessary.

Note:

To use Message Queuing over HTTP and HTTPS, install all the IIS recommended features.

6. In theMessage life field, accept the default 7,200 seconds (two hours) or type a new value for
thenumberof secondseachmessage is retained in thequeue if there is a communication failure.
After this time elapses, the message is deleted and the file is playable until the point where the
data is lost.

7. In the Session Recording Broker section, select the communication protocol that the Session
Recording Broker uses to communicate and change the default port number if necessary.

8. When prompted, restart the Session Recording Agent Service to accept the changes.
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Authorize users

September 7, 2025

To grant users the rights, you assign users to roles using the Session Recording Authorization Console
on the Session Recording Server. Five roles are available:

Important:

For security reasons, grant users only the rights they need to perform specific functions, such as
viewing recorded sessions.

• PolicyAdministrator. Grants the right to view, create, edit, delete, and enable recording poli‑
cies. By default, administrators of the machine hosting the Session Recording Server are mem‑
bers of this role.

• PolicyQuery. Allows the servers hosting the Session Recording Agent to request recording pol‑
icy evaluations. By default, authenticated users are members of this role.

• LoggingWriter. Grants the right to write the Administrator Logging logs. By default, local ad‑
ministrators and the Network Service group are members of this role. Changing the default
LoggingWritermembership can cause log writing failure.

• LoggingReader. Grants the right to query the Administrator Logging logs. There is no default
membership in this role.

• Player. Grants the right to view recorded Citrix Virtual Apps and Desktops™ sessions. There is
no default membership in this role. When you install Session Recording, no user has the right
to play recorded sessions. You must assign the right to each user, including the administrator.
A user without the permission to play recorded sessions receives the following error message
when trying to play a recorded session:

To assign users to a role, do the following:

1. Log on as an administrator to the machine hosting the Session Recording Server.
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2. Start the Session Recording Authorization Console.
3. Select the role to which you want to assign users.
4. From themenu bar, choose Action > Assign Users and Groups.
5. Add the users and groups.

Session Recording supports users and groups defined in Active Directory.

Any changes made to the console take effect during the update that occurs once every minute. Also,
starting with the 1906 release, you can use the Session Recording Policy Console to create recording
viewing policies. For more information, see Recording viewing policies.

Configure policies

December 26, 2025

Use the Session Recording Policy Console to create recording policies, event detection policies, event
responsepolicies, and recording viewingpolicies. Whencreating thepolicies, youcan specifyDelivery
Controllers from both the Citrix Cloud™ and on‑premises environments.

Important:

To use the Session Recording Policy Console, youmust have the Broker PowerShell Snap‑in (Bro‑
ker_PowerShellSnapIn_x64.msi) or the Citrix Virtual Apps andDesktops Remote PowerShell SDK
(CitrixPoshSdk.exe) installed manually. Locate the Broker PowerShell snap‑in on the Citrix Vir‑
tual AppsandDesktops ISO (\layout\image‑ full\x64\CitrixDesktopDeliveryController), or down‑
load theCitrix Virtual AppsandDesktopsRemotePowerShell SDK fromtheCitrix Virtual Appsand
Desktops Service download page.

Tip:

You can edit the registry to prevent recording file losses in case that your Session Record‑
ing Server might fail unexpectedly. Log on as an administrator to the machine where you
installed the Session Recording Agent, open the Registry Editor, and add a DWORD value
DefaultRecordActionOnError =1 under HKEY_LOCAL_MACHINE\SOFTWARE\
Citrix\SmartAuditor\Agent.

Recording policies

You can activate system‑defined recording policies or create and activate your own custom recording
policies. System‑defined recording policies apply a single rule to all users, published applications,
and servers. Custom recording policies specifying which users, published applications, and servers
are recorded.
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The active recording policy determines which sessions are recorded. Only one recording policy is ac‑
tive at a time.

System‑defined recording policies

Session Recording provides the following system‑defined recording policies:

• Donot record. Thedefault policy. If youdonot specify another policy, no sessions are recorded.

• Record only events (for everyone, with notification). This policy records only events that
your event detection policy specifies. It does not record screens. Users receive recording notifi‑
cations in advance.

• Recordonly events (for everyone,without notification). This policy records only events that
your event detection policy specifies. It does not record screens. Users do not receive recording
notifications.

• Record entire sessions (for everyone, with notification). This policy records entire sessions
(screens and events). Users receive recording notifications in advance.

• Record entire sessions (for everyone, without notification). This policy records entire ses‑
sions (screens and events). Users do not receive recording notifications.

You cannot modify or delete the system‑defined recording policies.

Create a custom recording policy

When you create your own recording policy, you make rules to specify which users or groups, pub‑
lished applications or desktops, delivery groups or VDA machines, and Citrix Workspace™ app client
IP addresses are being recorded. A wizard within the Session Recording Policy Console helps you cre‑
ate rules. To obtain the list of published applications or desktops and the list of delivery groups or
VDA machines, you must have the read permission as a site administrator. Configure the administra‑
tor read permission on the Delivery Controller™ of the site.

For each rule you create, you specify a recording action and rule criteria. The recording action applies
to sessions that meet the rule criteria.

For each rule, choose one recording action:

• Enable session recording with notification. This option records entire sessions (screens and
events). Users receive recording notifications in advance.

• Enable session recording without notification. This option records entire sessions (screens
and events). Users do not receive recording notifications.
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• Enable event only session recording with notification. This option records throughout ses‑
sions only events that your event detection policy specifies. It does not record screens. Users
receive recording notifications in advance.

• Enable event only session recording without notification. This option records throughout
sessionsonly events that youreventdetectionpolicy specifies. It doesnot record screens. Users
do not receive recording notifications.

• Disable session recording. This option means that no sessions will be recorded.

For each rule, choose at least one of the following items to create the rule criteria:

• UsersorGroups. Creates a list of usersor groups towhich theactionof the rule applies. Session
Recording allows you to use Active Directory groups and white list users.

• Published Applications or Desktop. Creates a list of published applications or desktops to
which the action of the rule applies. In the Rules wizard, choose the Citrix Virtual Apps and
Desktops™ Site or Sites on which the applications or desktops are available.

• DeliveryGroupsorMachines. Creates a list of DeliveryGroupsormachines towhich the action
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of the rule applies. In theRuleswizard, choose the location of the Delivery Groups ormachines.

• IP Address or IP Range. Creates a list of IP addresses or ranges of IP addresses to which the
action of the rule applies. On theSelect IP Address and IPRange screen, add a valid IP address
or IP range forwhich recording is enabled or disabled. The IP addressesmentioned here are the
IP addresses of the Citrix Workspace apps.

Note:

The Session Recording Policy Console supports configuringmultiple criteria within a single rule.
When a rule applies, both the “AND”and the “OR”logical operators are used to compute the fi‑
nal action. Generally speaking, the “OR”operator is used between items within a criterion, and
the “AND”operator is used between separate criteria. If the result is true, the Session Recording
policy engine takes the rule’s action. Otherwise, it goes to the next rule and repeats the process.

When you createmore than one rule in a recording policy, some sessions might match the criteria for
more than one rule. In these cases, the rule with the highest priority is applied to the sessions.

The recording action of a rule determines its priority:
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• Rules with the Do not record action have the highest priority.
• Rules with the Record with notification action have the second‑to‑highest priority.
• Rules with the Record without notification action have the second‑to‑lowest priority.
• Ruleswith theEnableeventonly session recordingwithnotificationactionhave themedium
priority.

• Ruleswith theEnable event only session recordingwithout notification action have the low‑
est priority.

Some sessionsmight notmeet any rule criteria in a recording policy. For these sessions, the action of
the policy fallback rule applies. The action of the fallback rule is always Do not record. You cannot
modify or delete the fallback rule.

To create a custom recording policy:

1. Log on as an authorized Policy Administrator to the server where the Session Recording Policy
Console is installed.

2. Start the Session Recording Policy Console and selectRecordingPolicies in the left pane. From
themenu bar, choose Add New Policy.

3. Right‑click theNew policy and select Add Rule.

4. In the rules wizard, select a recording option and then clickNext.
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5. Select the rule criteria ‑ You can choose one or more rule criteria:
Users or Groups
Published Applications or Desktop
Delivery Groups or Machines
IP Address or IP Range
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6. Edit the rule criteria ‑ To edit, click the underlined values. The values are underlined based on
the criteria you chose in the previous step.

Note:

If you choose the Published Applications or Desktop underlined value, the Site Address
is the IP address, a URL, or a machine name if the Controller is on a local network. The
Name of Application list shows the display name.

When choosing Published Applications or Desktop or Delivery Groups or Machines, specify
the Delivery Controller for your Session Recording Policy Console to communicate with.

The Session Recording Policy Console is the only channel to communicate with Delivery Con‑
trollers from the Citrix Cloud and on‑premises environments.
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For example, when choosing Delivery Groups or Machines, click the corresponding hyperlink
in Step 3 of the preceding screenshot and click Add to add queries to the Controller.
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For a description of use cases that cover the on‑premises and the Citrix Cloud Delivery Con‑
trollers, see the following table:

Use Case Action Required

On‑Premises Delivery Controller
a) Install Broker_PowerShellSnapIn_x64.msi.

2. Clear the Citrix Cloud Controller check
box.
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Use Case Action Required

Citrix Cloud Delivery Controller
a) Install the Citrix Virtual Apps™ and

Desktops Remote PowerShell SDK. 2.
Validate the Citrix Cloud account
credentials. 3. Select the Citrix Cloud
Controller check box.

Switch from an on‑premises Delivery Controller
to a Citrix Cloud Delivery Controller

a) Uninstall
Broker_PowerShellSnapIn_x64.msi and
restart the machine. 2. Install the Citrix
Virtual Apps and Desktops Remote
PowerShell SDK. 3. Validate the Citrix
Cloud account credentials. 4. Select the
Citrix Cloud Controller check box.

Switch from a Citrix Cloud Delivery Controller to
an on‑premises Delivery Controller

a) Uninstall the Citrix Virtual Apps and
Desktops Remote PowerShell SDK and
restart the machine. 2. Install
Broker_PowerShellSnapIn_x64.msi. 3.
Clear the Citrix Cloud Controller check
box.

Validating the Citrix Cloud credentials

To query Delivery Controllers hosted in the Citrix Cloud, manually validate your Citrix Cloud
credentials on the machine where the Session Recording Policy Console is installed. Failure
to comply can cause an error and your Session Recording Policy Console might not work as
expected.

To do the manual validation:

a) Log on to the Citrix Cloud console and locate Identity and Access Management > API
Access. Create an API access Secure Client for obtaining an authentication profile that can
bypass the Citrix Cloud authentication prompts. Download your Secure Client, rename,
and save it in a safe location. The file name is defaulted to secureclient.csv.

© 1997–2025 Citrix Systems, Inc. All rights reserved. 72



Session Recording 2110

b) Open a PowerShell session and run the following command to have the authentication
profile (obtained in the preceding step) take effect.

1 asnp citrix.*
2 Set-XDCredentials -CustomerId "citrixdemo" -SecureClientFile "

c:\temp\secureclient.csv" -ProfileType CloudAPI – StoreAs "
default"

Set CustomerId and SecureClientFile as required. The preceding command creates a
default authentication profile for the customer citrixdemo to bypass authentication
prompts in the current and all subsequent PowerShell sessions.

7. Follow the wizard to finish the configuration.

Note: Limitation regarding prelaunched application sessions:

• If the active policy tries to match an application name, the applications launched in the
prelaunched session are not matched, which results in the session not being recorded.

• If the active policy records every application, when a user logs on to Citrix Workspace app
for Windows (at the same time that a prelaunched session is established), a recording noti‑
fication appears and the prelaunched (empty) session and any applications to be launched
in that session going forward are recorded.

As a workaround, publish applications in separate Delivery Groups according to their recording
policies. Do not use an application name as a recording condition. This approach ensures that
prelaunched sessions can be recorded. However, notifications still appear.

Use Active Directory groups Session Recording allows you to use Active Directory groups when
creating policies. Using Active Directory groups instead of individual users simplifies the creation and
management of rules and policies. For example, if users in your company’s finance department are
contained in an Active Directory group named Finance, you can create a rule that applies to all mem‑
bers of this group by selecting the Finance group in the
Ruleswizard when creating the rule.
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White list users You can create Session Recording policies ensuring that the sessions of some users
in your organization are never recorded. This case is called
white listing these users. White listing is useful for users who handle privacy‑related information or
when your organization does not want to record the sessions of a certain class of employees.

For example, if all managers in your company are members of an Active Directory group named Exec‑
utive, you can ensure that sessions of these users are never recorded by creating a rule that disables
session recording for the Executive group. While the policy containing this rule is active, no sessions
ofmembers of the Executive group are recorded. The sessions of othermembers of your organization
are sessions recorded based on other rules in the active policy.

Configure Director to use the Session Recording Server

You can use the Director console to create and activate the recording policies.

1. For an HTTPS connection, install the certificate to trust the Session Recording Server in the
Trusted Root Certificates of the Director server.

2. Toconfigure theDirector server touse theSessionRecordingServer, run theC:\inetpub\wwwroot\Director\tools\DirectorConfig.exe
/configsessionrecording command.

3. Type the IP address or FQDN of the Session Recording Server and the port number and con‑
nection type (HTTP/HTTPS) that the Session Recording Agent uses to connect to the Session
Recording Broker on the Director server.

Event detection policies

Session Recording supports centralized configuration of event detection policies. You can create poli‑
cies in the Session Recording Policy Console to log various events.

Note:

To log the insertion of USBmass storage devices and the application starts and ends, use Session
Recording Version 1811 or later.
To log file operation events and web browsing activities, use Session Recording Version 1903 or
later.
To log clipboard activities, use Session Recording Version 2012 or later.

System‑defined event detection policy

The system‑defined event detection policy isDo not detect. It is inactive by default. When it is active,
no events are logged.
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You cannot modify or delete the system‑defined event detection policy.

Create a custom event detection policy

When you create your own event detection policy, you make rules to specify which users or groups,
publishedapplicationsordesktops, delivery groupsor VDAmachines, andCitrixWorkspaceappclient
IPaddresseshave specific events loggedduring session recording. Awizardwithin theSessionRecord‑
ing Policy Console helps you create rules. To obtain the list of published applications or desktops and
the list of delivery groups or VDAmachines, youmust have the read permission as a site administrator.
Configure the administrator read permission on the Delivery Controller of the site.

To create a custom event detection policy:

1. Log on as an authorized Policy Administrator to the server where the Session Recording Policy
Console is installed.

2. Start the Session Recording Policy Console.
By default, there is no active event detection policy.

3. Select Event Detection Policies in the left pane. From the menu bar, choose Add New Policy
to create an event detection policy.

4. (Optional) Right‑click the new event detection policy and rename it.
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5. Right‑click the new event detection policy and select Add Rule.

a) Specify one ormore target events tomonitor by selecting the check box next to each event
type.
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• Log CDM mapped USB events: Logs the insertion of a Client Drive Mapping (CDM)
mapped mass storage device in a client device where Citrix Workspace app for Win‑
dows or for Mac is installed, and tags the event in the recording.

• Log generic redirected USB events: Logs the insertion of a generic redirected mass
storage device in a client where Citrix Workspace app for Windows or for Mac is in‑
stalled, and tags the event in the recording.

• Log app start events: Logs the starts of target applications and tags the event in the
recording.

• Log app end events: Logs the ends of target applications and tags the event in the
recording.

Note:

Session Recording cannot log the end of an application without logging its start.
Therefore, in the Rules wizard, the Log app end events check box is grayed out
before you select Log app start events.

• Appmonitoring list: When you selectLogapp start events and Logappendevents,
use the Appmonitoring list to specify target applications tomonitor and to avoid an
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excessive number of events from flooding the recordings.

Note:

• To capture the start and end of an application, add the process name of the
application in the App monitoring list. For example, to capture the start of
Remote Desktop Connection, add the process name mstsc.exe to the App
monitoring list. When you add a process to the Appmonitoring list, applica‑
tions driven by the added process and its child processes are monitored. Ses‑
sion Recording adds the process names, cmd.exe, powershell.exe, and
wsl.exe, to the Appmonitoring list by default. If you select Log app start
events and Log app end events for an event detection policy, the starts and
endsof theCommandPrompt, PowerShell, andWindowsSubsystem for Linux
(WSL) apps are logged regardless of whether you manually add their process
names to the Appmonitoring list. The default process names are not visible
on the Appmonitoring list.

• Separate process names with a semicolon (;).
• Only the exact match is supported. Wildcards are not supported.
• Process names you add are case‑insensitive.
• To avoid an excessive number of events from flooding the recordings, do not
add any system process names (for example, explorer.exe) and web browsers
in the registry.

• Log fileoperations: Logsoperationson target files that you specified in theFilemon‑
itoring list and logs file transfers between session hosts (VDAs) and client devices (in‑
cludingmapped client drives and generic redirectedmass storage devices). Selecting
this option triggers the logging of file transfers, no matter whether or not you specify
the File monitoring list.

• File events presented in the web player
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• File events presented in the Session Recording Player

• File monitoring list: When you select Log file operations, use the File monitoring
list to specify target files tomonitor. You can specify folders to capture all files within
them. No file is specified by default, which means no file is captured by default.

Note:

• To capture renaming, creation, deletion, or moving operations on a file, add
the path string of the file folder (not the file name or the root path of the
file folder) in the File monitoring list. For example, to capture renaming,
creation, deletion, and moving operations on the sharing.ppt file in C:\
User\File, add the path string C:\User\File in the File monitoring
list.

• Both local file paths and remote shared folder paths are supported. For exam‑
ple, to capture operations on the RemoteDocument.txt file in the \\remote
.address\Documents folder, add the path string \\remote.address
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\Documents in the File monitoring list.
• Separate monitored paths with a semicolon (;).
• Only exact matches are supported. Wildcards are not supported.
• Path strings are case‑insensitive.

Limitations:

• Copying files or folders from amonitored folder to an unmonitored folder cannot
be captured.

• When the length of a file or folder path including the file or folder name exceeds
the maximum length (260 characters), operations on the file or folder cannot be
captured.

• Pay attention to thedatabase size. Toprevent largenumbers of events frombeing
captured, back up or delete the “Event”table regularly.

• When large numbers of events are captured at time intervals, the Player displays
and the database stores only one event item for each event type to avoid storage
expansion.

• Log web browsing activities: Logs user activities on supported browsers and tags
the browser name, URL, and page title in the recording.

List of supported browsers:

Browser Version

Chrome 69 and later

Internet Explorer 11

Firefox 61 and later

• Log topmostwindowevents: Logs the topmostwindowevents and tags the process
name, title, and process number in the recording.
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• Log clipboard activities: Logs copy operations of text, images, and files using the
clipboard. The process name and file path are logged for a file copy. The process
name and title are logged for a text copy. The process name is logged for an image
copy.

• Log registry modifications: Logs modifications in the Windows registry that occur
during recorded sessions. The detected registry modifications include adding a key
or value, renaming a key or value, changing an existing value, and deleting a key or
value.

• Registry monitoring list: When you select Log registry modifications, type the
absolute paths of target registries you want to monitor and separate the paths
with a semicolon (;). Start a path with HKEY_USERS, HKEY_LOCAL_MACHINE,
or HKEY_CLASSES_ROOT. For example, you can type HKEY_LOCAL_MACHINE\
SOFTWARE\Microsoft\Windows;HKEY_CLASSES_ROOT\GuestStateVDev
. If you leave this list unspecified, no registry modification is captured.

b) Select and edit the rule criteria.

Similar to creating a custom recording policy, you can choose one or more rule criteria:
Users or Groups, Published Applications or Desktop, Delivery Groups or Machines,
and IP Address or IP Range. For more information, see the instructions in the Create a
custom recording policy section.

Note:

Somesessionsmightnotmeet any rule criteria in aneventdetectionpolicy. For these
sessions, the action of the fallback rule applies, which is always Do not detect. You
cannot modify or delete the fallback rule.
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c) Follow the wizard to complete the configuration.

After a session that matches an event detection policy starts, the session ID and its event registry val‑
ues appear in the Session Recording Agent. For example:
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Compatibility with registry configurations

When Session Recording is newly installed or upgraded, no active event detection policy is avail‑
able by default. At this time, each Session Recording Agent respects the registry values under
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SessionEvents to determine whether to log
specific events. For a description of the registry values, see the following table:

Registry Value Description

EnableSessionEvents 1: enables event detection globally; 0: disables
event detection globally (default value data).

EnableCDMUSBDriveEvents 1: enables detecting the insertion of CDM
mapped USBmass storage devices; 0: disables
detecting the insertion of CDMmapped USB
mass storage devices (default value data).

EnableGenericUSBDriveEvents 1: enables detecting the insertion of generic
redirected USBmass storage devices; 0: disables
detecting the insertion of generic redirected USB
mass storage devices (default value data).
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Registry Value Description

EnableAppLaunchEvents 1: enables detecting only application starts; 2:
enables detecting both application starts and
ends; 0: disables detecting application starts
and ends (default value data).

AppMonitorList Specifies target applications to monitor. No
application is specified by default, which means
no application is captured by default.

EnableFileOperationMonitorEvents 1: enables detecting file operations; 0: disables
detecting file operations (default value data).

FileOperationMonitorList Specifies target folders to monitor. No folder is
specified by default, which means no file
operation is captured by default.

EnableWebBrowsingActivities 1: enables detecting web browsing activities; 0:
disables detecting web browsing activities
(default value data).

Here are some compatible scenarios:

• Your SessionRecording is newly installed or upgraded froma release earlier than 1811 that does
not support event detection (logging), the related registry values on each Session Recording
Agent are the default. Because there is no active event detection policy by default, no events
are logged.

• If your Session Recording is upgraded from a release earlier than 1811 that supports event de‑
tection but has the feature disabled before your upgrade, the related registry values on each
Session Recording Agent remain the default. Because there is no active event detection policy
by default, no events are logged.

• If your Session Recording is upgraded from a release earlier than 1811 that supports event de‑
tection and has the feature partially or fully enabled before your upgrade, the related registry
values on each Session Recording Agent remain the same. Because there is no active event de‑
tection policy by default, the event detection behavior remains the same.

• If your Session Recording is upgraded from 1811, the event detection (logging) policies config‑
ured in the Policy Console remain in use.

Caution:

When you activate the system‑defined or a custom event detection policy in the Session Record‑
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ing Policy Console, the relevant registry settings on each Session Recording Agent are ignored
and you cannot use registry settings for event detection any longer.

Recording viewing policies

The Session Recording Player supports role‑based access control. You can create recording viewing
policies in theSessionRecordingPolicyConsole andaddmultiple rules to eachpolicy. Each ruledeter‑
mines which user or user group can view the recordings originating fromother users and user groups,
published applications and desktops, and delivery groups and VDAs you specify.

Create a custom recording viewing policy

Before you can create recording viewing policies, enable the feature as follows:

1. Log on to the machine hosting the Session Recording Server.

2. From the Startmenu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the RBAC tab.

4. Select the Allow to configure recording viewing policies check box.
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To create a custom recording viewing policy:

Note: Different from recording policies and event detection policies, a recording viewing policy (in‑
cluding all rules added within) is active immediately when it is created. You do not have to activate
it.

1. Log on as an authorized Policy Administrator to the server where the Session Recording Policy
Console is installed.

2. Start the Session Recording Policy Console. By default, there is no recording viewing policy.
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Note: The Recording Viewing Policiesmenu is not available unless you have enabled the fea‑
ture in Session Recording Server Properties.

3. SelectRecordingViewingPolicies in the leftpane. Fromthemenubar, chooseAddNewPolicy
to create a recording viewing policy.

4. (Optional) Right‑click the new policy and rename it.

5. Right‑click the new policy and select Add rule.
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6. Click Add.

7. In the Select Users or Groups dialog, select a user or user group as the recording viewer.
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Note:

In each rule, you can select only one user or user group as the recording viewer. If you
select multiple users or user groups, only your most recent selection takes effect and ap‑
pears in the text box.
When you specify a recording viewer, ensure that you have assigned the viewer to the
Player role. A user without the permission to play recorded sessions receives an errormes‑
sage when trying to play a recorded session. For more information, see Authorize users.

8. ClickOK and thenNext. The dialog for setting rule criteria appears.

9. Select and edit the rule criteria to specify whose recordings are visible to the viewer you speci‑
fied earlier:

• Users or Groups
• Published Applications or Desktop
• Delivery Groups or Machines
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Note: If you leave the rule criteria unspecified, the viewer specified earlier has no recordings to
view.

10. Follow the wizard to complete the configuration.

For example:
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Event response policies

This policy setting allows you to send email alerts, or start screen recording immediately, or take both
actions in response to logged events in recorded sessions. If your active recording policy records
only specific events without capturing any screens, you can configure an event trigger to start screen
recording immediately when a specific event occurs. This is called event‑triggered dynamic screen
recording.

The only system‑defined event response policy is Do not respond. You can create custom event re‑
sponse policies as needed. Only one event response policy can be active at a time.

For an example email alert, see the following screen capture:
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Tip:

Clicking the playback URL opens the playback page of the recorded session in the web player.
Clicking here opens the All recordings page in the web player.

System‑defined event response policy

Session Recording provides one system‑defined event response policy:

• Do not respond. The default event response policy. If you do not specify another event re‑
sponse policy, neither email alerts nor dynamic screen recording is provided in response to
logged events in your recordings.

Create a custom event response policy

1. Log on as an authorized policy administrator to the server where the Session Recording Policy
Console is installed.
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2. Start the Session Recording Policy Console. By default, there is no active event response policy.

3. Select Event Response Policies in the left pane. From themenu bar, choose Add New Policy.

4. (Optional) Right‑click the new event response policy and rename it.

5. Right‑click the new event response policy and select Add Rule.

6. Select Email alert when a session start is detected or Use event triggers to specify how to
respondwhen a session event is detected.
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7. (Optional) Set email recipients and the email sender properties.

a) Type email addresses for the alert recipients in the Rules wizard.
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b) Configure outgoing email settings in the Session Recording Server Properties.
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Note:

If you select more than two options in the Email title section, a warning dialog ap‑
pears, saying that theemail subjectmightbe too long. After youselectAllowsending
email notifications and clickApply, Session Recording sends an email to verify your
email settings. If any setting is incorrect, for example, an incorrect password or port,
Session Recording returns an error message with the error details.
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Your email settings need about five minutes to take effect. To have your email set‑
tings take effect immediately or fix the issue that emails are not sent according to
the settings, restart the Storage Manager (CitrixSsRecStorageManager) service. Also,
restart theStorageManager service if youupgrade to the current release fromVersion
2006 and earlier.

c) Edit registry for accessing the web player.

To make the playback URLs in your alert emails work as expected, browse to the registry
key at HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server and
do the following:

• Set the value data of LinkHost to the URL of the domain you use to access the
web player. For example, to access a web player at https://example.com/
webplayer/#/player/, set the value data of LinkHost to https://example.
com.

• Add a new value, EmailThreshold, and set its value data to a number in the range of
1 through 100. The value data determines the maximum number of alert emails that
an email sending account sends within a second. This setting helps slow down the
number of emails that are being sent and thus reduces the CPU usage. If you leave
the value data unspecified or set it to a number out of range, the value data falls back
to 25.

Note:

• Your email server might treat an email sending account as a spam bot and thus
prevent it from sending emails. To allow an account to send emails, an email
client such as Outlook might request that you verify that the account is used by
a human user.

• There is a limit for sending emails within a given period. For example, when the
daily limit is reached, youcannot sendemailsuntil the startof thenextday. In this
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case, ensure that the limit is more than the number of sessions being recorded
within the period.

8. (Optional) Configure event triggers.

After you select Use event triggers to specify how to respond when a session event is de‑
tected, the Configure Event Triggers button becomes available. Click it to specify logged
events that can trigger email alerts, dynamic screen recording, or both.

Note:

Youmust select the event types that the active event detection policy logs. Click Confirm
when you are finished.

Select event types from the drop‑down list and set event rules through the two dimensions
that are combined using the logical AND operator. You can set up to seven event rules. You
can also define your event triggers in the Description column or leave the column empty. Your
defined description of an event trigger is provided in the alert emails if you have Send email se‑
lected and events of the type are logged. If you have Start screen recording selected, dynamic
screen recording automatically startswhen certain events occur during anevent‑only recording.
Set the time span for dynamic screen recording. If you leave the time span unspecified, screen
recording continues until the recorded session ends.
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For a complete list of supported event types, see the following table.

Event type Dimension Option

App Start

App name

Full command line

App End

App name

Top Most

App name

Windows title

Web Browsing

URL
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Event type Dimension Option

Tab title

Browser name

File Create

Path

File size(MB)

File Rename

Path

Name

File Move

Source path

Destination path

File size(MB)

File Delete

Path

File size(MB)

CDM USB

Drive letter

Generic USB

Device name

Idle

idle duration(Hrs)

9. ClickNext to select and edit the rule criteria.

Similar to when creating a custom recording policy, you can choose one or more rule criteria:
Users or Groups, Published Applications or Desktop, Delivery Groups or Machines, and IP
Address or IP Range. Formore information, see the instructions in the Create a custom record‑
ing policy section.
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Note:

When a session or an eventmeetsmore than one rule in a single event response policy, the
oldest rule takes effect.

10. Follow the wizard to complete the configuration.

11. Activate the new event response policy.

Activate a policy

1. Log on as an administrator to the machine where you installed the Session Recording Policy
Console.

2. Start the Session Recording Policy Console.
3. If the Connect to Session Recording Serverwindow appears, ensure that the name of the Ses‑

sion Recording Server, protocol, and port are correct. ClickOK.
4. In the Session Recording Policy Console, expandRecordingPoliciesorEvent LoggingPolicies

as required.

© 1997–2025 Citrix Systems, Inc. All rights reserved. 101



Session Recording 2110

5. Select the policy to activate.
6. From themenu bar, choose Activate Policy.

Modify a policy

1. Log on as an administrator to the machine where you installed the Session Recording Policy
Console.

2. Start the Session Recording Policy Console.
3. If the Connect to Session Recording Serverwindow appears, ensure that the name of the Ses‑

sion Recording Server, protocol, and port are correct. ClickOK.
4. In the Session Recording Policy Console, expandRecordingPoliciesorEvent LoggingPolicies

as required.
5. Select the policy you want to modify. The rules for the policy appear in the right pane.
6. To add, modify, or delete a rule:

• From the menu bar, choose Add New Rule. If the policy is active, a pop‑up window ap‑
pears requesting confirmation of the action. Use the Ruleswizard to create a rule.

• Select the rule you want tomodify, right‑click, and choose Properties. Use the Ruleswiz‑
ard to modify the rule.

• Select the rule you want to delete, right‑click, and choose Delete Rule.

Delete a policy

Note:

You cannot delete a system‑defined policy or a policy that is active.

1. Log on as an administrator to the machine where you installed the Session Recording Policy
Console.

2. Start the Session Recording Policy Console.
3. If the Connect to Session Recording Serverwindow appears, ensure that the name of the Ses‑

sion Recording Server, protocol, and port are correct. ClickOK.
4. In the Session Recording Policy Console, expandRecordingPoliciesorEvent LoggingPolicies

as required.
5. In the left pane, select the policy to delete. If the policy is active, you must activate another

policy.
6. From themenu bar, choose Delete Policy.
7. Select Yes to confirm the action.
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Understand rollover behavior

When you activate a policy, the previously active policy remains in effect until the session being
recorded ends or the session recording file rolls over. Files roll over when they have reached the
maximum size. Formore information about themaximum file size for recordings, see Specify file size
for recordings.

The following table details what happens when you apply a new recording policy while a session is
being recorded and a rollover occurs:

If the previous recording policy
was And the new recording policy is

After a rollover, the recording
policy will be

Do not record Any other policy No change. The new policy
takes effect only when the user
logs on to a new session.

Record without notification Do not record Recording stops.

Record without notification Record with notification Recording continues and a
notification message appears.

Record with notification Do not record Recording stops.

Record with notification Record without notification Recording continues. No
message appears the next time
a user logs on.

Specify where recordings are stored

April 3, 2023

UseSessionRecordingServerProperties to specifywhere recordings are storedandwherearchived
recordings are restored for playback.

You can store recordings on a local drive, a SAN volume, and a location specified by a UNC network
path. Starting from Version 2103, you can store recordings in Azure file shares. For more information,
see Configure an Azure file share to store recordings later in this article.

Note:

• Storing data on a NAS, based on file‑based protocols such as SMB and NFS, might have
performance and security implications. Use the latest version of the protocol in place to
avoid security implications and perform scale testing to ensure proper performance.
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• To archive files or restore deleted files, use the ICLDB command.

Specify one ormore folders for storing recordings and a folder for restoring archived
recordings

1. Log on to the machine hosting the Session Recording Server.

2. From the Startmenu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the Storage tab.

4. Use the File storage directories list to manage the folders where recordings are stored.

After you select the folders, Session Recording grants its service with Full Control permission to
these folders.

By default, recordings are stored in the <drive>:\SessionRecordings folder of the machine
hosting the Session Recording Server. You can change the folder where you store recordings,
add extra folders to load‑balance acrossmultiple volumes, ormake use ofmore space. Multiple
folders in the list indicate that recordings are load‑balanced across the folders. Load balancing
cycles through the folders.

5. In the Restore directory for archived files field, type your folder for restoring archived record‑
ings.

By default, archived recordings are restored in the <drive>:\SessionRecordingsRestore folder
of the machine hosting the Session Recording Server. You can change the folder.
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Configure an Azure file share to store recordings

To create an Azure file share to store recordings, complete the following steps:

1. In the Azure portal, create a storage account and then create an Azure file share.

For a quick start guide, see Create and manage Azure file shares with the Azure portal. The
following table recommends configurations for your consideration.

Recording File
Size MB/hour

Session
Quantity

File Share
Type

File Share
Quota (TB)

Session
Recording
Server
Quantity

Session
Recording
Server Size

< 6.37 < 1,000 HDD Standard
(StorageV2)

2 1 Standard
D4as_v4

< 6.37 1,000–2,000 SSD Premium 3 1 Standard
D4as_v4

< 6.37 2,000–3,000 SSD Premium 5 1 Standard
D4as_v4

< 6.37 3,000–4,000 SSD Premium 6 1 Standard
D4as_v4

Approx.10 < 1,000 HDD Standard
(StorageV2)

3 1 Standard
D4as_v4

Approx.10 1,000–2,500 SSD Premium 6 1 Standard
D4as_v4

Approx.10 2,500–4,000 SSD Premium 10 2 Standard
D4as_v4

The file share quota is calculated based on eight hours per day, 23working days permonth, and
a one‑month retention period for each recording file.

2. Add the Azure file share credentials to the host where you installed the Session Recording
Server.

a) Start a command prompt as an administrator and change the drive to the <Session
Recording Server installation path>\Bin folder.

By default, the Session Recording Server is installed in C:\Program Files\Citrix\
SessionRecording\Server.

b) Run the SsRecUtils.exe ‑AddAzureFiles <storageAccountName> <fileShareName>
<accesskey> command.

Where,
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• <storageaccountname> is the name of your storage account in Azure.
• <filessharename> is the name of the file share contained within your storage
account.

• <accesskey> is your storage account key that can be used to access the file share.

There are two ways to obtain your storage account key:

• You can obtain your storage account key from the connection string that appears
when you click the Connect icon in your file share page.

• You can also obtain your storage account key by clicking Access keys in the left navi‑
gation of your storage account page.
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c) Mount the Azure file share to the host where you installed the Session Recording Server.

i. Open Session Recording Server Properties.

ii. Click Add on the Storage tab.

iii. Enter theUNCpath in the formatof \\<storageaccountname>.file.core.windows.net\<filessharename>\<subfolder>.

Specify a subfolder under the file share to store your recording files. The Session
Recording Server then automatically creates the subfolder for you.
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iv. ClickOK in the File Storage Directory dialog box.

v. Click Apply in the Session Recording Server Propertieswindow.

vi. ClickOK after Apply becomes grayed out.

vii. Click Yes when you are prompted to restart the Session Recording Storage Manager
service.

Specify file size for recordings

September 7, 2025
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As recordings grow in size, recording files can take longer to download and respondmore slowlywhen
you use the seek slider to navigate during playback. To control file size, specify a threshold limit for a
file. When the recording reaches this limit, Session Recording closes the file and creates an extra file
to continue recording. This action is called a rollover.

You can specify two thresholds for a rollover:

• File size. When the file reaches the specified number of MB, Session Recording closes the file
andopens a newone. By default, files roll over after reaching 50MB. You can specify a limit from
10 MB to 300 MB.

• Duration. After the session records for the specified number of hours, the file is closed and a
new file is opened. By default, files roll over after recording for 12 hours. You can specify a limit
from one to 24 hours.

Session Recording checks both fields to determine which event occurs first to determine when to roll
over. For example, if you specify 17MB for the file size and six hours for the duration and the recording
reaches 17MB in three hours, Session Recording reacts to the 17MB file size to close the file and open
a new one.

Toprevent the creationofmany small files, SessionRecordingdoes not roll over until at least onehour
elapses (this value is theminimumnumber that you can type) regardless of the value specified for the
file size. The exception to this rule is if the file size surpasses 300 MB.

Specify themaximum file size for recordings

1. Log on to the machine hosting the Session Recording Server.

2. From the Startmenu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the Rollover tab.
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4. Type an integer between 10 and 300 to specify the maximum file size in MB.

5. Type an integer between 1 and 24 to specify the maximum recording duration in hours.
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Customize notificationmessages

September 7, 2025

If the active recording policy specifies that users are notified when their sessions are recorded, a no‑
tification message appears after the users type their credentials. The default notification message
is Your activity with the desktop or program(s) you recently started is being recorded. If you
object to this condition, close the desktop or program(s). The users can click OK to dismiss the
window and continue their sessions.

The default notification message appears in the language of the operating system on the VDA.

You can create custom notifications in the languages you choose. However, you can have only one
notificationmessage for each language. Your users seenotificationmessages in the languages of their
preferred local settings.

Create a notificationmessage

1. Log on to the machine hosting the Session Recording Server.
2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Notifications tab.
4. Click Add.
5. Choose the language for themessage and type the newmessage. You can create only onemes‑

sage for each language.

After accepting and activating, the newmessage appears in the
language‑specific notification message box.

Enable or disable recording

September 7, 2025

You install the Session Recording Agent on multi‑session OS VDAs for which you want to record ses‑
sions. Within each Agent is a setting that enables recording for the VDA on which it is installed. After
recording is enabled, Session Recording evaluates the active recording policy that determines which
sessions are recorded.

When you install the Session Recording Agent, recording is enabled. We recommend that you disable
Session Recording on VDAs that are not recorded because they experience a small impact on perfor‑
mance, even if no recording takes place.
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Enable or disable recording on a VDA

1. Log on to the server where the Session Recording Agent is installed.
2. From the Startmenu, choose Session Recording Agent Properties.
3. Under Session Recording, select or clear the Enable session recording for this VDAmachine

check box to specify whether sessions can be recorded for this VDA.
4. When prompted, restart the Session Recording Agent Service to accept the change.

Note:

When you install Session Recording, the active policy is
Do not record (no sessions are recorded on any server). To begin recording, use the
Session Recording Policy Console to activate a different policy.

Enable custom event recording

Session Recording allows you to use third‑party applications to insert custom data, known as events,
to recorded sessions. These events appear when the session is viewed using the Session Record‑
ing Player. They are part of the recorded session file and cannot be modified after the session is
recorded.

For example, an event might contain the following text: “User opened a browser.”Each time a user
opens a browser during a session that is being recorded, the text is inserted to the recording at that
point. When the session is playedusing the SessionRecordingPlayer, the viewer can locate and count
the times that the user opened a browser by noting the number of markers that appear in the Events
and Bookmarks list in the Session Recording Player.

To insert custom events to recordings on a server:

• Use Session Recording Agent Properties to enable a setting on each server where you want
to insert custom events. Enable each server separately. You cannot globally enable all servers
in a site.

• Write applications built on the Event API that runs within each user’s Citrix Virtual Apps and
Desktops™ session (to inject the data into the recording).

The Session Recording installation includes an event recording COM application (API) that allows you
to insert text from third‑party applications to a recording. You can use the API from many program‑
ming languages including Visual Basic, C++, or C#. For more information, see the Knowledge Center
article CTX226844. The SessionRecording Event API .dll is installed as part of the SessionRecording in‑
stallation. Youcan find it atC:\ProgramFiles\Citrix\SessionRecording\Agent\Bin\Interop.UserApi.dll.

To enable custom event recording on a server, do the following:

1. Log on to the server where the Session Recording Agent is installed.
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2. From the Startmenu, choose Session Recording Agent Properties.
3. In Session Recording Agent Properties, click the Recording tab.
4. Under Custom event recording, select the Allow third party applications to record custom

data on this server check box.

Enable or disable digital signing

September 7, 2025

If you install certificates on machines where you installed the Session Recording Server and the Ses‑
sion Recording Player, you can enhance the security of your deployment by assigning digital signa‑
tures to Session Recording.

By default, digital signing is disabled. After you select the certificate to sign the recordings, Session
Recording grants the read permission to the Session Recording Storage Manager Service.

Enable digital signing

1. Log on to the machine hosting the Session Recording Server.
2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Signing tab.
4. Browse to the certificate that enables secure communication among the machines where you

installed the Session Recording components.

Disable digital signing

1. Log on to the machine hosting the Session Recording Server.
2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Signing tab.
4. Click Clear.

Administrator Logging

September 7, 2025

Session Recording Administrator Logging logs the following activities:
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• Changes to recording policies and event logging policies on the Session Recording Policy Con‑
sole or Citrix Director.

• Changes in Session Recording Server Properties.

• Downloads of recordings in the Session Recording Player.

• Recording a session by Session Recording after policy query.

• Unauthorized attempts to access the Administrator Logging service.

Warning:

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

Disable or enable Administrator Logging

After installation, you can disable or enable the Session Recording Administrator Logging feature in
Session Recording Server Properties.

1. As an administrator, log on to the machine where Session Recording Administrator Logging is
installed.

2. From the Startmenu, choose Session Recording Server Properties.
3. Click the Logging tab.

When Session Recording Administrator Logging is disabled, no new activities are logged. You can
query the existing logs from the web‑based UI.

Whenmandatory blocking is enabled, the following activities are blocked if the logging fails. A sys‑
tem event is also logged with an Event ID 6001:

• Changes to recording policies on the Session Recording Policy Console or Citrix Director.
• Changes in Session Recording Server Properties.

The mandatory blocking setting does not impact the recording of sessions.

Configure an Administrator Logging service account

Bydefault, Administrator Logging is runningasawebapplication in Internet InformationServices (IIS),
and its identity is Network Service. To enhance the security level, you can change the identity of this
web application to a service account or a specific domain account.

1. As an administrator, log on to the machine hosting the Session Recording Server.
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2. In IIS Manager, click Application Pools.
3. In Application Pools, right‑click SessionRecordingLoggingAppPool and choose Advanced

Settings.
4. Change the attribute identity to the specific account that you want to use.
5. Grant the db_owner permission to the account for the database CitrixSessionRecordingLog‑

ging on the Microsoft SQL Server.
6. Grant the readpermission to theaccount for the registrykeyatHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.

Disable or enable the recording action logging

By default, Administrator Logging logs every recording action after the policy query completes. This
case might generate a large amount of loggings. To improve the performance and save the storage,
disable this kind of logging in Registry.

1. As an administrator, log on to the machine hosting the Session Recording Server.

2. Open the Registry Editor.

3. Browse toHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.

4. Set the value of EnableRecordingActionLogging to:

0: disable the recording action logging
1: enable the recording action logging

Query the Administrator Logging data

Session Recording provides a web‑based UI to query all Administrator Logging data.

On the computer hosting the Session Recording Server:

1. From the Startmenu, choose Session Recording Administrator Logging.

2. Type the credentials of a LoggingReader user.

The Administrator Logging webpage integrated with the web player appears.
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On other machines:

1. Open a web browser and visit the webpage for Administrator Logging.

• For HTTPS: https://servername/WebPlayer/#/logging/config and
https://servername/WebPlayer/#/logging/record, where servername
is the name of the machine hosting the Session Recording Server.

• For HTTP: http://servername/WebPlayer/#/logging/config and http
://servername/WebPlayer/#/logging/record, where servername is the
name of the machine hosting the Session Recording Server.

2. Type the credentials of a LoggingReader user.

Database high availability

September 7, 2025

Session Recording supports the following solutions for database high availability based on the Mi‑
crosoftSQLServer. Databases canautomatically fail overwhen thehardwareor softwareof aprincipal
or primary SQL Server fails, which ensures that Session Recording continues to work as expected.

• Always On availability groups

The Always On availability groups feature is a high availability and disaster‑recovery solution
that provides an enterprise‑level alternative to database mirroring. Introduced in SQL Server
2012, the Always On availability groups solutionmaximizes the availability of a set of user data‑
bases for an enterprise. It requires that the SQL Server instances reside on the Windows Server
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Failover Clustering (WSFC) nodes. For more information, see Always On availability groups: a
high‑availability and disaster‑recovery solution.

• SQL Server clustering

The Microsoft SQL clustering technology allows one server to automatically take over the tasks
and responsibilities of the server that has failed. However, setting up this solution is compli‑
cated and the automatic failover is typically slower than alternatives such as SQL Server data‑
base mirroring. For more information, see Always On Failover Cluster Instances (SQL Server).

• SQL Server database mirroring

Database mirroring ensures that an automatic failover occurs in seconds if the active database
server fails. This solution ismoreexpensive than theother twosolutionsbecause full SQLServer
licenses are required on each database server. You cannot use the SQL Server Express edition
in a mirrored environment. For more information, see Database Mirroring (SQL Server).

Methods for configuring Session Recording with database high availability

To configure Session Recording with database high availability, do either of the following:

• Install the Session Recording Server components first and then configure database high avail‑
ability for the created databases.
You can install the Session Recording Administration componentswith databases configured to
be installed on the prepared SQL Server instance. Then, configure database high availability for
the created databases.

• For Always On availability groups and clustering, you must manually change the SQL
Server instance name to the name of the availability group listener or SQL Server network
inHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\SmAudDatabaseInstance.

• For database mirroring, you must manually add the failover partners for databases in
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\DatabaseFailoverPartner
andHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\LoggingDatabaseFailoverPartner.

• Configure database high availability for empty databases first and then install the Session
Recording Administration components.
You can create two empty databases as the Session Recording Database and the Administrator
Logging Database in the expected primary SQL Server instance and configure high availability.
Then enter the SQL Server instance name when installing the Session Recording Server
components:

• Touse theAlwaysOnavailability groups solution, enter thenameof your availability group
listener.

• To use the database mirroring solution, enter the name of your principal SQL Server.

© 1997–2025 Citrix Systems, Inc. All rights reserved. 118

https://docs.microsoft.com/en-us/sql/database-engine/availability-groups/windows/always-on-availability-groups-sql-server?redirectedfrom=MSDN&view=sql-server-ver15
https://docs.microsoft.com/en-us/sql/database-engine/availability-groups/windows/always-on-availability-groups-sql-server?redirectedfrom=MSDN&view=sql-server-ver15
https://docs.microsoft.com/en-us/sql/sql-server/failover-clusters/windows/always-on-failover-cluster-instances-sql-server?redirectedfrom=MSDN&view=sql-server-ver15
https://docs.microsoft.com/en-us/sql/database-engine/database-mirroring/database-mirroring-sql-server?redirectedfrom=MSDN&view=sql-server-ver15


Session Recording 2110

• To use the clustering solution, enter the network name of your SQL Server.

Load balancing

September 7, 2025

Session Recording supports load balancing across Session Recording Servers. This article summa‑
rizes the load balancing configuration using the Citrix ADC as an example. For more information, see
Configure load balancing in an existing deployment and Deploy and load‑balance Session Recording
in Azure.

You can synchronize load balancing configurations among all Session Recording Servers.

Note:

The load balancing feature requires Version 7.16 or later of the Session Recording Server and
Session Recording Agent.

Changes to Session Recording in support of load balancing:

• All Session Recording Servers share one folder to store recording files.
• All Session Recording Servers share one Session Recording Database.
• (Recommended) Install only one Session Recording Policy Console and all Session Recording
Servers share this Console.

Configure load balancing

To use this feature, perform the following steps on Citrix ADC and on the various Session Recording
components:

Configure load balancing (Citrix ADC part)

Configure loadbalancing servers Add the SessionRecording Servers to the loadbalancing servers
in Citrix ADC.

Configure load balancing services

1. Add a load balancing service for each needed protocol on each Session Recording Server.
2. (Recommended) Select the relevant protocol monitor to bind each service monitor.
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Configure load balancing virtual servers

1. Create virtual servers with the same Citrix ADC VIP address based on the needed protocols and
bind the virtual servers to the relevant load balancing services.

2. Configure persistence on each virtual server.
3. (Recommended) Choose LEASTBANDWITH or LEASTPACKETS as the load balancing method

rather than the default method (LEASTCONNECTION).
4. Create a certificate to make the HTTPS virtual server UP.

Configure load balancing (Session Recording part)

On each server where you installed the Session Recording Server, do the following

1. (Recommended) Type the same Session Recording Database name during the Session Record‑
ing Server installation.

2. If you choose the Administrator Logging feature, Citrix recommends that you type the same
Administrator Logging Database name when you install each Session Recording Server.

3. After sharing the Read/Write permission of the file storage folder with all Session Recording
Server machine accounts, change to use the file storage folder as the shared folder in Session
Recording Server Properties. For more information, see Specify where recordings are restored.

4. Addavalue to theSessionRecordingServer registrykeyatHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.
Value name: EnableLB
Value data: 1 (DWORD, meaning enable)

5. If you choose the HTTP or the HTTPS protocol for the Session Recording Storage Manager
message queue, create a host record for the Citrix ADC VIP address, add redirections in
C:\Windows\System32\msmq\Mapping\sample_map, and restart the Message Queuing
service.

The redirection is similar to:

1 <redirections xmlns="msmq-queue-redirections.xml">
2 <redirection>
3 <from>http://<ADCHost>*/msmq/private$/

CitrixSmAudData</from>
4 <to>http://<LocalFqdn>/msmq/private$/

CitrixSmAudData</to>
5 </redirection>
6 <redirection>
7 <from>https://<ADCHost>*/msmq/private$/

CitrixSmAudData</from>
8 <to>https://<LocalFqdn>/msmq/private$/

CitrixSmAudData</to>
9 </redirection>

10 </redirections>
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Where <ADCHost> is the created FQDN of the Citrix ADC VIP address, and <LocalFqdn> is the
FQDN of the local host.

6. (Recommended) After configuring one Session Recording Server registry, you can use the <Ses‑
sion Recording Server installation path>\Scripts\SrServerConfigurationSync.ps1 script to
export configurations from this Server registry and import the registry to the other Session
Recording Server registries. You can also use the SrServerConfigurationSync.ps1 script to
add redirection mapping for message queuing.

a) On one Session Recording Server, after configuring the EnableLB registry value, start a
command prompt as an administrator and run the powershell.exe ‑file SrServerCon‑
figurationSync.ps1 –Action Export,AddRedirection –ADCHost <ADCHost> command,
where <ADCHost> is the created FQDN of the Citrix ADC VIP address.

b) After the script runs, an exported registry file namedSrServerConfig.reg is generated and
an sr_lb_map.xml file is added to the C:\Windows\System32\msmq\Mapping path.

c) On other Session Recording Servers, copy SrServerConfig.reg generated in the preced‑
ing step, start a command prompt as an administrator, and run the powershell.exe ‑
file SrServerConfigurationSync.ps1 –Action Import,AddRedirection –ADCHost <AD‑
CHost> command, where <ADCHost> is the created FQDN of the Citrix ADC VIP address.

d) After the script runs, the EnableLB value is added to the other Session Recording Server
registrykeysandansr_lb_map.xml file is added to theC:\Windows\System32\msmq\Mapping
path.

On the machine where you installed the Session Recording Agent, do the following in Session
Recording Agent Properties

• If you choose the HTTP or the HTTPS protocol for the Session Recording Storage Manager mes‑
sage queue, type the FQDN of the Citrix ADC VIP address in the Session Recording Server text
box.

• If you choose the default TCP protocol for the Session Recording Storage Manager message
queue, type the Citrix ADC VIP address in the Session Recording Server text box.

On the machine where you installed the Session Recording Player, do the following Add the
Citrix ADC VIP address or its FQDN as the connected Session Recording Server.

On the SQL Server where you installed the Session Recording Database, do the following Add
all the Session Recording Server machine accounts to the shared Session Recording Database and
assign themwith the db_owner permission.
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Change your communication protocol

September 7, 2025

For security reasons, Citrix® does not recommend using HTTP as a communication protocol. The
Session Recording installation is configured to use HTTPS. To use HTTP instead of HTTPS, you must
change several settings.

Use HTTP as the communication protocol

1. Log on to themachine hosting the Session Recording Server and disable secure connections for
Session Recording Broker in IIS.

2. Change the protocol setting from HTTPS to HTTP in Session Recording Agent Properties on
each server where the Session Recording Agent is installed:

a) Log on to each server where the Session Recording Agent is installed.
b) From the Startmenu, choose Session Recording Agent Properties.
c) In Session Recording Agent Properties, choose the Connections tab.
d) In the Session Recording Broker area, selectHTTP from theProtocol drop‑down list and

clickOK to accept the change. If you are prompted to restart the service, click Yes.

3. Change the protocol setting from HTTPS to HTTP in the Session Recording Player settings:

a) Log on to each workstation where the Session Recording Player is installed.
b) From the Startmenu, choose Session Recording Player.
c) From the Session Recording Player menu bar, choose Tools > Options > Connections,

select the server, and chooseModify.
d) Select HTTP from the Protocol drop‑down list and click OK twice to accept the change

and exit the dialog box.

4. Change the protocol setting from HTTPS to HTTP in the Session Recording Policy Console:

a) Log on to the server where the Session Recording Policy Console is installed.
b) From the Startmenu, choose Session Recording Policy Console.
c) SelectHTTP from theProtocoldrop‑down list andclickOK to connect. If the connection is

successful, this setting is remembered thenext time you start the SessionRecordingPolicy
Console.

Revert to HTTPS as the communication protocol

1. Log on to themachine hosting the Session Recording Server and enable secure connections for
the Session Recording Broker in IIS.

© 1997–2025 Citrix Systems, Inc. All rights reserved. 122



Session Recording 2110

2. Change the protocol setting from HTTP to HTTPS in Session Recording Agent Properties on
each server where the Session Recording Agent is installed:

a) Log on to each server where the Session Recording Agent is installed.
b) From the Startmenu, choose Session Recording Agent Properties.
c) In Session Recording Agent Properties, choose the Connections tab.
d) In the Session Recording Broker area, select HTTPS from the Protocol drop‑down list

and clickOK to accept the change. If you are prompted to restart the service, click Yes.

3. Change the protocol setting from HTTP to HTTPS in the Session Recording Player settings:

a) Log on to each workstation where the Session Recording Player is installed.
b) From the Startmenu, choose Session Recording Player.
c) From the Session Recording Player menu bar, choose Tools > Options > Connections,

select the server, and chooseModify.
d) Select HTTPS from the Protocol drop‑down list and click OK twice to accept the change

and exit the dialog box.

4. Change the protocol setting from HTTP to HTTPS in the Session Recording Policy Console:

a) Log on to the server where the Session Recording Policy Console is installed.
b) From the Startmenu, choose Session Recording Policy Console.
c) SelectHTTPS from theProtocoldrop‑down list and clickOK to connect. If the connection

is successful, this setting is remembered the next time you start the Session Recording
Policy Console.

Configure Citrix Customer Experience Improvement Program (CEIP)

March 21, 2024

When you participate in the Citrix Customer Experience Improvement Program (CEIP), anonymous
configuration and usage data is collected and sent to Citrix to help improve the product quality and
performance. In addition, a copy of the anonymous data is sent to Google Analytics (GA) for fast and
efficient analysis.

Settings

CEIP setting

By default, you automatically participate in CEIPwhen you install Session Recording. The first upload
of data occurs approximately seven days after you install Session Recording. To unsubscribe from
CEIP, do the following:
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1. Log on to the machine hosting the Session Recording Server.

2. From the Startmenu, choose Session Recording Server Properties.

3. In Session Recording Server Properties, click the CEIP tab.

4. Clear the Participate in the Customer Experience Improvement Program check box.

5. Restart the Citrix Session Recording Analytics Service to make the setting take effect.

GA setting

When GA is enabled, the heartbeat data between GA and the Session Recording Server is collected
every 5 hours.

Registry setting that enables or disables GA (default = 0):

Location: HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\

Name: CeipHeartBeatDisable

Value: 1 = disabled, 0 = enabled
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When unspecified, GA is enabled.

To disable GA:

1. Log on to the machine hosting the Session Recording Server.

2. Open the Registry Editor.

3. Browse toHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server\.

4. Add a registry value and name it CeipHeartBeatDisable.

5. Set the value data of CeipHeartBeatDisable to 1.

6. Restart the Citrix Session Recording Analytics Service to make the setting take effect.

Data collected from the Session Recording Server

The following table gives an example of the types of anonymous information collected. The data does
not contain any details that identify you as a customer.

Data Point Key Name Description

Machine GUID machine_guid Identifying the machine where
the data originates. When GA is
enabled, the heartbeat data is
sent to GA regardless of
whether CEIP is enabled.

Operating System version OS_version Text string denoting the
machine’s operating system.
When GA is enabled, the
heartbeat data is sent to GA
regardless of whether CEIP is
enabled.

Session Recording Server
version

SRS_version Text string denoting the
installed version of the Session
Recording Server. When GA is
enabled, the heartbeat data is
sent to GA regardless of
whether CEIP is enabled.

Number of application
recordings

application‑recording‑number Integer denoting the number of
application recording files. The
data is sent when both GA and
CEIP are enabled.
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Data Point Key Name Description

Number of recordings recording‑number Integer denoting the number of
both application and desktop
recording files. The data is sent
when both GA and CEIP are
enabled.

Number of dynamic recordings dynamic‑recording‑number Integer denoting the number of
dynamically recorded files. The
data is sent when both GA and
CEIP are enabled.

Number of agents hosting
recorded sessions

recorded‑agent‑number Integer denoting the number of
VDAs hosting recorded sessions.
The data is sent when both GA
and CEIP are enabled.

Number of agents hosting
recorded sessions containing
logged events

event‑logging‑enabled‑agent‑
number

Integer denoting the number of
VDAs hosting recorded sessions
that contain logged events. The
data is sent when both GA and
CEIP are enabled.

Number of recordings
containing logged events

event‑logging‑recording‑
number

Integer denoting the number of
recording files that contain
logged events. The data is sent
when both GA and CEIP are
enabled.

Administrator logging
enablement

admin‑logging‑status Digit indicating the enablement
of administrator logging. “1”
means enabled. “0”means
disabled. The data is sent when
both GA and CEIP are enabled.

Number of logged events collected‑events‑number Integer denoting the number of
logged events. The data is sent
when both GA and CEIP are
enabled.

Number of custom policies customized‑policies‑number Integer denoting the number of
custom session recording and
event logging policies. The
data is sent when both GA and
CEIP are enabled.
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Data Point Key Name Description

Load balancing enablement load‑balancing‑status Digit indicating the
enablement of load balancing.
“1”means enabled. “0”means
disabled. The data is sent when
both GA and CEIP are enabled.

Recording viewing policy
enablement

rbac‑status Digit indicating the enablement
of recording viewing policies.
“1”means enabled. “0”means
disabled. The data is sent when
both GA and CEIP are enabled.

Log events

September 7, 2025

Session Recording can log events and tag events in recordings for later search and playback. You can
search for events of interest from large amounts of recordings and locate the events during playback
in the Session Recording Player.

System‑defined events

Session Recording can log the following system‑defined events that occur during recorded ses‑
sions:

• Insertion of USBmass storage devices

• Application starts and ends

• File renaming, creation, deletion, and moving operations within sessions and file transfers be‑
tween session hosts (VDAs) and client devices (includingmapped client drives and generic redi‑
rectedmass storage devices)

• Web browsing activities

• Topmost window events

• Clipboard activities

• Modifications in the Windows registry
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Insertion of USBmass storage devices

SessionRecording can log the insertion of a Client DriveMapping (CDM)mappedor generic redirected
USBmass storage device in a client where Citrix Workspace™ app for Windows or for Mac is installed.
Session Recording tags these events in the recording.

Note:

To use an inserted USB mass storage device and log the insertion events, set the Client USB
device redirection policy to Allowed in Citrix Studio.

Currently, only the insertion of USBmass storage devices (USBClass 08) can be logged. Formore
information, see Event detection policies.

Application starts and ends

Session Recording supports logging of both application starts and ends. When you add a process to
the App monitoring list, apps driven by the added process and its child processes are monitored.
Child processes of a parent process that starts before Session Recording runs can also be captured.

Session Recording adds the process names, cmd.exe, powershell.exe, and wsl.exe, to the
App monitoring list by default. If you select Log app start events and Log app end events for an
event logging policy, the starts and ends of the Command Prompt, PowerShell, andWindows Subsys‑
tem for Linux (WSL) apps are logged regardless of whether you manually add their process names to
the Appmonitoring list. The default process names are not visible on the Appmonitoring list.

In addition, Session Recording provides a full command line for each app start event logged.
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File renaming, creation, deletion, andmoving operations within sessions and file transfers
between session hosts (VDAs) and client devices

Session Recording can log renaming, creation, deletion, and moving operations on target files and
folders that you specify in the File monitoring list. Session Recording can also log file transfers be‑
tween session hosts (VDAs) and client devices (includingmapped client drives and generic redirected
mass storage devices). Selecting the Log sensitive file events option triggers the logging of file trans‑
fers, no matter whether or not you specify the File monitoring list. For more information, see Event
detection policies.
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Note:

To enable file drag and drop and capture the drag and drop events, set theDrag andDrop policy
to Enabled in Citrix Studio.

Web browsing activities

You can log user activities on supported browsers and tag the events in the recording. The browser
name, URL, and page title are logged. For an example, see the following screen capture.

When you move your cursor away from a webpage that has focus, your browsing of this webpage is
taggedwithout showing thebrowser name. This feature canbeused to estimatehow longauser stays
on a webpage. For an example, see the following screen capture.

List of supported browsers:

Browser Version

Chrome 69 and later

Internet Explorer 11

Firefox 61 and later

Note:

This feature requires Session Recording Version 1906 or later. For more information, see Event
detection policies.

Topmost window events

Session Recording can log the events when the window of an app is on top of all others and tag the
topmost window events in the recording. The process name, title, and process number are logged.
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Clipboard activities

Session Recording can log copy operations of text, images, and files using the clipboard. The process
name and file path are logged for a file copy. The process name and title are logged for a text copy.
The process name is logged for an image copy.

Note: Content of copied text is not logged by default. To log text content, go to the Session
Recording Agent and set HKEY_LOCAL_MACHINE\SOFTWARE\ Citrix\SmartAuditor\
Agent\CaptureClipboardContent to 1(the default value is 0).
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Modifications in the Windows registry

Starting with Version 2109, Session Recording can detect and log the following registrymodifications
while recording sessions:

Registry modification Corresponding event

Adding a key Registry Create

Adding a value Registry Set Value

Renaming a key Registry Rename

Renaming a value Registry Delete Value and Registry Set Value

Changing an existing value Registry Set Value

Deleting a key Registry Delete

Deleting a value Registry Delete Value

For example:
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Toenable this registrymonitoring functionality, select theLog registrymodificationsoption for your
event detection policy. For more information, see Create a custom event detection policy.

Custom events

The Session Recording Agent provides the IUserApi COM interface that third‑party applications can
use to add application‑specific event data into recorded sessions. Based on the event customiza‑
tion, SessionRecording canblock sensitive informationand log the sessionpauseand session resume
events accordingly.

Sensitive information blocking

Session Recording lets you skip certain periods when recording the screen and blocks sensitive infor‑
mation in these periods during session playback. To use this feature, use Session Recording 2012 and
later.
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To use this feature, complete the following steps:

1. In Session Recording Agent Properties, select the Allow third party applications to record
custom data on this VDAmachine check box and click Apply.

2. Grant users permission to invoke the Session Recording Event API (IUserApi COM interface).

Session Recording added access control to the event API COM interface in version 7.15. Only au‑
thorized users are allowed to invoke the functionality to insert eventmetadata into a recording.

Local administrators are granted with this permission by default. To grant other users this per‑
mission, use the Windows DCOM configuration tool:

a) Open the Windows DCOM configuration tool on the Session Recording Agent by running
dcomcnfg.exe.
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b) Right‑click Citrix Session Recording Agent and choose Properties.
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c) Select the Security tab, click Edit to add users with Local Activation permission in the
Launch and Activation Permissions section.
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Note:

DCOM configuration takes effect immediately. There is no need to restart any services or
the machine.

3. Start a Citrix virtual session.

4. Start PowerShell and change the current drive to the <Session Recording Agent installation
path>\Bin folder to import the SRUserEventHelperSnapin.dll module.

5. Run the Session-Pause and Session-Resume cmdlets to set parameters for triggering
sensitive information blocking.

Parameter Description Required or Optional

-APP The app name that calls the
cmdlet.

Required

© 1997–2025 Citrix Systems, Inc. All rights reserved. 138



Session Recording 2110

Parameter Description Required or Optional

-Reason The reason that content is
blocked. If you leave this
parameter unspecified, the
default setting shows, stating
Content Blocked and
Sensitive information exists
and is blocked. If you set this
parameter, the reason you
specify shows when you
navigate to the blocked period
during session playback.

Optional

For example, you can run Session-Pause similar to the following:

Search for and play back recordings with tagged events

Search for recordings with tagged events

The Session Recording Player allows you to perform advanced searches for recordings with tagged
events.
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1. In the Session Recording Player, click Advanced Search on the tool bar or choose Tools > Ad‑
vanced Search.

2. Define your search criteria in the Advanced Search dialog box.

The Events tab allows you to search for tagged events in sessions by Event text or Event type or
both. You can use the Events, Common, Data/Time, and Other filters in combination to search for
recordings that meet your criteria.

Note:

• The Event type list itemizes all event types that have been logged by Citrix Session Record‑
ing. Youcanselectanyoneof theevent types tosearch. SelectingAnyCitrix‑definedevent
means to search for all recordings with any type of events logged by Citrix Session Record‑
ing.

• The Event text filter supports partial match. Wildcards are not supported.
• The Event text filter is case‑insensitive whenmatching.
• For the types of events, the words App Start, App End, Client drive mapping,
and File Rename do not participate in matching when you search by Event text.
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Therefore, when you type App Start, App End, Client drive mapping, or
File Rename in the Event text box, no result can be found.

Play back recordings with tagged events

When you play back a recording with events tagged, the events are present in the Events and Book‑
marks panel and show as yellow dots in the lower part of the Session Recording Player:

You can use events to navigate through a recorded session, or skip to the points where the events are
tagged.

View recordings

September 7, 2025

Use the Session Recording Player to view, search, and bookmark recorded Citrix Virtual Apps and
Desktops™ sessions.

If sessions are recorded with the live playback feature enabled, you can view sessions that are in
progress, with a delay of 1‑2 seconds.
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Sessions that have a longer duration or larger file size than the limits configured by your Session
Recording administrator appear in more than one session file.

Note:

A Session Recording administrator must grant users the right to access the recorded sessions of
VDAs. If youaredeniedaccess to viewing sessions, contact your SessionRecording administrator.

When theSessionRecordingPlayer is installed, theSessionRecordingadministrator typically setsupa
connection between the Session Recording Player and a Session Recording Server. If this connection
is not set up, the first time you perform a search for files, you are prompted to set it up. Contact your
Session Recording administrator for setup information.

Launch the Session Recording Player

September 7, 2025

Launch the Session Recording Player

Note:

• If a recording contains blocked content, Session Recording skips it. However, if you navi‑
gate to the blocked period, your playback shows a black screen and a message indicating
that that content is blocked. To use this feature, use Session Recording 2012 and later.

• If you are using the Session Recording Player 2009 and earlier to play back a recording, the
following error message appears. The web player is not impacted.

1. Log on to the workstation where the Session Recording Player is installed.

2. From the Start menu, choose Session Recording Player. The Session Recording Player ap‑
pears.
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Tip: The EventOnly column indicates a screen recording or an event‑only recording.

To show all recording files of a recorded session, right‑click a recording on the list and choose
Follow up.
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Display or hide window elements

The Session Recording Player has window elements that toggle on and off.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose View.
4. Choose the elements that you want to display. Selecting an element causes it to appear imme‑

diately. A check mark indicates that the element is selected.

Connect to the desired Session Recording Server

You can set up your Session Recording Player to connect to multiple Session Recording Servers and
then select a Session Recording Server that it connects to. The Session Recording Player can connect
to only one Session Recording Server at a time.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Tools >Options > Connections.
4. Select the Session Recording Server to which you want to connect.
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Enable or disable live session playback and playback protection

September 7, 2025

Enable or disable live session playback

If sessions are recorded with the live playback feature enabled, you can view a session after or while
it is being recorded. Viewing a session that is being recorded is similar to seeing actions happening
live. However, there is actually a delay of 1‑2 seconds when the data propagates from the VDA.

Some functionality is not available when you view sessions that are not recorded completely:

• A digital signature cannot be assigned until recording is complete. If digital signing is enabled,
you can view live playback sessions. But they are not digitally signed and you cannot view the
certificates until the session is completed.

• Playback protection cannot be applied until recording is complete. If playback protection is
enabled, you can view live playback sessions. But they are not encrypted until the session is
completed.

• You cannot cache a file until recording is complete.

By default, live session playback is enabled.

1. Log on to the computer hosting the Session Recording Server.
2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Playback tab.
4. Select or clear the Allow live session playback check box.

Enable or disable playback protection

As a security precaution, Session Recording automatically encrypts recorded files that are down‑
loaded for viewing in the Session Recording Player. This playback protection prevents recorded files
from being copied and viewed by anyone other than the user who downloaded the file. The files
cannot be played back on another workstation or by another user. Encrypted files are identified
with an .icle extension. Unencrypted files are identified with an .icl extension. The files remain
encrypted while they reside in %localAppData%\Citrix\SessionRecording\Player\
Cache on the Session Recording Player until an authorized user opens them.

We recommend that you use HTTPS to protect the transfer of data.

By default, playback protection is enabled.

1. Log on to the machine hosting the Session Recording Server.
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2. From the Startmenu, choose Session Recording Server Properties.
3. In Session Recording Server Properties, click the Playback tab.
4. Select or clear the Encrypt session recording files downloaded for playback check box.

Open and play recordings

September 7, 2025

Open recordings

You can open session recordings in the Session Recording Player in three ways:

• Perform a search using the Session Recording Player. Recorded sessions that meet the search
criteria appear in the search results area.

• Access recorded session files directly from your local disk drive or a shared drive.
• Access recorded session files from a Favorites folder.

When youopena file thatwas recordedwithout adigital signature, awarningmessage appears saying
that the origin and integrity of the file were not verified. If you are confident of the integrity of the file,
click Yes in the warning window to open the file.

A check on the Citrix Workspace™ app version is conducted before the Session Recording Player plays
backa recording file. If thePlayerdoesnot support theversionof theCitrixWorkspaceapp thathas the
file recorded, an error is returned. To eliminate the error, select Skip Citrix Workspace app version
check before playback in Session Recording Server Properties.
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Note:

The Administrator Logging feature of Session Recording allows you to log the downloads of
recordings in the Session Recording Player. For more information, see Administrator Logging.

Open a recording in the search results area

1. Log on to the machine where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Perform a search.
4. If the search results area is not visible, select Search Results in the Workspace pane.
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5. In the search results area, select the session you want to play.
6. Do any of the following:

• Double‑click the session.
• Right‑click and select Play.
• From the Session Recording Playermenu bar, choose Play > Play.

Open a recording by accessing the file

The name of a recorded session file begins with i_, followed by a unique alphanumeric file ID and
then the .icl or .icle extension. The .icl extension denotes the recordings without playback
protection applied. The .icle extension denotes the recordings with playback protection applied.
Recorded session files are saved in a folder that incorporates the date the sessions were recorded.
For example, the file for a session recorded on December 22, 2014, is saved in the folder path
2014\12\22.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Do any of the following:

• From the Session Recording Playermenu bar, choose File>Open and browse for the file.
• Using Windows Explorer, navigate to the file and drag the file to the Playerwindow.
• Using Windows Explorer, navigate to and double‑click the file.
• If you created Favorites in theWorkspace pane, selectFavorites andopen the file from the
Favorites area in the same way you open files from the search results area.

Use favorites

Creating theFavorites folders allows you toquickly access recordings that you view frequently. These
Favorites folders reference recorded session files that are stored on your workstation or on a network
drive. You can import and export these files to other workstations and share these folders with other
Session Recording Player users.

Note:

Only userswith access rights to the SessionRecordingPlayer candownload the recorded session
files associated with the Favorites folders. Contact your Session Recording administrator for the
access rights.

To create a Favorites subfolder:

1. Log on to the workstation where the Session Recording Player is installed.
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2. From the Startmenu, choose Session Recording Player.
3. In the Session Recording Playerwindow, select the Favorites folder in your Workspace pane.
4. From the menu bar, choose File > Folder > New Folder. A new folder appears under the Fa‑

vorites folder.
5. Type the folder name, then press Enter or click anywhere to accept the new name.

Use the other options that appear in the File > Foldermenu to delete, rename, move, copy, import,
and export the folders.

Play recordings

After you open a recorded session in the Session Recording Player, you can navigate through the
recorded sessions using these methods:

• Use the player controls to play, stop, pause, and increase or decrease playback speed.
• Use the seek slider to move forward or backward.

If you have inserted markers to the recording or if the recorded session contains custom events, you
can also navigate through the recorded session by going to those markers and events.

Note:

• During playback of a recorded session, a secondmouse pointer might appear. The second
pointer appears at the point in the recording when the user navigated within Internet Ex‑
plorer and clicked an image that was originally larger than the screen but was scaled down
automatically by Internet Explorer. While only one pointer appears during the session, two
might appear during playback.

• This version of Session Recording does not support SpeedScreen Multimedia Acceleration
and the Flash quality adjustment policy setting. When this option is enabled, playback dis‑
plays a black square.

• Whenyou recorda sessionwitha resolutionhigher thanorequal to4096x4096, theremight
be fragments in the recording appearance.

Use the player controls

You can click the player controls in the lower part of the Player window or access them by choosing
Play from the Session Recording Playermenu bar.

Player Control Function

Plays the selected session file.
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Player Control Function

Pauses playback.

Stops playback. If you click Stop, then Play, the
recording restarts at the beginning of the file.

Halves the current playback speed down to a
minimum of one‑quarter of the normal speed.

Doubles the current playback speed up to a
maximum of 32 times the normal speed.

Use the seek slider

Use the seek slider in the lower part of the Player window to jump to a different position within the
recorded session. You can drag the seek slider to the point in the recording you want to view or click
anywhere on the slider bar to move to that location.

You can also use the following keyboard keys to control the seek slider:

Keyboard Key Function

Home Seeks to the beginning.

End Seeks to the end.

Right Arrow Seeks forward five seconds.

Left Arrow Seeks backward five seconds.

Move the mouse wheel one notch down Seeks forward 15 seconds.

Move the mouse wheel one notch up Seeks backward 15 seconds.

Ctrl + Right Arrow Seeks forward 30 seconds.

Ctrl + Left Arrow Seeks backward 30 seconds.

Page Down Seeks forward oneminute.

Page Up Seeks backward oneminute.

Ctrl + Move the mouse wheel one notch down Seeks forward 90 seconds.

Ctrl + Move the mouse wheel one notch up Seeks backward 90 seconds.

Ctrl + Page Down Seeks forward six minutes.

Ctrl + Page Up Seeks backward six minutes.
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To adjust the speed of the seek slider: From the Session Recording Playermenu bar, choose Tools >
Options>Playeranddrag the slider to increaseordecrease the seek response time. A faster response
time requiresmorememory. The responsemight be slowdepending on the size of the recordings and
your machine’s hardware.

Change the playback speed

You can set the Session Recording Player to play recorded sessions in exponential increments from
one‑quarter normal playback speed to 32 times normal playback speed.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Play > Play Speed.
4. Choose a speed option.

The speed adjusts immediately. Text indicating the exponential rate appears briefly in green in the
lower part of the Player window.

Highlight the idle periods of recorded sessions

Idle periods of a recorded session are the portions inwhich no action takes place. The Session Record‑
ing Player can highlight the idle periods of recorded sessions during playback. The option is On by
default. For more information, see Highlight idle periods.

Skip over spaces where no action occurred

Fast reviewmode allows you to set Session Recording Player to skip the portions of recorded sessions
in which no action takes place. This setting saves time for playback viewing. However, it does not
skip animated sequences suchas animatedmousepointers, flashing cursors, or displayed clockswith
second handmovements.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Play > Fast ReviewMode.

The option toggles on and off. Each time you choose it, its status appears briefly in green in the Player
window.
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Change the playback display

Options allow you to change how recorded sessions appear in the Player window. You can pan and
scale the image, show the playback in full screen, display the Player window in a separate window,
and display a red border around the recorded session to differentiate it from the Player window back‑
ground.

Display the Player window in full screen

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose View > Player Full Screen.
4. To return to the original size, press Esc or F11.

Display the Player window in a separate window

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose View > Player in Separate Window. A

new window appears, containing the Player window. You can drag and resize the window.
4. To embed the Player window in the main window, choose View > Player in Separate Window,

or press F10.

Scale the session playback to fit the Player window

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Play > Panning and Scaling > Scale to

Fit.

• Scale to Fit (Fast Rendering) shrinks images while providing good quality. Images are
drawn quicker than using the High Quality option but the images and texts are not sharp.
Use this option if you are experiencing performance issues when using the High Quality
mode.

• Scale to Fit (High Quality) shrinks images while providing high quality. Using this option
can cause the images to be drawnmore slowly than the Fast Rendering option.

Pan the image

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
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3. From the Session Recording Playermenu bar, choose Play > Panning and Scaling > Panning.
The pointer changes to a hand. And a small representation of the screen appears in the top right
of the Player window.

4. Drag the image. The small representation indicates where you are in the image.
5. To stop panning, choose one of the scaling options.

Display a red border around Session Recording

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Tools >Options > Player.
4. Select the Show border around session recording check box.

If the Show border around session recording check box is not selected, you can temporarily
view the red border by clicking and holding down the left mouse button while the pointer is in
the Player window.

Highlight idle periods

September 7, 2025

Idle periods of a recorded session are the portions inwhich no action takes place. The Session Record‑
ing Player can highlight the idle periods of recorded sessions during playback. The option is On by
default.

Note: Idle periods are not highlighted when playing back live sessions with the Session Recording
Player.

To highlight the idle periods of recorded sessions, do the following:

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose View > Idle Periods and select or clear

the check box.

Cache recordings

September 7, 2025
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Each time you open a recorded session file, the Session Recording Player downloads the file from the
location where the recordings are stored. If you download the same files frequently, you can save
download time by caching the files on your workstation. Cached files are stored on your workstation
in this folder:

userprofile\AppData\Local\Citrix\SessionRecording\Player\Cache

You can specify howmuch disk space is used for the cache. When the recordings fill the specified disk
space, Session Recording deletes the oldest, least used recordings to make room for new recordings.
You can empty the cache at any time to free up disk space.

Enable caching

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Tools >Options > Cache.
4. Select the Cache downloaded files on local machine check box.
5. To limit the amount of disk space used for caching, select the Limit amount of disk space to

use check box and specify the number of MB to be used for cache.
6. ClickOK.

Empty caches

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Tools >Options > Cache.
4. Select the Cache downloaded files on local machine check box.
5. In the Session Recording Player, choose Tools >Options > Cache.
6. Click Purge Cache andOK to confirm the action.

Use events and bookmarks

September 7, 2025

You can use events and bookmarks to help you navigate through recorded sessions.

Citrix‑defined events are inserted to sessions while the sessions are recorded. You can also use the
EventAPI anda third‑party application to insert customevents. Events are savedaspart of the session
file. You cannot delete or alter them using the Session Recording Player.
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Bookmarks are markers you insert in a recorded session during session playback using the Ses‑
sion Recording Player. After insertion, bookmarks are associated with the recorded session until
you delete them. However, they are not saved as part of the session file but stored as sepa‑
rate .iclb files in the Bookmarks cache folder on the Session Recording Player, for example,
C:\Users\SpecificUser\AppData\Local\Citrix\SessionRecording\Player\Bookmarks, with the same
file name as the .icl recording file. To play back a recording using bookmarks on a different Player,
copy the .iclb files to the Bookmarks cache folder on that Player. By default, each bookmark is
labeled with the text “Bookmark,”but you can change it to any text annotation up to 128 characters
long.

Events appear as yellow dots and bookmarks appear as blue squares in the lower part of the Player
window. Moving the mouse over the dots and squares displays the text label associated with them.
You can also display the events and bookmarks in the Events and Bookmarks list of the Session
Recording Player. They appear in this list with their text labels and the times in the recorded session
at which they appear, in chronological order.

You can use events and bookmarks to help you navigate through recorded sessions. By going to an
event or bookmark, you can skip to the point in the recorded session where the event or bookmark is
inserted.

Display events and bookmarks in the list

The Events and Bookmarks list displays the events and bookmarks inserted in the recorded session
that is currently playing. It can show events only, bookmarks only, or both.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Move the mouse pointer to the Events and Bookmarks list area and right‑click to display the

menu.
4. Choose Show Events Only, Show Bookmarks Only, or Show All.

Insert a bookmark

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Begin playing the recorded session to which you want to add a bookmark.
4. Move the seek slider to the position where you want to insert the bookmark.
5. Move the mouse pointer to the Player window area and right‑click to display the menu.
6. Add a bookmark with the default Bookmark label or create an annotation:

• To add a bookmark with the default Bookmark label, choose Add Bookmark.
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• To add a bookmark with a descriptive text label that you create, choose Add Annotation.
Type the text label you want to assign to the bookmark, up to 128 characters. ClickOK.

Add or change an annotation

After a bookmark is created, you can add an annotation to it or change its annotation.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Begin playing the recorded session containing the bookmark.
4. Ensure that the Events and Bookmarks list is displaying bookmarks.
5. Select the bookmark in the Events and Bookmarks list and right‑click to display the menu.
6. Choose Edit Annotation.
7. In the window that appears, type the new annotation and clickOK.

Delete a bookmark

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Begin playing the recorded session containing the bookmark.
4. Ensure that the Events and Bookmarks list is displaying bookmarks.
5. Select the bookmark in the Events and Bookmarks list and right‑click to display the menu.
6. Choose Delete.

Go to an event or bookmark

Going to an event or bookmark causes the Session Recording Player to go to the point in the recorded
session where the event or bookmark is inserted.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Begin playing a session recording containing events or bookmarks.
4. Go to an event or bookmark:

• In the lower part of the Player window, click the dot or square representing the event or
bookmark to go to the event or bookmark.

• In the Events and Bookmarks list, double‑click the event or bookmark to go to it. To go
to the next event or bookmark, select any event or bookmark from the list, right‑click to
display the menu, and choose Seek to Bookmark.
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Search for recordings

September 7, 2025

The Session Recording Player allows you to perform quick and advanced searches and to specify op‑
tions that apply to all searches. Results of searches appear in the search results area of the Session
Recording Player.

Note:

To display all available recorded sessions, up to the maximum number of sessions that might
appear in a search, perform a search without specifying any search parameters.

Perform a quick search

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. Define your search criteria:

• Enter a search criterion in the Search field.
• Move the mouse pointer over the Search label to display a list of parameters to use as a
guideline.

• Click the arrow to the right of the Search field to display the text for the last 64 searches
you performed.

• Use the drop‑down list to the right of the Search field to select a period or duration speci‑
fying when the session was recorded.

4. Click the binocular icon to the right of the drop‑down list to start the search.

Perform an advanced search

Advanced searches might take up to 20 seconds to return results containing more than 150,000 enti‑
ties. Citrix® recommendsusingmoreaccurate search conditions suchas adate rangeoruser to reduce
the result number.

1. Log on to the workstation where the Session Recording Player is installed.

2. From the Startmenu, choose Session Recording Player.

3. In the Session Recording Player window, click Advanced Search on the tool bar or choose
Tools > Advanced Search.

4. Define your search criteria on the tabs of the Advanced Search dialog box:
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• Common allows you to search by domain or account authority, site, group, VDA for multi‑
session OS, application, or file ID.

• Date/Time allows you to search date, day of week, and time of day.
• Events allows you to search for Citrix‑defined and custom events that are inserted to the
sessions.

• Other allows you to search by session name, client name, client address, and recording
duration. It also allows you to specify, for this search, the maximum number of search
results displayed and whether archived files are included in the search.
When you specify search criteria, the query you are creating appears in the pane at the
bottom of the dialog box.

5. Click Search to start the search.

You can save and retrieve advanced search queries. Click Save in the Advanced Search dialog
box to save the current query. ClickOpen in theAdvancedSearchdialogbox to retrieve a saved
query. Queries are saved as files with an .isq extension.

Set search options

The Session Recording Player search options allow you to limit the maximum number of session
recordings that appear in search results and to specify whether search results include archived
session files.

1. Log on to the workstation where the Session Recording Player is installed.
2. From the Startmenu, choose Session Recording Player.
3. From the Session Recording Playermenu bar, choose Tools >Options > Search.
4. In theMaximum result to display field, type the number of search results you want to display.

A maximum of 500 results can be displayed.
5. To set whether archived files are included in searches, select or clear Include archived files.

Session Recording web player

December 8, 2021

Overview

The web player lets you use a web browser to view and play back recordings. Using the web player,
you can:
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• Search for recordings by using filters, including host name, client name, user name, application,
client IP address, event text, event type, and time.

• View and play back both live and completed recordings with tagged events listed in the right
pane.

• configure cachememory for storing recordings while playing.

• Highlight idle periods.

• Leave comments about a recording and set comment severities.

• Share URLs of recordings.

• View graphical event statistics for each recording.

Note:

Supported browsers include Google Chrome, Microsoft Edge, and Firefox.

Enable the web player

The web player is enabled by default.

• To disable the web player, start a Windows command prompt and run the <Session
Recording Server installation path>\Bin\SsRecUtils.exe –disablewebplayer
command.

• To enable the web player, start a Windows command prompt and run the <Session
Recording Server installation path>\Bin\SsRecUtils.exe -enablewebplayer
command.

Logon and password

The URL of the web player website is http(s)://<FQDN of Session Recording Server
>/WebPlayer. To ensure the use of HTTPS, add an SSL binding to the website in IIS and update
the SsRecWebSocketServer.config configuration file. For more information, see the HTTPS
configuration section in this article.

Note:

When logging on to theweb player website, domain users do not need to enter credentials while
non‑domain users must.
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Installation

Install the web player on the Session Recording Server only. Double‑click SessionRecordingWeb‑
Player.msi and follow the instructions to complete your installation. For more information about
installing Session Recording, see Install, upgrade, and uninstall.

Starting from Version 2103, Session Recording migrates the WebSocket server to IIS. With the web
player installed, the SessionRecordingRestApiService, SessionRecordingWebStreaming, and
WebPlayer applications appear in IIS.

A fresh installation of Session Recording 2103 and later connects your web browser to theWebSocket
server hosted in IIS when you access the web player website. The WebSocket server hosted in IIS is
versioned 2.0, as indicated by the registry valueWebSocketServerVersion under the registry key at
HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.
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Anupgrade installation fromanearlier version to SessionRecording 2103 and later connects yourweb
browser to thePython‑basedWebSocket server. To connect to theWebSocket server hosted in IIS, run
the <Session Recording Server installation path>\Bin\SsRecUtils.exe ‑enablestreamingservice
command. To connect back to the Python‑based WebSocket server, run the <Session Recording
Server installation path>\Bin\SsRecUtils.exe ‑ disablestreamingservice command. The Python‑
based WebSocket server is versioned 1.0.

HTTPS configuration

To use HTTPS to access the web player website:

1. Add an SSL binding in IIS.

a) Obtain an SSL certificate in PEM format from a trusted Certificate Authority (CA).

Note:

Most popular browsers such as Google Chrome and Firefox no longer support the
common name in a Certificate Signing Request (CSR). They enforce Subject Alterna‑
tive Name (SAN) in all publicly trusted certificates. To use theweb player over HTTPS,
take the following actions accordingly:

• When a single Session Recording Server is in use, update the certificate of the
Session Recording Server to a SAN certificate.
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• When load balancing is in use, ensure that a SAN certificate is available both on
Citrix ADC and on each Session Recording Server.

b) On IIS, right‑click the website and select Add Bindings. The Site Bindings dialog box ap‑
pears.
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c) Click Add in the upper right corner. The Add Site Binding dialog box appears.

d) Select https from the Type list and select your SSL certificate.

e) ClickOK.

2. Update the SsRecWebSocketServer.config configuration file.

a) Locate and open the SsRecWebSocketServer.config configuration file.

The SsRecWebSocketServer.config configuration file is typically located in the <
Session Recording Server installation path>\Bin\ folder.
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b) (Optional) For Session Recording 2103 and later that host the WebSocket server in IIS, en‑
able TLS by editing TLSEnable=1 and ignore the ServerPort, SSLCert, and SSLKey fields.

c) (Optional) For SessionRecording2012andearlier, enable TLSbyeditingTLSEnable=1, and
fill in the paths to the SSL certificate and its key, respectively.

Note:

Only the PEM format of SSL certificates and key files is supported.
The ServerPort field indicates the port number that the web player uses to collect
recording files. In the following screen capture, it is set to the default value (22334).

To extract the separate certificate andkey files used in theWebSocket server configuration:

i. Ensure that OpenSSL is installed on your Session Recording Server that contains the
SSL certificate.

ii. Export the SSL certificate as a .pfx file. The .pfx file includes both the certificate and
the private key.

iii. Open the command prompt and go to the folder that contains the .pfx file.

iv. Start OpenSSL from the OpenSSL\bin folder.

v. Run the following command to extract the certificate:

1 openssl pkcs12 -in [yourfile.pfx] -clcerts -nokeys -out [
aSRS2.pem]

Enter the import password that you created when exporting the .pfx file.

vi. Run the following command to extract the private key:
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1 openssl pkcs12 -in [yourfile.pfx] -nocerts -out [
newaSRS2keyWithPassword.pem]

Enter the import password that you created when exporting the .pfx file. Provide a
new password for protecting your key file when prompted for the PEM pass phrase.

vii. Run the following command to decrypt the private key:

1 openssl rsa -in [newaSRS2keyWithPassword.pem] -out [
newaSRS2key.pem]

d) Save your changes.

e) Check your firewall settings. Allow SsRecWebSocketServer.exe to use the TCP port (22334
by default) and allow access to the web player URL.

f) Run the SsRecUtils –stopwebsocketserver command.

View recordings

After you log on, the web player home pagemight hide or show content based onwhether the follow‑
ing option is selected in Session Recording Server Properties.
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• With the option selected, the web player home page hides all content. Recordings can be ac‑
cessed only by way of their URLs. Recording URLs are provided in email alerts that are sent to
specified recipients. For information about email alerts, see Email response policies. You can
also share recording URLs through the Share Current Playback control on recording playback
pages. See descriptions later in this article.

• With the option unselected, the web player home page shows content similar to the following
screen capture. Click All Recordings in the left navigation to refresh the page and display new
recordings if there are any. Scroll down the webpage to select recordings to view or use filters
to customize your search results. For live recordings, the Duration column shows Live and the
play button appears green.

To show all recording files of a recorded session, select a recording on the list and click the Follow up
icon. The Follow up icon is available only when a recording is selected.
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For a description of the recording items, see the following table.

Item Description

Start time The recording start time. Click the up and down
arrows to list recordings in chronological order.

User The user whose session was recorded. Click the
up and down arrows to concentrate recordings
of a user on the list and arrange users in
alphabetical order.

Host The host name of the VDA where the recorded
session was hosted. Click the up and down
arrows to arrange the VDA host names in
alphabetical order.

Client The name of the client device where the session
was running. Click the up and down arrows to
arrange the client host names in alphabetical
order.

Events The quantity of events in the recording. Click the
up and down arrows to arrange recordings on
the list by event quantity.

Events Only Indicates a screen recording or an event‑only
recording. An event‑only recording played in the
web player contains an event statistics pie chart
and histogram. The pie chart and histogram
hold static throughout playback.

Recording Server The Session Recording Server that processes
recording data sent from VDAs.

Duration The time length of the recording. Click the up
and down arrows to arrange recordings on the
list by time length.
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Search for recordings by using filters

You can search for recordings by using filters. The available filters include host name, client name,
user name, application, client IP address, event text, event type, and time.

For example, after you select the host name filter, the following dialog box appears. Type in the host
name (of the VDAwhere recorded sessions are hosted) and click Search to filter out irrelevant record‑
ings and display only the relevant ones.

You can change to a different filter by clicking the currently selected Host name, as shown in the
following screen capture. All filters are listed after you click Host name. Select a different filter as
needed.

You can also click the + symbol to add filters.

For example, you can add the Time filter as shown in the following screen.
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The Time filter consists of recording start date, start time, and duration.

Open and play recordings

On the recordings page, each recording has a play button on the right side, next to the Duration
item.

Click the play button. The playback page appears. Playback starts after memory caching.
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Tip:

• Clicking the session progress time lets you switch to the absolute date and time the session
was recorded.

• For an event‑only recording, the play icon in the upper left corner is unavailable.

For a description of the player controls, see the following table:

Player Control Description

Plays the selected recording file.

Pauses playback.

You can drag the progress bar during playback.
Idle periods of recorded sessions are highlighted
during playback.

Seeks backward 7 seconds.

Indicates the current position of the recording
playback and the total recording duration. The
time format is HH:MM:SS.
Lets you click and leave a comment about the
recording being played.
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Player Control Description

Lets you click and copy the URL of the current
recording to the clipboard.

Indicates the current speed of playback. Click
the icon to switch between options including
X0.5, X1, X2, and X4.
Displays the playback in full screen.

Displays the playback within the webpage.

In the right pane of the playback page, the Events andComments filters, quick search box, and some
recording data are available:
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• The date and time on the web player machine. In this example, AUG 20, 2021 and 18:50:50.

• The duration of the recording in playback. In this example, 01:37:00.

• The number of events in the recording. In this example, 359 EVENTS.

• The name of the user whose session was recorded.

• The host name of the VDA where the recorded session was hosted.

• The name of the client device where the session was running.

• Options for sorting search results: Select All, Events, or Comments to sort search results.

• Event filters. You can select more than one filter to search for events in the current recording.

Click the icon to expand displays of events. For example:
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• Event list. Clicking an event on the list takes you to the position of the event in the recording.

• Quick search box. The search events quick search box helps to quickly narrow down a list of
events in the current recording.

View graphical event statistics

Event data visualization is available in the web player for each recording. It provides graphical event
statistics that help you quickly comprehend large numbers of events inserted in recordings, allowing
you to easily see and communicate event trends.

To view graphical event statistics, complete the following steps:

1. Open and play a recording.

2. In the upper left corner of the playback page, click the statistics icon.

3. Switchbetween theScreen time,File transfers,Commands, andEvents tabs to viewstatistics
from different perspectives.

• Screen time

The Screen time tab lets you know the cumulative time an application window is in focus
(active window).
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By clicking the horizontal time bar next to an application on the list, you can view the start
time and duration each time the application becomes and stays in focus, respectively. You
can narrow down your search range by specifying a duration range other than the default
All option. For example:

• File transfers

The File transfers tab provides graphical statistics about bidirectional file transfers be‑
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tween the VDA hosting the recorded session and the client device where the session runs.
You can customize the visualization by using the following settings:

• Time granularity: Per 1minute, Per 10minutes, Per hour
• File transfer destination: All transfers, Transfer from host to client, Transfer from
client to host

• Number or size (Bytes or MB) of transferred files

The X axis represents the absolute time in the 24‑hour system.

• Commands

The Commands tab shows CMD and PowerShell commands that are run during the
recorded session. You can customize the data display by typing your custom search in
Custom search or selecting a saved search from Saved search. The “OR”logical operator
is used to compute the final action.
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• Events

The Events tab shows the proportions and numbers of all types of events in the recorded
session.
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Configure cachememory for storing recordings while playing

On the Configuration page of the web player, click the slider to set up the cache memory for storing
recordings while playing.

Tip:

You can access theConfiguration page directly throughhttp(s)://<FQDNof Session Recording
Server>/WebPlayer/#/configuration/cache.

Record idle events and highlight idle periods

Session Recording can record idle events and highlight idle periods in the Session Recording web
player. Idle events are not visible in the Session Recording Player because idle events are saved in
the Session Recording Database but not in the relevant recording files (.icl files).

To customize the idle event feature, set the following registry keys as required. The registry keys are
located at HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SessionEvents.

Registry key Default value Description

DisableIdleEvent 0 To disable the idle event
feature, set the value to 1. To
enable the idle event feature,
set the value to 0.
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Registry key Default value Description

IdleEventThrottle 120 seconds If there is no user activity
(including graphics changes
and keyboard/mouse inputs)
longer than the time threshold
set by the registry key, an idle
event is recorded. The idle
period is highlighted when the
recorded session plays back on
the Session Recording web
player.

IdleEventActiveThrottle 30 seconds Only a certain number of
graphics changes within a
specified amount of time
qualify as user activities. By
default, at least three packets
within 30 seconds can qualify
as user activities.

IdleEventActivePktNumThrottle 3 packets Only a certain number of
graphics changes within a
specified amount of time
qualify as user activities. By
default, at least three packets
within 30 seconds can qualify
as user activities.

IdleEventActivePktSizeThrottle 100 bytes Graphics packets smaller than
the key value are ignored and
the relevant time duration is
regarded as idle.

Comment on recordings

When a recorded session is being played, you can click the Comments player control to leave com‑
ments and set comment severities. Severities include Normal, Medium, and Severe. Severe and
Medium comments are indicated with red and orange dots, respectively. During session playback,
you can view all comments about a recording. To delete a comment you just left, refresh your web‑
page, expand the comment, and then click Delete.
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Clicking a comment lets you jump to the locationwhere the commentwas given. You can viewall your
comments on theMy comments page.

Note:

Tomake the comment feature work as expected, clear theWebDAV Publishing check box in the
Add Roles and Featureswizard of Server Manager on the Session Recording Server.
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Share URLs of recordings

ClickingShareCurrentPlaybackon the playback page of a recording copies the recordingURL to the
clipboard. You can share the URL with other users for them to access the recording directly without
the need to search in all recordings.
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After you click Share Current Playback, either of the following messages appears, indicating a suc‑
cessful or failed operation respectively:

• The URL to the shared recording has been copied to the clipboard

• Sharing the recording URL failed

Pasting the shared URL in the address bar lets you jump to the location where the URL was copied.

For secure sharing, set the following registry values under HKEY_LOCAL_MACHINE\SOFTWARE\
Citrix\SmartAuditor\Server:

Registry value Description Default value Remarks

LinkExpire Time span beyond
which a shared URL
expires. Counted as
timeticks in the unit of
10 microseconds.

1,728,000,000,000 (The
default value equals 2
days.)

‑

LinkSalt A security method to
protect the preceding
URL expiration time

Kk2od974 Change the default
value to an arbitrary
string that preferably
ends with digits.

Administrator Logging integrated with the web player

Theweb player integrates the Administrator Loggingwebpage. An administrator assigned to both the
LoggingReader and the Player roles can view the administrator activity logs in the web player.
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Note:

The language set for the web player browser must match the language you selected when you
installed the Session Recording Administration components.

• Configuration logging:

• Recording reason logging:

Ensure that your SessionRecordingLoggingWebApplication site in IIS and the web player have the
same SSL settings. Otherwise, 403 errors occur when you request to access the administrator activity
logs.
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Troubleshoot

September 7, 2025

The troubleshooting information contains solutions to some issues you might encounter during or
after installing the Session Recording components.

Warning:

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix® cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

Installation of Server components fails

September 7, 2025

The installation of the Session Recording Server components fails with error codes 2503 and 2502.
Resolution: Check the access control list (ACL) of folder C:\windows\Temp to ensure that the Local
Users and Groups have write permission for this folder. If not, manually add write permission.
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Test connection to the Database fails during install

September 7, 2025

When you install the Session RecordingDatabase or the Session Recording Server, the test connection
fails with the error message Database connection test failed. Please correct Database instance
name even if the database instance name is correct.

In this case, ensure that the current user has the public SQL Server role permission to correct the
permission limitation failure.

Agent cannot connect to the Server

December 8, 2021

When the Session Recording Agent cannot connect to the Session Recording Server, the Exception
caught while sending poll messages to Session Recording Broker event message is logged, fol‑
lowed by the exception text. The exception text provides reasons why the connection failed. The
reasons include:

• The underlying connection was closed. Could not establish a trust relationship for the
SSL/TLS secure channel. This exception means that the Session Recording Server is using a
certificate signed by a CA that the server hosting the Session Recording Agent does not trust or
the server hosting the Session Recording Agent does not have a CA certificate. Alternatively, the
certificate might have expired or been revoked.

Solution: Verify that the correct CA certificate is installed on the server hosting the Session
Recording Agent or use a CA that is trusted.

• The remote server returned an error: (403) forbidden. This standard HTTPS error occurs
when you attempt to connect using HTTP that is unsecure. The machine hosting the Session
Recording Server rejects the connection because it accepts only secure connections.

Solution: Use Session Recording Agent Properties to change the Session Recording Broker pro‑
tocol toHTTPS.

• The Session Recording Broker returned an unknown error while evaluating a record pol‑
icy query. Error code 5 (Access Denied). For more information, see the Event log on the
Session Recording Server. This error occurs when sessions are started and a request for a
record policy evaluation is made. The error is a result of the Authenticated Users group (the de‑
faultmember) being removed fromthePolicyQuery roleof theSessionRecordingAuthorization
Console.
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Solution: Add the Authenticated Users group back to this role, or add each server hosting each
Session Recording Agent to the PolicyQuery role.

• The underlying connection was closed. A connection that was expected to be kept alive
was closed by the server. This error means that the Session Recording Server is down or un‑
available to accept requests. The IIS might be offline or restarted, or the entire server might be
offline.

Solution: Verify that the Session Recording Server is started, IIS is running on the server, and
the server is connected to the network.

• The remote server returned an error: 401 (Unauthorized). This error manifests itself in the
following ways:

• On startup of the Session Recording Agent Service, an error describing the 401 error is
recorded in the event log.

• Policy query fails on the Session Recording Agent.
• Session recordings are not captured on the Session Recording Agent.

Solution: Ensure that theNT AUTHORITY\AuthenticatedUsers group is amember of the local
Users group on the Session Recording Agent.
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Server cannot connect to the Database

September 7, 2025

When the SessionRecording Server cannot connect to the SessionRecordingDatabase, youmight see
a message similar to one of the following:

Event Source:

A network‑related or instance‑specific error occurred while establishing a connection to SQL
Server. This error appears in the applications event log with ID 2047 in the Event Viewer of the com‑
puter hosting the Session Recording Server.

Citrix Session Recording Storage Manager Description: Exception caught while establishing
database connection. This error appears in the applications event log in the Event Viewer of the
machine hosting the Session Recording Server.

Unable to connect to the Session Recording Server. Ensure that the Session Recording Server is
running. This error message appears when you launch the Session Recording Policy Console.

Resolution:

• The Express Edition of Microsoft SQL Server 2008 R2, Microsoft SQL Server 2012, Microsoft SQL
Server 2014, or Microsoft SQL Server 2016 is installed on a stand‑alone server and does not
have the correct services or settings configured for Session Recording. The server must have
the TCP/IP protocol enabled and the SQL Server Browser service running. See the Microsoft
documentation for information about enabling these settings.

• During the Session Recording installation (administration portion), incorrect server and data‑
base information was given. Uninstall the Session Recording Database and reinstall it, supply‑
ing the correct information.

• The Session Recording Database Server is down. Verify that the server has connectivity.
• The machine hosting the Session Recording Server or the machine hosting the Session Record‑
ing Database Server cannot resolve the FQDN or NetBIOS name of the other. Use the ping com‑
mand to verify that the names can be resolved.

• Check the firewall configuration on the Session Recording Database to ensure that the SQL
Server connections are allowed. Formore information, see the Microsoft article at https://docs
.microsoft.com/en‑us/sql/sql‑server/install/configure‑the‑windows‑firewall‑to‑allow‑sql‑
server‑access?redirectedfrom=MSDN&view=sql‑server‑ver15.

Logon failed for user ‘NT_AUTHORITY\ANONYMOUS LOGON’. This error message means that the
services are logged on incorrectly as .\administrator.

Resolution: Restart the services as local system user and restart the SQL services.
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Sessions are not recording

September 7, 2025

If application sessions arenot recording successfully, start by checking the applicationevent log in the
Event Viewer on the VDA for multi‑session OS that runs the Session Recording Agent and the Session
Recording Server. Doing so can provide valuable diagnostic information.

If sessions are not recording, the possible cause might be:

• Component connectivity and certificates. If the Session Recording components cannot com‑
municate with each other, session recording can fail. To troubleshoot recording issues, verify
that all components are configured correctly to point to the correct machines and that all cer‑
tificates are valid and correctly installed.

• Non‑Active Directory domain environments. Session Recording is designed to run in a Mi‑
crosoft Active Directory domain environment. If you are not running in an Active Directory en‑
vironment, you might experience recording issues. Ensure that all Session Recording compo‑
nents are running onmachines that are members of an Active Directory domain.

• Session sharing conflictswith the active policy. Session Recordingmatches the active policy
with the first published application that a user opens. Subsequent applications opened during
the samesession continue to follow thepolicy that is in force for the first application. Toprevent
session sharing from conflicting with the active policy, publish the conflicting applications on
separate VDAs for multi‑session OS.

• Recording isnotenabled. Bydefault, installing theSessionRecordingAgentonamulti‑session
OS VDA enables recording for the VDA. Recording does not occur until an active recording policy
is configured to allow it.

• The active recording policy does not permit recording. A session can be recorded onlywhen
the session meets the rules of the active recording policy.

• Session Recording services are not running. For sessions to be recorded, the Session Record‑
ing Agent servicemust be runningonaVDA formulti‑sessionOSand theSessionRecording Stor‑
age Manager service must be running on the machine hosting the Session Recording Server.

• MSMQ is not configured. If MSMQ is not correctly configured on the server running the Session
Recording Agent and the machine hosting the Session Recording Server, recording problems
might occur.

Unable to view live session playback

September 7, 2025
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If you experience difficulties when viewing recordings using the Session Recording Player, the follow‑
ing error message might appear:

Download of recorded session file failed. Live session playback is not permitted. The server
has been configured to disallow this feature. This error indicates that the server is configured to
disallow the action.

Resolution: In Session Recording Server Properties, choose the Playback tab and select the Allow
live session playback check box.

Recordings are corrupted or incomplete

September 7, 2025

• If recordings are corrupted or incomplete when you view them using the Session Recording
Player, youmight also see warnings in the Event logs on the Session Recording Server.

Event Source: Citrix Session Recording Storage Manager

Description: Data lost while recording file <icl file name>

The issue occurs when MCS or PVS is used to create VDAs with a master image configured and
Microsoft Message Queuing (MSMQ) installed. In this condition, the VDAs have the same QMId
for MSMQ.

As aworkaround, create a uniqueQMId for eachVDA. Formore information, see Install, upgrade,
and uninstall.

• The Session Recording Playermight report an internal error with themessage ‑ “The file being
playedhas reported that an internal systemerror (error code: 9) occurredduring its origi‑
nal recording. The file can still beplayedup to thepoint that the recordingerroroccurred”
when playing back a certain recording file.

The issue occurs due to insufficient buffer size on the Session Recording Agent when graphic
intensive sessions are recorded.

Asaworkaround, changeHKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\SmAudBufferSizeMB
to higher value data on the Session Recording Agent, and then restart the machine.

Verify component connections

September 7, 2025
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During the setup of Session Recording, the components might not connect to other components. All
the components communicate with the Session Recording Server (Broker). By default, the Broker (an
IIS component) is secured using the IIS default website certificate. If one component cannot connect
to the Session Recording Server, the other componentsmight also fail when attempting to connect.

The Session Recording Agent and the Session Recording Server (StorageManager andBroker) log con‑
nection errors in the applications event log in the Event Viewer of the machine hosting the Session
Recording Server. The Session Recording Policy Console and The Session Recording Player display
connection error messages on screen when they fail to connect.

Verify that the Session Recording Agent is connected

1. Log on to the server where the Session Recording Agent is installed.
2. From the Startmenu, choose Session Recording Agent Properties.
3. In Session Recording Agent Properties, click Connection.
4. Verify that the correct FQDN is entered in the Session Recording Server field.
5. Verify that the server given as the value for the Session Recording Server is accessible to your

VDA for multi‑session OS.

Note: Check the application event log for errors and warnings.

Verify that the Session Recording Server is connected

Caution:

UsingRegistryEditor cancauseseriousproblems thatmight require you to reinstall theoperating
system. Citrix® cannot guarantee that problems resulting from incorrect use of Registry Editor
can be solved. Use Registry Editor at your own risk.

1. Log on to the machine hosting the Session Recording Server.
2. Open the Registry Editor.
3. Browse to HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\SmartAuditor\Server.
4. Verify that theSmAudDatabaseInstance value correctly references theSessionRecordingData‑

base you installed on your SQL Server instance.

Verify that the Session Recording Database is connected

1. Using a SQL Management tool, open your SQL instance that contains the Session Recording
Database you installed.

2. Open the Security permissions of the Session Recording Database.
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3. Verify that the Session Recording Computer Account has access to the database. For example,
if the machine hosting the Session Recording Server is named SsRecSrv in the MIS domain,
the computer account in your database must be configured as MIS\SsRecSrv$. This value is
configured during the Session Recording Database installation.

Test IIS connectivity

Testing connections to the Session Recording Server IIS site by using a Web browser to access the
Session Recording Broker webpage can help you determine whether problems with communication
between Session Recording components stem from misconfigured protocol configuration, certifica‑
tion issues, or problems starting Session Recording Broker.

To verify IIS connectivity for the Session Recording Agent:

1. Log on to the server where the Session Recording Agent is installed.
2. Open a Web browser and type the following address:

• ForHTTPS:https://servername/SessionRecordingBroker/RecordPolicy
.rem?wsdl, where servername is the name of the machine hosting the Session
Recording Server.

• For HTTP: http://servername/SessionRecordingBroker/RecordPolicy.
rem?wsdl, where servername is the name of themachine hosting the Session Record‑
ing Server.

3. If you are prompted for NT LANManager (NTLM) authentication, log on with a domain adminis‑
trator account.

To verify IIS connectivity for the Session Recording Player:

1. Log on to the workstation where the Session Recording Player is installed.
2. Open a Web browser and type the following address:

• For HTTPS: https://servername/SessionRecordingBroker/Player.rem?
wsdl, where servername is the name of the machine hosting the Session Recording
Server

• For HTTP: http://servername/SessionRecordingBroker/Player.rem?
wsdl, where servername is the name of the machine hosting the Session Recording
Server

3. If you are prompted for NT LANManager (NTLM) authentication, log on with a domain adminis‑
trator account.

To verify IIS connectivity for the Session Recording Policy Console:

1. Log on to the server where the Session Recording Policy Console is installed.
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2. Open a Web browser and type the following address:

• ForHTTPS:https://servername/SessionRecordingBroker/PolicyAdministration
.rem?wsdl, where servername is the name of the machine hosting the Session
Recording Server

• ForHTTP:http://servername/SessionRecordingBroker/PolicyAdministration
.rem?wsdl, where servername is the name of the machine hosting the Session
Recording Server

3. If you are prompted for NT LANManager (NTLM) authentication, log on with a domain adminis‑
trator account.

If you see an XML document within your browser, it verifies that the machine running the Session
Recording Policy Console is connected to the machine hosting the Session Recording Server using
the configured protocol.

Troubleshoot certificate issues

If you are using HTTPS as your communication protocol, the machine hosting the Session Recording
Servermust be configuredwith a server certificate. All component connections to the SessionRecord‑
ing Server must have root certificate authority (CA). Otherwise, attempted connections between the
components fail.

You can test your certificates by accessing the Session Recording Broker webpage as youwould when
testing IIS connectivity. If you are able to access the XML page for each component, the certificates
are configured correctly.

Here are some common ways certificate issues cause connections to fail:

• Invalid or missing certificates. If the server running the Session Recording Agent does not
have a root certificate to trust the server certificate and cannot trust and connect to the Session
Recording Server over HTTPS, causing connectivity to fail, verify that all components trust the
server certificate on the Session Recording Server.

• Inconsistent naming. If the server certificate assigned to the machine hosting the Session
Recording Server is created using an FQDN, all connecting components must use the FQDN
when connecting to the Session Recording Server. If a NetBIOS name is used, configure the
components with a NetBIOS name for the Session Recording Server.

• Expiredcertificates. If a server certificateexpired, connectivity to theSessionRecordingServer
through HTTPS fails. Verify the server certificate assigned to the machine hosting the Session
Recording Server is valid and has not expired. If the same certificate is used for the digital sign‑
ing of session recordings, the event log of the machine hosting the Session Recording Server
provides error messages that the certificate expired or warning messages when it is about to
expire.
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Search for recordings using the Player fails

December 8, 2021

If you experience difficulties when searching for recordings using the Session Recording Player, the
following error messages might appear:

• Search for recorded session files failed. The remote server name could not be resolved:
servername. The servername is the name of the server towhich the Session Recording Player
is attempting to connect. The Session Recording Player cannot contact the Session Recording
Server. Two possible reasons are an incorrectly typed server name or that the DNS cannot re‑
solve the server name.

Resolution: From the Player menu bar, choose Tools > Options > Connections and verify that
the servername in theSessionRecordingServers list is correct. If it is correct, fromacommand
prompt, run the ping command to see if the name canbe resolved. When the SessionRecording
Server is down or offline, the search for recorded session files failed errormessage isUnable to
contact the remote server.

• Unable to contact the remote server. This error occurs when the Session Recording Server is
down or offline.

Resolution: Verify that the Session Recording Server is connected.

• Access denied. An access denied error can occur if the user was not given permission to search
for and download recorded session files.

Resolution: Assign the user to the Player role using the Session Recording Authorization Con‑
sole.

• Access denied when the Player role is assigned. This error occurs when you install the Ses‑
sion Recording Player on the same machine with the Session Recording Server, and you have
enabled UAC. When you assign the Domain Admins or Administrators user group as the Player
role, a non‑built‑in administrator user included in that group might fail to pass the role‑based
check when searching recordings in the Session Recording Player.

Resolutions:

• Run the Session Recording Player as an administrator.

• Assign specific users as the Player role rather than the entire group.

• Install the Session Recording Player in a separate machine rather than Session Recording
Server.

• Search for recorded session files failed. The underlying connectionwas closed. Could not
establish a trust relationship for the SSL/TLS secure channel. The error occurs when the
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Session Recording Server uses a certificate that is signed by a CA that the client device does not
trust or have a CA certificate for.

Resolution: Install the correct or trustedCA certificateworkstationwhere theSessionRecording
Player is installed.

• The remote server returned an error: (403) forbidden. This error is a standard HTTPS error
that occurs when you attempt to connect using HTTP (nonsecure protocol). The server rejects
the connection because, by default, it is configured to accept only secure connections.

Resolution: From the Session Recording Playermenu bar, choose Tools >Options > Connec‑
tions. Select the server from the SessionRecording Servers list, and clickModify. Change the
protocol fromHTTP toHTTPS.

Troubleshoot MSMQ

If a notification message is given but the viewer cannot find recordings after a search in the Session
Recording Player, there is a problem with MSMQ. Verify that the queue is connected to the Session
Recording Server (StorageManager). Use aWeb browser to test for connection errors (if you are using
HTTP or HTTPS as your MSMQ communication protocol).

To verify that the queue is connected:

1. Log on to the server hosting the Session Recording Agent and view the outgoing queues.

2. Verify that the queue to the machine hosting the Session Recording Server has a connected
state.

• If the state is waiting to connect, there are messages in the queue, and the protocol is
HTTP or HTTPS (corresponding to the protocol selected on the Connections tab in Ses‑
sion Recording Agent Properties), perform Step 3.

• If the state is connectedand therearenomessages in thequeue, theremightbeaproblem
with the server hosting the Session Recording Server. Skip Step 3 and perform Step 4.

3. If there are messages in the queue, open a Web browser and type the following address:

• For HTTPS: https://servername/msmq/private$/CitrixSmAudData, where
servername is the name of the machine hosting the Session Recording Server.

• For HTTP: http://servername/msmq/private$/CitrixSmAudData, where
servername is the name of the machine hosting the Session Recording Server.

If the page returns an error such as The server only accepts secure connections, change the
MSMQ protocol listed in Session Recording Agent Properties to HTTPS. If the page reports a
problemwith thewebsite security certificate, theremight be aproblemwith a trust relationship
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for the TLS secure channel. In that case, install the correct CA certificate or use a CA that is
trusted.

4. If there are no messages in the queue, log on to the machine hosting the Session Recording
Server and view private queues. Select citrixsmauddata. If there are messages in the queue
(Number of Messages Column), verify that the Session Recording StorageManager service is
started. If it is not, restart the service.

Manage your database records

September 7, 2025

The ICA Log database (ICLDB) utility is a database command‑line utility used to manipulate the ses‑
sion recording database records. This utility is installed, during the Session Recording installation, to
the drive:\Program Files\Citrix\SessionRecording\Server\Bin folder on the server
hosting the Session Recording Server.

Quick reference chart

The following table lists the commands and options that are available for the ICLDB utility. Type the
commands using the following format:

icldb [version | locate | dormant | import | archive | remove |
removeall] command-options [/l] [/f] [/s] [/?]

Note:

More extensive instructions are available in the help associated with the utility. To access the
help, from a command prompt, type the drive:
\Program Files\Citrix\SessionRecording\Server\Bin folder, and type
icldb /?. To access help for specific commands, type
icldb *command* /?.
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Command Description

archive Archives the session recording files older than
the retention period specified. Use this
command to archive recordings and events in
the recordings. The events are archived in the
ArchivedEvent database table.

dormant Displays or counts the session recording files
that are considered dormant. Dormant files are
session recordings that were not completed due
to data loss. Use this command to verify if you
suspect that you are losing data. You can check
whether the session recording files are
becoming dormant for the entire database, or
only recordings made within the specified
number of days, hours, or minutes.

import Imports session recording files to the Session
Recording database. Use this command to
rebuild the database if you lose database
records. Also, use this command tomerge
databases (if you have two databases, you can
import the files from one of the databases).

locate Locates and displays the full path to a session
recording file using the file ID as the criteria. Use
this command when you are looking for the
storage location of a session recording file. It is
also one way to verify if the database is
up‑to‑date with a specific file.

remove Removes the references to session recording
files from the database. Use this command (with
caution) to clean up the database. Specify the
retention period to be used as the criteria. You
can also remove the associated physical file.
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Command Description

removeall Removes all references to session recording files
from the Session Recording Database and
returns the database to its original state. The
actual physical files are not deleted; however,
you cannot search for these files in the Session
Recording Player. Use this command (with
caution) to clean up the database. Deleted
references can be reversed only by restoring
from your backup.

version Displays the Session Recording Database
schema version.

/l Logs the results and errors to the Windows event
log.

/f Forces the command to run without prompts.

/s Suppresses the copyright message.

/? Displays help for the commands.

Archive session recording files

Tomaintainanadequate levelof sparediskcapacity in the recordingstorage locations, archive session
recording files regularly. Depending on the amount of disk space available and the typical size of
session recording files, archiving intervals differ. Session recording files must be older than two days
from the start date before a session recording file can be archived. This rule is to prevent any live
recordings from being archived before they become complete.

Two methods are available when you archive session recordings. The database record for a session
recording file can be updated to have a status of archived while the session recording file remains
in the recording storage location. This method can be used to reduce the search results in the Player.
The othermethod is to update the database record for a session recording file to the status of archived
and also move the session recording file from the recording storage location to another location for
backup to alternativemedia. When the ICLDButilitymoves session recording files, the files aremoved
to the specified directorywhere the original file folder structure of year/month/day no longer exists.

The session recording record in the Session Recording Database contains two fields associated with
archiving: the archive time representing the current date and time a session recording was archived;
the archive note, anoptional text note thatmight be addedby the administrator during archiving. The
two fields indicate a session recording has been archived and the time of archiving.
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In the Session Recording Player, any archived session recordings show a status of Archived and the
date and timeof archiving. Session recordings that havebeen archivedmight still be played if the files
have not beenmoved. If a session recording file was moved during archiving, a file not found error is
displayed. The session recording file must be restored before the session can be played. To restore a
session recording, provide the administratorwith the File ID andArchiveTimeof the session recording
from the recording Properties dialog box in the Session Recording Player. Restoring archived files is
discussed further in the following Restore session recording files section.

The archive command of the ICLDB utility has several parameters that are described as follows:

• /RETENTION:<days> ‑ The retention period in days for session recordings. Recordings older
than the number of days specified are marked as archived in the Session Recording Database.
The retention period must be an integer number greater than or equal to 2 days.

• /LISTFILES –Lists the full pathand file nameof session recording files as theyarebeingarchived.
This parameter is optional.

• /MOVETO:<directory> ‑ Thedirectory towhich youphysicallymove archived session recording
files. The specified directory must exist. This parameter is optional. If no directory is specified,
files remain in their original storage location.

• /NOTE:<note> ‑ A text note that is added to the database record for each session recording
archived. Ensure that the note is enclosed with double quotes. This parameter is optional.

• /L –Logs the results and errors to theWindows event log of the number of session recording files
archived. This parameter is optional.

• /F –Forces the archive command to run without prompts. This parameter is optional.

To archive session recordings in the Session Recording Database and physically move session
recording files

1. Log on to the server where the Session Recording Server is installed as a local administrator.

2. Start a command prompt.

3. Change from the current working directory to the Bin directory of the Session Recording Server
installation path (<Session Recording Server Installation Path>/Server/
Bin).

4. Run theICLDB ARCHIVE /RETENTION:<days> /LISTFILES /MOVETO:<directory
> /NOTE:<note> /L command where days is the retention period for session recording
files, directory is the directorywhere archived session recording files aremoved to, and note is
the text note that is added to the database record for each session recording file being archived.
Enter Y to confirm the archive.
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To only archive session recordings in the Session Recording Database

1. Log on to the server where the Session Recording Server is installed as a local administrator.

2. Start a command prompt.

3. Change from the current working directory to the Bin directory of the Session Recording Server
installation path (<Session Recording Server Installation Path>/Server/Bin).

4. Run the ICLDB ARCHIVE /RETENTION:<days> /LISTFILES /NOTE:<note> /L
command where days is the retention period for session recordings and note is the text note
that is added to the database record for each session recording being archived. Enter Y to
confirm the archive.

Restore session recording files

Restoration of session recording files is required when you want to view a session recording that was
archived in the Session Recording Database and the file has been moved from the recording storage
location. Archived session recordings thatwere notmoved from the recording storage locationduring
archiving are still accessible in the Session Recording Player.

Two methods are available for restoring session recording files that have been moved. Copy the re‑
quired session recording file to the restore directory for archived files, or import the required session
recording file back to the Session Recording Database by using the ICLDB utility. Citrix® recommends
the first method for restoring archived session recording files. Remove archived files copied to the
restore directory for archived files when you no longer need them.

TheSessionRecordingBroker utilizes theRestoredirectory for archived fileswhena session record‑
ing file is not found in its original storage location. This caseoccurswhen theSessionRecordingPlayer
requests a session recording file for playback. The Session Recording Broker first attempts to find the
session recording file in the original storage location. If the file is not found in the original storage loca‑
tion, the Session Recording Broker then checks the Restore directory for archived files. If the file is
present in the restore directory, the Session Recording Broker sends the file to the Session Recording
Player for playback. Otherwise, if the file is not found, the Session Recording Broker sends a file not
found error to the Session Recording Player.

Importing archived session recording files by using the ICLDB utility updates the Session Recording
Database with session recording information from the session recording file, including a new storage
path for the session recording file. Using the ICLDB utility to import an archived session recording file
does not move the file back to the original storage location when the session was recorded.

Note: An imported session recording file has the archive time and archive note cleared in the Session
Recording Database. Therefore, the next time the ICLDB archive command is run, the imported
session recording file might become archived again.
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The ICLDB import command is useful to import a large number of archived session recording files,
repair, or update incorrect and missing session recording data in the Session Recording Database, or
move session recording files from one storage location to another storage location on the Session
Recording Server. The ICLDB import command can also be used to repopulate the Session Recording
Database with session recordings after running the ICLDB removeall command.

The import command of the ICLDB utility has several parameters that are described as follows:

• /LISTFILES –Lists the full path and file name of session recording files while they are being im‑
ported. This parameter is optional.

• /RECURSIVE –Searches all subdirectories for session recording files. This parameter is optional.

• /L –Logs the results and errors to the Windows event log the number of session recording files
imported. This parameter is optional.

• /F –Forces the import command to run without prompts. This parameter is optional.

To restore session recording files by using the restore directory for archived files

1. Log on to the server where the Session Recording Server is installed as a local administrator.

2. In Session Recording Player Properties, determine the File ID and Archive Time of the archived
session recording file.

3. Locate the session recording file in your backups using the File ID specified in SessionRecording
Player Properties. Each session recording has a file name of i_<FileID>.icl, where FileID
is the ID of the session recording file.

4. Copy the session recording file from your backup to the restore directory for archived files. To
determine the restore directory for archived files:

a) From the Startmenu, choose Start > All Programs > Citrix > Session Recording Server
Properties.

b) In Session Recording Server Properties, select the Storage tab. The current restore direc‑
tory appears in the Restore directory for archived files field.

To restore session recording files by using the ICLDB import command

1. Log on to the server where the Session Recording Server is installed as a local administrator.

2. Start a command prompt.

3. Change from the current working directory to the Bin directory of the Session Recording Server
installation path (<Session Recording Server Installation Path>/Server/
Bin).
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4. Either:

• Run the ICLDB IMPORT /LISTFILES /RECURSIVE /L <directory> com‑
mand where directory is the name of one or more directories, separated by a space
containing session recording files. Enter Y to confirm the import.

• Run theICLDB IMPORT /LISTFILES /L <file> commandwhere file is the name
of one or more session recording files, separated by a space. Wildcards might be used to
specify session recording files. Enter Y to confirm the import.

Best practices

December 8, 2021

You can consult the following best practices documentation for deploying Session Recording and con‑
figuring load balancing:

• Configure load balancing in an existing deployment
• Deploy and load‑balance Session Recording in Azure

Configure load balancing in an existing deployment

September 7, 2025

This article guides you through the process of adding load balancing nodes using Citrix ADC in an
existing Session Recording deployment. The following servers are used as an example throughout
the process. You can also deploy and load‑balance Session Recording in Azure.

• Session Recording

Host Name Server Role OS IP Address

SRServer1 Session Recording
Server

Windows Server 10.63.32.55

LBDC Domain controller Windows Server 10.63.32.82

TSVDA Session Recording
Agent

Windows Server 10.63.32.215
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Host Name Server Role OS IP Address

SRSQL Session Recording
Database and the file
server

Windows Server 10.63.32.91

All SessionRecording components and thedomain controller share adomain, for example,lb.
com. The domain administrator account, for example, lb\administrator, is used for server logon.

• Citrix ADC

Host Name Server Role
Management IP
Address (NSIP)

Subnet IP Address
(SNIP)

Netscaler Citrix ADC VPX instance 10.63.32.40 10.63.32.109

For more information, see Deploy a Citrix ADC VPX instance.

Step 1: Create shared folders on the file server

1. Log on to the file server by using a domain administrator account, for example, lb\
administrator.

2. Create a folder to store recordings and name the folder SessionRecording, for example, C
:\SessionRecording. Share theRead/Writepermissionof the folderwithaSessionRecord‑
ing Server. Using SRServer1 as an example, type LB\SRSERVER1$. The dollar sign $ is re‑
quired.
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3. Create a subfolderwithin theSessionRecording folder and name the subfoldershare, for
example, C:\SessionRecording\share.

4. Createanother folder to restorearchived recordingsandnamethe folderSessionRecordingsRestored
, for example, C:\ SessionRecordingsRestored. Share the Read/Write permission
of the folder with a Session Recording Server. Using SRServer1 as an example, type
LB\SRSERVER1$. The dollar sign $ is required.

5. Create a subfolder within the SessionRecordingsRestored folder and name the
subfolder share, for example, C:\ SessionRecordingsRestored\share.

© 1997–2025 Citrix Systems, Inc. All rights reserved. 202



Session Recording 2110

Step 2: Configure an existing Session Recording Server to support load balancing

This step describes how to configure an existing Session Recording Server to support load balancing.
Step7details theprocedureof addingmoreSessionRecordingServers to your existingdeployment.

1. Log on to a Session Recording Server by using a domain administrator account.

2. Open Session Recording Server Properties.

3. Add the Universal Naming Convention (UNC) paths created in Step 1 to store and restore
recording files, in this example, \\SRSQL\SessionRecording\share and \\SRSQL\
SessionRecordingRestored\share. SRSQL is the host name of the file server.
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Note:

The SessionRecording Player cannot play files under a path that contains a drive letter or a
dollar sign ($) unless you install the player and the Session Recording Server on the same
machine.

4. Add a value to the Session Recording Server registry key at HKEY_LOCAL_MACHINE\
SOFTWARE\Citrix\SmartAuditor\Server.

Value name: EnableLB
Value data: 1 (D_WORD, meaning enable)
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5. Restart the Citrix Session Recording Storage Manager service.

Step 3: Configure load balancing in Citrix ADC

There are twoways to configure load balancing in Citrix ADC ‑ TCP passthrough and SSL offloading.

Configure load balancing through TCP passthrough

The following topologies show how to configure load balancing through TCP passthrough.

• If you are using the Python‑based WebSocket server (Version 1.0):
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• If you are using the WebSocket server hosted in IIS (Version 2.0):

To configure load balancing through TCP passthrough, complete the following steps:

1. Log on to your Citrix ADC VPX instance.

2. Navigate to Configuration > System > Settings > Configure Basic Features.
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3. Select Load Balancing and clickOK.

4. Add load balancing servers.

Navigate to Traffic Management > Load Balancing > Servers and click Add.
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Type thenameand IP address of a SessionRecordingServer and then clickCreate. For example:

Click the save icon in the upper right corner to save your changes.
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5. For WebSocket server Version 1.0, add load balancing services of ports 80, 1801, 22334, and
443 for each Session Recording Server. For WebSocket server Version 2.0, add load balancing
services of ports 80, 1801, and 443 for each Session Recording Server.

Navigate to Traffic Management > Load Balancing > Services and click Add.

Type a name for each load balancing service you add. Choose Existing Server, select the IP
address of your target Session Recording Server, select TCP as the server protocol, and type a
port number. ClickOK.
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Bind the TCP protocol monitor to each load balancing service.
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Click the save icon in the upper right corner to save your changes.

Tip:

The load balancing service of port 22334 is required only for WebSocket server Version 1.0.

6. Add load balancing virtual servers.

For WebSocket server Version 1.0, complete the following steps to add load balancing virtual
servers of ports 80, 443, 1801, and 22334. ForWebSocket server Version 2.0, add load balancing
virtual servers of ports 80, 443, and 1801. For example:
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Navigate to Traffic Management > Load Balancing > Virtual Servers and click Add.

Add each virtual server with the Citrix ADC VIP address based on the TCP protocol.
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Bind each virtual server to the load balancing service of the same port. For example:
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Choose a load balancing method.
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Configure persistence on each virtual server. We recommend you select SOURCEIP as the per‑
sistence type. For more information, see Persistence settings.
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7. Create a host record for the Citrix ADC VIP address on the domain controller.
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8. To access the web player over HTTPS, ensure that a SAN certificate is available both on Citrix
ADC and on each Session Recording Server. A SAN certificate contains the FQDNs of the Citrix
ADC and of each Session Recording Server.

Configure load balancing through SSL offloading

The following topologies show how to configure load balancing through SSL offloading.

• If you are using the Python‑based WebSocket server (Version 1.0):
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• If you are using the WebSocket server hosted in IIS (Version 2.0):

1. Log on to your Citrix ADC VPX instance.
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2. Navigate to Configuration > System > Settings > Configure Basic Features.

3. Select SSL Offloading and Load Balancing and clickOK.

4. Add load balancing servers.

Navigate to Traffic Management > Load Balancing > Servers and click Add.
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Type thenameand IP address of a SessionRecordingServer and then clickCreate. For example:

Click the save icon in the upper right corner to save your changes.
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5. Add load balancing services for each Session Recording Server you added in the previous step.

Add the following load balancing services for each Session Recording Server:

• (Required only when you are using the WebSocket server Version 1.0) SSL load balancing
service of port 22334 that binds to the TCPmonitor

• SSL load balancing service of port 443 that binds to the HTTPSmonitor
• TCP load balancing service of port 1801 that binds to the TCPmonitor

For example:

Navigate to Traffic Management > Load Balancing > Services and click Add.
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(Required only when you are using the WebSocket server Version 1.0) Add an SSL load
balancing service of port 22334 for each Session Recording Server. Type a name for the
load balancing service, choose Existing Server, select the IP address of a Session Recording
Server, select SSL as the server protocol, type port number 22334, and clickOK.

For example, see the following screen capture.

Bind the TCPmonitor to the SSL load balancing service you just added.
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Add an SSL load balancing service of port 443 for each Session Recording Server. Type a
name for the load balancing service, choose Existing Server, select the IP address of a Session
Recording Server, select SSL as the server protocol, type port number 443, and clickOK.
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Bind the HTTPSmonitor to the SSL load balancing service you just added.
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Add a TCP load balancing service of port 1801 for each Session Recording Server. Type a
name for the load balancing service, choose Existing Server, select the IP address of a Session
Recording Server, select TCP as the server protocol, type port number 1801, and clickOK.
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Bind the TCPmonitor to the TCP load balancing service you just added.
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6. (Required only when you are using the WebSocket server Version 1.0) Add an HTTP profile for
each SSL load balancing service of port 22334.

Navigate to System > Profiles > HTTP Profiles and click Add.
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Select the Enable WebSocket connections check box and accept the other default settings.
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Type a name for the HTTP profile, for example, websocket_SSL.

Go back to each SSL load balancing service of port 22334, for example, srv-1-22334. Click +
Profiles.
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Select the HTTP profile, for example, websocket_SSL, and clickOK and then Done.

7. (Required only when you are using the WebSocket server Version 2.0) Add an HTTP profile for
each SSL load balancing service of port 443.

8. Create a host record for the Citrix ADC VIP address on the domain controller.

© 1997–2025 Citrix Systems, Inc. All rights reserved. 230



Session Recording 2110

9. Add load balancing virtual servers.

Add the following load balancing virtual servers with the Citrix ADC VIP address.

• (Required only when you are using the WebSocket server Version 1.0) load balancing vir‑
tual server of port 22334 based on SSL

• load balancing virtual server of port 443 based on SSL
• load balancing virtual server of port 1801 based on TCP

For example, see the following screen capture.

Navigate to Traffic Management > Load Balancing > Virtual Servers and click Add.
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Add each virtual server with the Citrix ADC VIP address. Type a server name, select TCP or SSL,
and select the relevant port number as described earlier.

Bind each virtual server to the load balancing service of the same port. For example:
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Tip:

The load balancing service of port 22334 is required only when you are using the Web‑
Socket server Version 1.0.

Choose a load balancing method.
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Configure persistence on each virtual server. We recommend you select SOURCEIP as the per‑
sistence type. For more information, see Persistence settings.
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(Required only when you are using the WebSocket server Version 1.0) Add an HTTP profile for
the load balancing virtual server of port 22334.

10. Install a Subject Alternative Name (SAN) certificate in Citrix ADC.

Obtain a SAN certificate in PEM format from a trusted Certificate Authority (CA). Extract and up‑
load the certificate and private key files in Citrix ADC by navigating to Traffic Management >
SSL > Server Certificate Wizard.

For more information, see SSL certificates.
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11. Bind a SAN certificate to each SSL load balancing virtual server.

Navigate to Traffic Management > Load Balancing > Virtual Servers, select an SSL load bal‑
ancing virtual server, and click Server Certificate.
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Add the previously mentioned SAN certificate and click Bind.

Step 4: Configure an existing Session Recording Agent to support load balancing

1. Log on to the Session Recording Agent by using a domain administrator account.

2. Open Session Recording Agent Properties.

3. Complete this step if you use Microsoft Message Queuing (MSMQ) over TCP.

© 1997–2025 Citrix Systems, Inc. All rights reserved. 237



Session Recording 2110

Type the FQDN of your Citrix ADC VIP address in the Session Recording Server box.

On each Session Recording Server, add and set the IgnoreOSNameValidation
DWORD value to 1 under HKEY_LOCAL_MACHINE\ SOFTWARE\Microsoft\MSMQ\
Parameters.

4. Complete this step if you use MSMQ over HTTP or HTTPS.

(Skip if this step is done) Create a host record for the Citrix ADC VIP address on the domain con‑
troller.
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OneachSessionRecordingServer, run thepowershell.exe -file SrServerConfigurationSync
.ps1 –Action AddRedirection – ADCHost <ADCHost> command to add redirec‑
tions fromCitrix ADC to the local host. <ADCHost> is the FQDN of the Citrix ADC VIP address. A
redirection file, for example,sr_lb_map.xml is generated underC:\Windows\System32
\msmq\Mapping.

Note: Change to the folder where SrServerConfigurationSync.ps1 resides when you
run PowerShell.exe.

Type the FQDN of your Citrix ADC VIP address in the Session Recording Server box. For exam‑
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ple:

Step 5: Configure an existing Session Recording Player to support load balancing

On each machine where you installed the Session Recording Player component, add the Citrix ADC
VIP address or its FQDN as the connected Session Recording Server.

Step 6: Check whether load balancing works for the configured, existing Session
Recording Server

1. Launch a Citrix virtual session.
2. Check whether the session can be recorded.
3. Check whether the web player and the Session Recording Player can play back the recording

file.

Step 7: Addmore Session Recording Servers

1. Prepare a machine in the same domain and install only the Session Recording Server and Ses‑
sion Recording Administrator Logging modules on the machine.
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2. Use the same database names as the existing Session Recording Server. For example:
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3. Disable the network firewall on the machine.

4. On the SQL Server where you installed the Session Recording Database, add all the Session
Recording Servermachine accounts to the shared SessionRecordingDatabase and assign them
with the db_owner permission. For example:
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5. Share the Read/Write permission of the recording storage and restore folders, for example,
SessionRecording and SessionRecordingsRestored, with the machine account
of the new Session Recording Server, for example, LB\SRServer2$. The dollar sign $ is
required.

6. Repeat Step 3 to add load balancing services for the new Session Recording Server and edit
existing virtual servers to add bindings to the load balancing services. There is no need to add
more virtual servers. For example:

© 1997–2025 Citrix Systems, Inc. All rights reserved. 244

https://docs.citrix.com/en-us/session-recording/2110/best-practices/configure-load-balancing-in-an-existing-deployment.html#step-3-configure-load-balancing-in-citrix-adc


Session Recording 2110

© 1997–2025 Citrix Systems, Inc. All rights reserved. 245



Session Recording 2110

© 1997–2025 Citrix Systems, Inc. All rights reserved. 246



Session Recording 2110

7. Copy theSessionRecordingAuthorizationConsoleconfiguration file,SessionRecordingAzManStore
.xml, from the existing Session Recording Server to the new Session Recording Server. The
file lives in <Session Recording Server installation path>\App_Data.

8. TouseMSMQoverHTTPorHTTPS for thenewSessionRecordingServer, complete the following
steps to import registry settings of the currently functioning Session Recording Server.

On the existing Session Recording Server, for example, SRServer1, run the powershell
.exe -file SrServerConfigurationSync.ps1 –Action Export – ADCHost
<ADCHost > command, where <ADCHost> is the FQDN of the Citrix ADC VIP address. An

exported registry file, SrServerConfig.reg, is generated.

Copy the SrServerConfig.reg file to the new Session Recording Server and run the
powershell.exe -file SrServerConfigurationSync.ps1 –Action Import
,AddRedirection – ADCHost <ADCHost> command. The EnableLB value is added
to the registry key of the new Session Recording Server at HKEY_LOCAL_MACHINE\
SOFTWARE\Citrix\SmartAuditor\Server and a sr_lb_map.xml file is added
under C:\Windows\System32\msmq\Mapping.

9. Repeat the procedure to add another Session Recording Server.
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Troubleshoot

• Sessions are not recording when you use a CNAME record or an ALIAS record for a Session
Recording Server. To address this issue, see the Microsoft documentation.

• Recording files can be stored locally but cannot be stored in a Universal Naming Convention
(UNC) path. To address this issue, change the startmodeof theCitrix SessionRecording Storage
Manager service to Automatic (Delayed Start).

Deploy and load‑balance Session Recording in Azure

December 26, 2025

Prerequisites

• You already have Citrix Virtual Apps and Desktops™ installed in Azure.
• You have an Azure account.

Step 1: Upload the Citrix Virtual Apps™ and Desktops installer to Azure

Note:

Skip Step 1 if you use your Citrix account credentials to access the Citrix Virtual Apps and Desk‑
tops download page and download the product ISO file to a VM in Azure.

1. In the Azure portal, create a general‑purpose v2 storage account and accept the default perfor‑
mance tier, Standard.

All access to Azure Storage goes through a storage account.
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2. Navigate to your new storage account and select Containers in the Blob service section to cre‑
ate a container.
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3. Upload the Citrix Virtual Apps and Desktops installer to the container.

Step 2: Create a SQLmanaged instance in the Azure portal

For more information, see Create an Azure SQL Managed Instance.

Step 3: Create Azure virtual machines (VMs)

ChooseWindows Server 2019 Datacenter –Gen1 for the image and Standard_D4as_v4 –4 vcpus,
16GiBmemory for the size. Formore information, see Create aWindows virtualmachine in the Azure
portal.
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Step 4: Remote desktop and download the Citrix Virtual Apps and Desktops installer to
the Azure VMs

Step 5: Run the installer to install Session Recording components on the Azure VMs

For more information, see Install the Session Recording Administration components.

Step 6: Configure an Azure file share to store recordings

To create an Azure file share to store recordings, complete the following steps:

1. In the Azure portal, create a storage account and then create an Azure file share.

For a quick start guide, see Create and manage Azure file shares with the Azure portal. The
following table recommends configurations for your consideration.

Recording File
Size MB/hour

Number of
Recorded
Sessions Per
Day

File Share
Type

File Share
Quota (TB)

Session
Recording
Server
Quantity

Session
Recording
Server Size

< 6.37 < 1,000 HDD Standard
(StorageV2)

2 1 Standard
D4as_v4

< 6.37 1,000–2,000 SSD Premium 3 1 Standard
D4as_v4
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Recording File
Size MB/hour

Number of
Recorded
Sessions Per
Day

File Share
Type

File Share
Quota (TB)

Session
Recording
Server
Quantity

Session
Recording
Server Size

< 6.37 2,000–3,000 SSD Premium 5 1 Standard
D4as_v4

< 6.37 3,000–4,000 SSD Premium 6 1 Standard
D4as_v4

Approx.10 < 1,000 HDD Standard
(StorageV2)

3 1 Standard
D4as_v4

Approx.10 1,000–2,500 SSD Premium 6 1 Standard
D4as_v4

Approx.10 2,500–4,000 SSD Premium 10 2 Standard
D4as_v4

The file share quota is calculated based on eight hours per day, 23working days permonth, and
a one‑month retention period for each recording file.

2. Add the Azure file share credentials to the host where you installed the Session Recording
Server.

a) Start a command prompt as an administrator and change the drive to the <Session
Recording Server installation path>\Bin folder.

By default, the Session Recording Server is installed in C:\Program Files\Citrix\
SessionRecording\Server.

b) Run the SsRecUtils.exe ‑AddAzureFiles <storageAccountName> <fileShareName>
<accesskey> command.

Where,

• <storageaccountname> is the name of your storage account in Azure.
• <filessharename> is the name of the file share contained within your storage
account.

• <accesskey> is your storage account key that can be used to access the file share.

There are two ways to obtain your storage account key:

• You can obtain your storage account key from the connection string that appears
when you click the Connect icon in your file share page.
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• You can also obtain your storage account key by clicking Access keys in the left navi‑
gation of your storage account page.

© 1997–2025 Citrix Systems, Inc. All rights reserved. 254



Session Recording 2110

c) Mount the Azure file share to the host where you installed the Session Recording Server.

i. Open Session Recording Server Properties.

ii. Click Add on the Storage tab.

iii. Enter theUNCpath in the formatof \\<storageaccountname>.file.core.windows.net\<filessharename>\<subfolder>.

Specify a subfolder under the file share to store your recording files. The Session
Recording Server then automatically creates the subfolder for you.
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iv. ClickOK in the File Storage Directory dialog box.

v. Click Apply in the Session Recording Server Propertieswindow.

vi. ClickOK after Apply becomes grayed out.

vii. Click Yes when you are prompted to restart the Session Recording Storage Manager
service.

Step 7: Add a load balancer

If there is more than one Session Recording Server, we recommend you add a load balancer in front
of them. Azure offers many options to load‑balance traffic requests. This section walks you through
the process of creating Citrix ADC, Azure Load Balancer, and Azure Application Gateway in Azure.
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Option 1: Create a Citrix ADC VPX instance in Azure

1. In the Azure portal, type Citrix ADC in the search box.

2. Choose the Citrix ADC VPX Bring Your Own License plan and then click Create.

3. Select or create a resource group and set the other settings on the Basics tab.

4. Set VM configurations.
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5. Check and modify network settings if necessary. Choose ssh (22), http (80), https (443) for
public inbound ports.

A virtual network is automatically created. If youalreadyhaveaSessionRecording environment
installed, you can use its virtual network and server subnet settings.
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6. Click Next: Review + create to create the Citrix ADC VPX instance and wait for the deployment
to complete.
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7. Set the subnet IP (SNIP) address and the Citrix ADC VIP address to be on the same subnet.

The SNIP address and the VIP address must be on the same subnet. In this example, we set the
VIP address to be on the subnet of the SNIP address.

a) Stop the citrix‑adc‑vpx virtual machine.

b) Change the subnet of the VIP address.
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c) Start the citrix‑adc‑vpx virtual machine

Option 2: Create an Azure load balancer

Azure Load Balancer is a TCP passthrough service. The following diagram shows load balancing
through TCP passthrough.
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1. Create an Azure load balancer.

a) Search in the Azure portal and select Load Balancers from theMarketplace.

On theBasics tab of theCreate loadbalancerpage, configure settings as described in the
following table:

Setting Value

Subscription Select your subscription.

Resource group For example, select srlbtest created earlier.

Name Enter SRLoadBalance.

Region Select (US) East US.

Type Select Internal.

SKU Select Standard
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Setting Value

Virtual network For example, select srazureautovnet created
earlier.

Subnet For example, select srazureautosubnet created
earlier.

IP address assignment Select Dynamic.

Availability zone Select Zone‑redundant.

b) Add loadbalancer resources, includingaback‑endpool, healthprobes, and loadbalancing
rules.

• Add a back‑end pool.
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Select the load balancer you created from the resources list and click Backend pools
in the left navigation. Click Add to add a back‑end pool.

Enter a name for the new back‑end pool and then click Add.
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• Add health probes.
Select the load balancer you created from the resources list and then click Health
probes in the left navigation.

Click Add to add health probes on ports 80, 22334, 1801, and 443.

For example, use the following settings to create a health probe on port 80.

Setting Value

Name Enter SRHealthProbe80.
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Setting Value

Protocol Select TCP.

Port Enter 80.

Interval 5

Unhealthy threshold Select 2 for the number of unhealthy threshold
or consecutive probe failures that must occur
before a VM is considered unhealthy.

• Add a load balancing rule.
Select the load balancer you created from the resources list and then click Load bal‑
ancing rules in the left navigation. Click Add to add a load balancing rule.
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Click Add to add load balancing rules for ports 80, 22334, 1801, and 443.

For example, use the following settings to create a load balancing rule for port 80.
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Setting Value

Name Enter a name, for example, SRTCPRule80.

IP Version Select IPv4.

Frontend IP address Select LoadBalancerFrontEnd.

Protocol Select TCP.

Port Enter 80.

Backend port Enter 80.

Backend pool Select SRBackendPool.

Health probe Select SRHealthProbe80.

Session persistence Select Client IP.

Idle timeout (minutes) Accept the default setting.

TCP reset Select Enabled.

Outbound source network address translation
(SNAT)

Select (Recommended) Use outbound rules to
provide backend pool members access to the
internet.
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• Add the Azure VMs where the Session Recording Server is installed to the back‑end
pool.
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c) Test the Azure load balancer.
If you cannot add a server to the back‑end pool and the following error message appears
NetworkInterfaceAndLoadBalancerAreInDifferentAvailabilitySets, disassociate the
public IP address of the server network interface.
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Option 3: Create an Azure application gateway

Tip:

Application Gateway V2 does not support routing requests through an NTLM‑enabled proxy.

1. Create an Azure application gateway.

Configure the following settings when you create an application gateway.

• On the Basics tab, set Tier to Standard.
• On the Frontends tab, set Frontend IP address type to Private. The new application
gateway is used as an internal load balancer.

2. Add a back‑end pool.
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3. Create HTTP settings.

Azure Application Gateway supports both HTTP and HTTPS for routing requests to back‑end
servers. Create HTTP settings for ports 80, 443, and 22334.

• HTTP over port 80
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• HTTP over port 443

An authentication certificate is required to allow back‑end servers in Application Gateway
V1. The authentication certificate is the public key of back‑end server certificates in Base‑
64 encodedX.509(.CER) format. For informationonhow to export thepublic key fromyour
TLS/SSL certificate, see Export authentication certificate (for v1 SKU).
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• HTTP or HTTPS over port 22334

If WebSocket uses HTTP, use the same setting as port 80.
If WebSocket uses HTTPS, use the same setting as port 443.

4. Add a front‑end IP address.

5. Add listeners.

Add listeners on ports 80, 443, and 22334, for example:
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• Listener on port 80

• Listener on port 443

Create a self‑signed certificate and upload the certificate to the Azure portal when you cre‑
ate the HTTPS listener. For more information, see Certificates supported for TLS termina‑
tion and Create a self‑signed certificate.
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• Listener on port 22334

IfWebSocket usesHTTP, use the samesettingasport 80. IfWebSocket usesHTTPS, use the
same setting as port 443. The following example shows the setting of an HTTPS listener
on port 22334.
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6. Create request routing rules.

Create rules for ports 80, 443, and 22334, for example:
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• Routing rule for port 80
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• Routing rule for port 443

• Routing rule for port 22334
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7. Add the Azure VMs where the Session Recording Server is installed to the back‑end pool.

8. Configure Session Recording Servers according to Knowledge Center article CTX230015.

https://support.citrix.com/article/CTX230015
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